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TERMS AND CONDITIONS OF SALE AND LICENSE OF TANDY COMPUTER EQUIPMENT AND
SOFTWARE PURCHASED FROM RADIO SHACK COMPANY-OWNED COMPUTER CENTERS RETAIL
STORES AND RADIO SHACK FRANCHISEES OR DEALERS AT THEIR AUTHORIZED LOCATIONS

LIMITED WARRANTY
CUSTOMER OBLIGATIONS
A. CUSTOMER assumes full responsibility that this computer hardware purchased (the "Equipment") and any

copies of software Included with the Equipment or licensed separately (the "Software") meets the specifications
capacity, capabilities, versatility, and other requirements of CUSTOMER.

B. CUSTOMER assumes full responsibility for the condition and effectiveness of fhe operafing environment In which
the Equipment and Software are to function, and for its installation.

LIMITED INARRANTIES AND CONDITIONS OF SALE
A. For a period of ninety (90) calendar days from the date of the Radio Shack sales document received upon

purchase of fhe Equipment, RADIO SHACK warrants to the original CUSTOMER that the Equipment and the
medium upon which the Software Is stored Is free from manulacfuring defecfs. This warranty is only applicable
to purchases of Tandy Equipment by the original customer from Radio Shack company-owned computer
centers, retail sleres, and Radio Shack franchisees and dealers el fheir euthorlzed locetions. The warranty Is
void If the Equipment or Software has been subjected to Improper or abnormal use. If a manufacturing defect Is
discovered during the stated warranty period, the detective Equipment must be returned to a Radio Shack
Computer Center, a Radio Shack retail store, a participating Radio Shack franchisee or a parflclpating Radio Shack
dealer for repair, along with a copy of the sales document or lease agreement. The original CUSTOMER'S sole and
exclusive remedy In the event of a defect Is limited to the correction of the defect by repair, replacement or
refund of the purchase price, at RADIO SHACK'S election and sole expense. RADIO SHACK has no obligation to
replace or repair expendable Items.

B. RADIO SHACK makes no warranty as to the design, capability, capacity, or suitability for use of fhe Software
except as provided In this paragraph. Software Is licensed on an "AS IS" basis, without warranty. The original
CUSTOMER'S exclusive remedy. In the event of a Software manufacturing defect, is Its repair or replacement
within thirty (30) calendar days of the date of the Radio Shack sales document received upon license of the
Software. The defective Software shall be returned to a Radio Shack Computer Cehter, a Radio Shack retail store
a participating Radio Shack franchisee or Radio Shack dealer along with the sales document.

C. Except as provided herein no employee, agent, franchisee, dealer or ofher persoh is authorized to give any
warranties of any nature on behalf of RADIO SHACK.

D. EXCEPT AS PROVIDED HEREIN, RADIO SHACK MAKES NO EXPRESS WARRANTIES, AND ANY IMPLIED
WARRANTY OF MERCHANTABILITY DR FITNESS FOR A PARTICULAR PURPOSE IS LIMITED IN ITS DURATION
TO THE DURATION OF THE WRIHEN LIMITED WARRANTIES SET FORTH HEREIN.

E. Some sfates do not allow limitations on how long an implied warranty lasts, so the above llmltatlon(s) mav not
apply to CUSTOMER.

LIMITATION OF LIABILITY
A. EXCEPT AS PROVIDED HEREIN, RADIO SHACK SHALL HAVE NO LIABILITY OR RESPONSIBILITY TO CUSTOMER

OR ANY OTHER PERSON OR ENTITY WITH RESPECT TO ANY LIABILITY, LOSS OR DAMAGE CAUSED OR
ALLEGED TO BE CAUSED DIRECTLY OR INDIRECTLY BY "EQUIPMENT" OR "SOFTWARE" SOLO, LEASED
LICENSED OR FURNISHED BY RADIO SHACK, INCLUDING, BUT NOT LIMITED TO, ANY INTERRUPTION OF
SERVICE, LOSS OF BUSINESS OR ANTICIPATORY PROFITS OR CONSEQUENTIAL DAMAGES RESULTING FROM
THE USE OR OPERATION OF THE "EQUIPMENT" QR "SOFTWARE." IN NO EVENT SHALL RADIO SHACK BE
LIABLE FOR LOSS OF PROFITS, OR ANY INDIRECT, SPECIAL, QR CONSEQUENTIAL DAMAGES ARISING OUT OF
ANY BREACH OF THIS WARRANTY OR IN ANY MANNER ARISING OUT OF OR CONNECTED WITH THE SALE
LEASE, LICENSE, USE QR ANTICIPATED USE OF THE "EQUIPMENT" QR "SOFTWARE."
NOTWITHSTANDING THE ABOVE LIMITATIONS AND WARRANTIES, RADIO SHACK'S LIABILITY HEREUNDER FOR
DAMAGES INCURRED BY CUSTOMER QR OTHERS SHALL NOT EXCEED THE AMOUNT PAID BY CUSTOMER FDR
THE PARTICULAR "EQUIPMENT" OR "SOFTWARE" INVOLVED.

B. RADIO SHACK shall not be liable for any damages caused by delay In delivering or furnishing Equlpmenf and/or
Software.

C. No action arising out of any claimed breach of this Warranty or transactions under this Warranty may be brought
more than two (2) years after the cause of action has accrued or more than four (4) years after the date of the
Radio Shack sales documeht for the Equipment or Software, whichever first occurs.

D. Some states do not allow the limitation or exclusion of Incidenfal or consequential damages, so the above
llmltation(s) or excluslon(s) may not apply to CUSTOMER.

SOFTWARE LICENSE ^
RADIO SHACK grants to CUSTOMER a non-exclusive, paid-up license to use the TANDY Software on one computer,
subject to the following provisions:
A. Except as otherwise provided In this Software License, applicable copyright laws shall apply to the Software.
B. Title to the medium on which the Software Is recorded (cassette and/or diskette) or stored (ROM) Is transferred to

CUSTOMER, but not title to the Software.
C. CUSTOMER may use Software on a multiuser or network system only If either, the Software Is expressly labeled

to be for use on a multiuser or network system, or one copy of this software Is purchased for each node or
terminal on which Software Is to be used simultaneously.

0. CUSTOMER shall not use, make, manufacture, or reproduce copies of Software except for use on one computer
and as Is specifically provided In this Software License. Customer Is expressly prohibited from disassembling the
Software.

E. CUSTOMER Is permitted to make additional copies of the Software only for backup or archival purposes or If
additional copies are required in the operation of one computer with the Software, but only to the extent the
Software allows a backup copy to be made. However, for TRSDOS Soffware, CUSTOMER Is permlfted to make a
limited number of additional copies for CUSTOMER'S own use.

F. CUSTOMER may resell or distribute unmodified copies of the Software provided CUSTOMER has purchased ohe
copy of the Software for each one sold or distributed. The provisions of this Software License shall also be
applicable to third parties receiving copies of the Software from CUSTOMER.

G. All copyright notices shall be retained on all copies of the Software.
APPLICABILITY OF WARRANTY
A. The terms and conditions of this Warranty are applicable as between RADIO SHACK and CUSTOMER to either a

sale of fhe Equlpmenf and/or Software License to CUSTOMER or to a transaction whereby Radio Shack sells or
conveys such Equipment to a third party for lease to CUSTOMER.

B, The limitations of liability and Warranty provisions herein shall Inure to the benefit of RADIO SHACSi.'the author
owner and or licensor of the Software and any manufacturer of the Equipment sold by Radio Shack

STATE LAW RIGHTS
The warranties granted herein give the original CUSTOMER specific legal rights, and the original CUSTOMER may
have other rights which vary from state to state.
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Personal DeskMate"* Software
©1986 Tandy Corporation

All Rights Reserved.

All portions of this software are cop3n:ighted and are the
proprietary and trade secret information of Tandy Corpo
ration. Use, reproduction or publication of any portion of
this material without prior written authorization by
Tandy Corporation is strictly prohibited.

Personal DeskMate^*" Manual

©1986 Tandy Corporation
All Rights Reserved.

Reproduction or use, without express written permission
from Tandy Corporation, of any portion of this manual is
prohibited. While reasonable efforts have been taken in
the preparation of this manual to assure its accuracy,
Tandy Corporation assumes no liability resulting from
any errors or omissions in this manual, or from the use of
the information contained herein.

Tandy and Digi-Mouse are registered trademarks of Tandy
Corporation.

Personal DeskMate and the Tandy hourglass logo are
trademarks of Tandy Corporation.

Microsoft and MS-DOS are registered trademarks of
Microsoft Corporation.

IBM is a registered trademark of International Business
Machines Corporation.
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Chapter 1

INTRODUCTION

Welcome to Personal DeskMate^"! Personal DeskMate combines
seven applications and ten accessories to give you a complete sys
tem for keeping track of anything you like. You'll find a myriad
of uses for these applications:

Tandy Desktop

Text

Worksheet

Fder

Paint

A visual organizer and manager for the
files you create using Personal DeskMate.
Ydu gain access to the Personal DeskMate
applications, accessories, and files from the
Tandy Desktop. You can even install some of
the accessories on the Tandy Desktop for
quick review.

An easy to use text processor that lets you
handle short letters or longer school reports.
Text gives you the power to remove as little
or as much unwanted text as you like, copy
parts of your text and use them again else
where, search for occurrences of certain
words you might want to change, and even
replace selected text with new text. You can
emphasize words by boldfacing or under
lining them, giving your document a pol
ished, "finished" look.

An application for working with numbers in
spreadsheet fashion. You have 99 rows and
99 columns for laying out your budget, fig
uring interest on your mortgage, or track
ing tax deductions. And you can instantly
see the result that changing just one figure
could have on the entire worksheet.

A small database system that lets you set
up forms for recording any information you
need. You can create your own personal Yel
low Pages or keep track of the PTA mem
bership drive and print either individual
records or lists of records that meet criteria
you choose.

A graphic "picture editor" that enables you
to draw pictures and fill them with a vari
ety of colors and patterns.
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Calendar A scheduler for your personal appointments.
You can use Calendar to store yearly,
monthly, and daily events. Calendar lets you
print calendars that show all nationally rec
ognized holidays and scheduled appoint
ments in a variety of printing formats.

Telecom A basic telecommunications package that
lets you communicate via your computer
with information services or with other
computers. Y»u can send, receive, and store
information you collect. (To use Telecom, you
need additional equipment. See "Equipment
and Software You Need," later in this
chapter.)

Y)u can use the Personal DeskMate accessories from inside any
Personal DeskMate application. The accessories are:

Notepad

Calendar

Calculator

Phone

Directory

A mini text editor that holds several small
pages of notes and reminders you write. Y)u
can install the Notepad in your Tandy
Desktop application.

A small monthly calendar for quick refer
ence. Y)u can install the Calendar in your
Tandy Desktop application.

A "pop-up" calculator for quick calculations
whenever you need them. You can see a lim
ited running history of calculations on the
scrolling visual adding machine-type tape
and install the Calculator on the Tandy
Desktop.

A means of storing important phone num
bers you need at your fingertips. You can
print the phone list in two attractive for
mats and use the accessory to make Per
sonal DeskMate dial one of the phone
numbers for you. You can install the Phone
Directory on your Tandy Desktop.
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Clipboard

Colors

Communications

Date and Time

Mouse

Printer

An accessory that enables you to take infor
mation from one file and use it in another.

For instance, use the Clipboard to hold a
paragraph in a document you created via
Text so that you can put it in another
document.

An accessory that lets you choose four colors
from a palette of 16.

An accessory that enables you to select
hardware options and communications set
tings you need for using the Telecom appli
cation and the Phone List accessory.

An accessory that lets you change the date
and time from the one you specify when you
start up the computer.

An accessory that lets you choose the double
click speed you want to use if you're using a
pointing device (a mouse, joystick, or Touch
Pad).

An accessory that lets you tell Personal
DeskMate the type of printer you'll be
using. Choose from a list of Tandy® printers
or IBM® graphics printers, and set up or
change other printer attributes and hard
ware controls.

Equipment and Software You Need
To use Personal DeskMate, you must have:

•  A Tandy 1000 series computer with at least one floppy disk
drive and 256K Random Access Memory (RAM)

•  A monochrome or color monitor

•  The MS-DOS® operating system

•  At least three blank floppy diskettes

To use the Telecom application, you need a telecommunications
card or a modem.
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To enhance your use of Personal DeskMate, you can add the
following:

An additional floppy disk drive

A Tandy Digi-Mouse®

A Color Mouse, joystick, or Touch Pad

A dot matrix or daisy wheel printer

A CGP 220 color graphics printer for producing color output
with the Paint application only

How to Use the Manual

The Parts of the Manual. This manual is your guide to Per
sonal DeskMate. It is arranged to give you the information you
need quickly and easily. The manual is divided into several
parts that you will find useful at different times as you learn
about Personal DeskMate.

The Introduction, which you're now reading, gives you an over
view of Personal DeskMate, lists the equipment you'll need, and
gives you some background information that will help you get up
to speed.

The Sample Session is a set of exercises designed to show you
around Personal DeskMate and give you experience in using the
software before you actually put it to work using your own infor
mation. We suggest that you perform all the exercises so that
you'll feel comfortable and be able to start using Personal
DeskMate with complete assurance that you won't "get lost" in
it. Be sure to read the first chapter of the Sample Session, "Get
ting Started." It contains critical information about using a key
board or mouse, as well as explanations of procedures you'll use
throughout the Sample Session.

The Reference part gives you detailed information about every
aspect of Personal DeskMate. Each chapter describes a different
application or accessory and explains all its options and func
tions. Use this part of the manual when you need detailed infor
mation about an aspect of Personal DeskMate you might not be
familiar with.

The Appendices include information about installing applica
tions on separate diskettes and setting up Personal DeskMate so
that you can use a pointing device.
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The manual concludes with a detailed Index that gives you
quick access to any subject discussed in the manual.

Things You'll See Throughout the Manual. As you read this
manual, keep in mind a few pointers that will help you:

•  Anything you see on the screen appears in the manual in
this kind of type.

•  Anything you need to type appears in the manual in bold
type.

•  Keys you need to press appear in | boxes |, with the exception
of the space bar.

•  Sometimes you'll see two "boxed" keys together, such as
I CTRL I rn. When you see instructions telling you to press
these keys, hold down the first key, and press the second
one.

•  Most of the Sample Session is laid out in steps. The first
part of each step is the broad, general procedure you'll fol
low. Some of the steps are expanded with supplemental
information needed to accomplish that procedure. As you
become more and more familiar with Personal DeskMate,
you might not need to refer to the supplemental
information.

Before You Do Anything Else

Before you do anything else, turn to the Introduction to MS-DOS
to find out how to make copies of your Personal DeskMate
diskettes. Never use the originals to run Personal DeskMate. If
you do, you'll be in for a big disappointment if your diskettes are
ever damaged. Without copies of your software, everything could
be lost—the programs, the files you had created—in short, all
your Personal DeskMate information! Get into the habit of mak
ing copies as you develop files and add or change information,
perhaps as often as every day. This is the best insurance you
can have that all your information will really be at your finger
tips when you need it.
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You also need to set up Personal DeskMate for use with a point
ing device if you plan on using one. Instructions for doing this
are in Appendix B, but read the next three chapters before you
actually perform the procedure in the appendix.

When you complete the preliminary steps, you're ready to start
the Sample Session. Again, we strongly suggest that you
actually do the exercises. They'll help you through some of the
procedures you'll want to perform regardless of the way you plan
on using Personal DeskMate, like starting up the software and
choosing colors you want the screen to display. Of course, the
Reference part of the manual also contains this information, but
why not make it easy on yourself and have a little fun, too?
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Chapter 2

GETTING STARTED

Before you start learning about the Personal DeskMate applica
tions, you need to know about a few concepts and techniques
you'll use throughout the Sample Session. This chapter familiar
izes you with these techniques and teaches you how to:

open a file and run an application

move from one section of the screen to another

select information on which you'll perform menu commands

"pull down" a menu and choose commands from that menu

work with dialog boxes

exit a file and application

You'll learn these techniques whether you use the keyboard or a
pointing device. Instructions are provided for both. As well as
instructions, you'll see specific examples to try.

Installing Personal DeskMate

Personal DeskMate comes to you on two diskettes. To gain valu
able diskette storage space, we strongly urge you to transfer Per
sonal DeskMate onto at least three diskettes. You'll do this by
using the install command, explained below.

Format three diskettes. Instructions on formatting diskettes are
in Introduction to MS-DOS. Temporarily label the diskettes as
destination diskettes 1, 2, and 3.

Next, with the A > prompt on the screen, insert a copy of Diskette
#1 (of the diskettes supplied with this package) in Drive A.

With Diskette #1 in Drive A, type install I enter |. The diskette
that is currently in Drive A is called source disk #1. The other
Personal DeskMate diskette is called source disk #2. The for
matted diskettes you made are called destination disks #1, #2,
and #3.
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Follow the instructions on the screen carefully. The screen asks
you to make choices about the types of files you want to store on
each diskette and then instructs you to switch diskettes in Drive
A several times. Choose installation option #1 and then be sure
to insert the correct diskettes when the screen requests
them. If you insert a diskette the screen did not ask for, we sug
gest that you start the procedure again using three formatted
diskettes.

When the computer finishes, the A> prompt returns to the
screen. Destination diskette #1 contains the Tandy Desktop, the
Phone List accessory, and the Calendar application. Diskette #2
contains Text, Paint, and Telecom. Diskette #3 contains Work
sheet and Filer. Be sure to note the contents of each destination
diskette and to label each diskette in a way meaningful to you.
Use only the new diskettes to run Personal DeskMate, and store
the original diskettes in a safe place.

Loading and Exiting Personal DeskMate
With the system prompt on the screen and Diskette # 1 (of the
diskettes you created) in Drive A, type desk | enter |. The Desktop
soon appears on the screen.

Throughout the Sample Session, you'll need to switch diskettes
when a message on the screen asks you to. After you switch
diskettes, select the OK button to continue using Personal
DeskMate. (This chapter shows you how to select buttons.)

To exit Personal DeskMate during the Sample Session, use the
File Menu from the desktop, and choose the Quit DeskMate
option. If you stop working in the middle of a chapter, use the
application's File Menu and Quit option to return to the desktop.
Be sure to save the information you're using so that you can con
tinue from the same point when you return to Personal
DeskMate.

After exiting Personal DeskMate, you might he asked to insert a
diskette containing COMMAND.COM in the drive. Insert your
MS-DOS diskette, and press I enter |.

10
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Getting Ready to Use a Pointing Device

You can use the keyboard alone to run Personal DeskMate with
no problem. However, if you want to use a pointing device, (a
mouse or joystick), the first thing you need to do is prepare for
using the device. Instructions for preparing to use a pointing
device are in Appendix B. We suggest, however, that you first
read this chapter and Chapters 3 and 4 before you follow the
instructions in Appendix B. Perform the Text sample session
using the keyboard. You'll then have a good foundation for using
Appendix B to set up your pointing device.

After you prepare to use the pointing device, we suggest that you
become familiar with the following terms that describe the way
you move the pointer (the marker):

To point Move the device until the pointer rests on
the information to which you want to point.

To press Hold down the button on the device.

To click Quickly press and release the button.

To double click Click the button twice in rapid succession.

To drag Hold down the button while moving the
pointer.

If you haven't already loaded Personal DeskMate, do so now, fol
lowing the instructions earlier in this chapter. (Load Personal
DeskMate from your working Diskette #1.) After you load Per
sonal DeskMate, the desktop appears on the screen:

11
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To use one of the applications, you need to either open an exist
ing file or run the application without opening a file. Doing
either is easy. On the desktop, notice the several hoxes headed
with the application names—TEXT, WORKSHEET, FILER, and so
on. These hoxes are called list boxes. Any names that appear in
an application's list hox are the names of files that make use of
that particular application. For instance, the CALENDAR list box
contains a file, AGENDA . CAL. .CAL is a filename extension. Unless
specifically instructed (as in Telecom), do not enter extensions for
filenames. They are automatically entered by Personal
DeskMate.

To open a file and its appropriate application, follow these gen
eral instructions.

With the Keyboard. Press I tab I to move the marker to the list
hox containing the file you want to open. If you move past the
list box you want, hold down | shift I and press | tab | to move the
marker back. When the marker is on the correct list box, press
rn until the marker is on the file you want to open. If the list
box contains more files than will fit in the hox, use fTl or (Tl to
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scroll the list one item at a time, until you mark the correct file.
When the file you want to use is marked, press [ enter I to open
the file and run the appropriate application.

Sometimes you must run an application without opening a file at
the same time. For instance, if you follow the procedures in the
Worksheet and Filer sample sessions, you'll actually create a
file, not simply open an existing one and use it. To run an appli
cation without opening a file at the same time, press I tab I to
move the marker to the title of the appropriate list box (using
I SHIFT I I TAB I to move back if you pass the box you want). When the
marker is on the list box for the application you want to run,
press I ENTER I.

With the Pointing Device. Use the device to point to the file
you want to open. If the list box contains more files than will fit
in the box, point to one of the scrolling arrows in the list box
title, and click. This scrolls the list one item at a time in the
direction of the arrow. To scroll more than one item, point to the
appropriate scrolling arrow, and press and hold the button.

After you point to the file you want to use, double click on that
file to open it and run the appropriate application.

To run an application without opening a file at the same time,
simply point to the title of the list box for the application you
want to use, and double click.

An Example. Open the Text application's Emily.doc file by fol
lowing the instructions below. (You'll use this file in another
example later in this chapter.)

With the keyboard:

1. Replace Diskette #1 with Diskette #2.

2. Hold down [cm], and press (This activates the Disk
Menu's Swap option.)

3. Press I tab I until the marker is on the TEXT list box.

4. Press [T] until the marker is on Emily.doc.

5. Press [ enter | to open the file. You see the first part of the
document on your screen.
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With the pointing device:

1. Replace Diskette #1 with Diskette #2.

2. Point to Disk in the menu bar, press and hold the button,
and drag the pointer down until you highlight the Swap
option. Release the button.

3. PointtoEmily.doc.

4. Double click the button. You see the first part of the docu
ment on your screen.

Moving Around on the Screen

Most of the time, moving the marker around on a screen is a
matter of pressing arrow keys or pointing and clicking. Several
techniques help you move the marker farther and faster.

With the Keyboard. Generally, you can press an arrow key to
move the marker one character in the direction indicated on the

key. When you're working with information that isn't character-
oriented (for example, a field in the Filer application), use the
I TAB I key to move forward from field to field or | shift I | tab I to move
backward from field to field. In addition to the arrow keys and
the I TAB I key, these keys help you move around on the screen:

I CTRL I rn or Moves the marker to the same column at
I PG UP I the top of the screen. If you're already at

the top of the screen, | ctrl | [Tl moves you to
the top of the previous screen (if any).

I CTRL I rn or Moves the marker to the same column at
I PG ON I the bottom of the screen. If you're already

at the bottom of the screen, | ctrl | fTI moves
you to the bottom of the next screen (if
any).

I CTRL I F~l Moves the marker to the right margin of
the screen. If you're already at the right
margin, | CTRL | Q scrolls the marker to the
right margin of the next screen to the right
(if any).
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I CTRL I rn Moves the marker to the left margin of the
screen. If you're already at the left margin,
I CTRL I rn scrolls the marker to the left mar
gin of the next screen to the left (if any).

I HOME I Moves the marker to the beginning of the
file's information.

I END I Moves the marker to the end of the file's
information.

With the Pointing Device. Position the marker anywhere on
the screen by pointing to the appropriate location and clicking.
To move the marker to different screens, use the scrolling arrow
icons on the screen's menu bar. (The menu bar is the second line
on the screen. It shows the different menus you can use in an
application and the scrolling arrow icons. Note that not every
screen displays all the icons that follow in this explanation.)

Point and click on: To move the marker:

O  Up one line. If you're at the top line of
the screen, the marker moves to the
last line of the previous screen (if any).

O  Down one line. If you're at the bottom
line of the screen, the marker moves to
the first line of the next screen (if
any).

Right one character. If you're at the
right margin of the screen, the marker
moves to the left margin of the next
screen to the right (if any).

^  Left one character. If you're at the left
margin of the screen, the marker
moves to the right margin of the next
screen to the left (if any).

To scroll more than one line or character at a time, point to the
appropriate arrow icon, and press and hold the button. This lets
you scroll continuously until you release the button.

An Example. To see how to move around on the screen cur
rently displayed, follow the instructions below.
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With the keyhoard:

1. Move the marker to the end of the document by pressing
I END |.

2. Move the marker up one line by pressing [T].

3. Move the marker to the top of the screen by pressing
I PG UP 1.

4. Display the previous screen by pressing I pg up I again.

5. Return to the beginning of the document by pressing | home |.

With the pointing device:

1. Move the marker to the end of the document by pointing to
the icon, pressing the button, and holding it down.
When you reach the last line of the document, release the
button. Then, point to the last character, and click.

2. Move the marker up one line by pointing to the character
directly above the current marker location and clicking.

3. Move the marker to the top of the screen by pointing to the
first character on the screen and clicking.

4. Display the previous screen by pointing to the icon,
pressing the button, and holding it down until the old infor
mation scrolls completely off the bottom of the screen. Then,
release the button.

5. Return to the beginning of the document by pointing to the
-tCS- icon and pressing the button. When the first line of the
document is again at the top of the screen, release the
button.

Selecting Information in a File

Another technique you'll use frequently is selecting information
in files to manipulate. For instance, to move a block of informa
tion to another part of your file, you must first select that infor
mation, then move it. Generally, selecting information follows
procedures like the ones presented below. These procedures
assume that you are using Insert mode, the mode Personal
DeskMate automatically assumes when you type. The Text appli
cation lets you use either Insert or Overtype mode. The sample
session for Text shows you how to select in either mode.
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With the Keyboard. To select information with a keyboard, use
these keys:

I SHIFT I m To select the character on which the marker
rests and all previous characters through
the same column position on the previous
line.

ISHIFI rn To select the character on which the marker
rests and all following characters through
the same column position on the next line.

I SHIFT I rn To select the next character to the right.

I SHIFT I F1 To select the previous character to the left.

fFT] m To select the character on which the marker
rests and all previous characters through
the same column position at the top of the
screen.

fpfl m To select the character on which the marker
rests and all following characters through
the same column position at the bottom of
the screen.

[m m To select the character on which the marker
rests and all following characters through
the rightmost character on the same line.

im m To select the character on which the marker
rests and all previous characters through
the first character on the same line.

With the Pointing Device. To select information with a point
ing device, point to the location at which you wish to begin
selecting information, and press and hold the button. Then, drag
the pointer in the direction in which you want to select informa
tion, releasing the button when all the information you want to
select is marked.

An Example. To see how to select information, follow the
instructions below, using the screen currently on display.

After you select information, you can do several things, fbr
example, you can use an Edit Menu option. Cut, to remove that
information from the screen. "You can then use the Edit Menu's
Paste option to place the cut information elsewhere in the file.
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%u can replace the selected text with other characters (in this
example) by typing the characters after selecting the text. For
instance, you might select several lines and then press the space
bar to replace the selected text with a blank space.

To cancel selection, press I Esc I or reposition the marker. The
highlighting disappears, leaving the information intact.

With the keyboard:

1. Select the first two characters in the document, #2.

Press QD until the marker is just before the #. Then, press
I SHIFT I Fl twice.

2. Select the first line of the document.

Press |7T] Q]-

3. Select the remainder of the screen.

Press (TT] (T).

4. Cancel the selection of the text by pressing | home | to move to
the beginning of the document.

With the pointing device:

1. Select the first two characters in the document, #2.

Point to the #, and press the button. Do not release the
button. Drag the pointer to the 2.

2. Select the first line of the document.

Drag the pointer to the last character on the line, still hold
ing down the button.

3. Select the remainder of the screen.

Drag the pointer to the last character on the screen, and
release the button.

4. Cancel the selection of the text by pointing to the beginning
of the document and clicking.

18



2 / Getting Started

Pulling Down Menus and Selecting
Options

You access most of an application's features by pulling down
menus. The menus you can use appear on the second line of
every screen in Personal DeskMate, in the line known as the
Menu Bar, with the exception of the Accessories Menu, which
appears as the Tandy icon in the upper left corner of the screen.
The screen currently on display shows this menu bar:

FileaEditillfxtBSeapciil |tj[¥

With the Keyboard. To pull down a menu by using the key-
hoard, hold down | alt |, and press the key that corresponds to the
first letter of the menu name. An exception to this is the Acces
sory Menu, which you display by pressing I alt I and the space bar.
To cancel the menu display before you choose an option, press

To choose an option from a menu, use the arrow keys to mark
the option you want to use, and press I enter |.

With the Pointing Device. To pull down a menu and choose an
option by using the pointing device, point to the menu you want
to display, and press and hold the button. To cancel the menu
display before you choose an option, move the pointer away from
the menu, and release the button.

To choose an option from a menu, drag the pointer down to dis
play and mark different menu options. When you mark the
option you want to use, release the button.

An Example. To pull down the Accessory Menu and choose an
option, follow the instructions below.

With the keyboard:

1. Hold down | alt I and press the space bar. The Accessory
Menu appears.
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2. Choose the Color option by pressing [T) until you mark
Color, and press I enter |. You'll use the window that appears
in a moment.

With the pointing device:

1. Point to the Tandy icon, (in the upper left corner of the
screen) and press and hold the button.

2. Drag the pointer down until you mark the Color . . .
option, and release the button. You'll use the window that
appears in a moment.

Working With Dialog Boxes

Usually, when you use an application's features. Personal
DeskMate tries to perform the function you choose, but occasion
ally, it needs more information from you before it can carry out
your command. Whenever you need to supply information, you'll
see a dialog box, a window in which you and Personal DeskMate
have a short "dialog."

A dialog box can consist of several components. Each component
is explained in the paragraphs that follow.

Edit Fields. An edit field is a line following a prompt. In an edit
field, you supply information by typing it or by changing infor
mation that already appears in the field.

Me: / /

List Boxes, A list box is a list of information from which you
choose for display in an edit field to save time rather than typing
the information directly in the edit field.
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♦  FIEDS ♦
I Me;

OManization
Hefhod of Fa
Receipt?

To choose a response that appears in a list box via the keyboard,
use the arrow keys to move to the response of your choice. If the
list box contains more choices than can display in the box, use
the arrow keys to scroll through the list until you mark the
response you want to use. Then, after marking your choice, press
I TAB |. Personal DeskMate places that information in the edit
field, and the marker moves to the edit field, which is now filled
in. You can press |tab | again to move past the edit field, or you
can edit the answer now displayed in the field.

To use a response that appears in a list box via the pointing
device, point to the response of your choice. If the list box con
tains more choices than can display in the box, click on one of
the scrolling arrow icons in the list box title. To scroll continu
ously, press and hold the button while pointing to the icon,
releasing the button when you see the response you want. Mark
your choice by pointing to it, and click. The response appears in
the edit field when you point to the edit field and click.

Radio Buttons. Sometimes you'll see groups of choices with
small buttons beside them. These buttons are radio buttons,
which means that they work the same way as, for instance, an
automobile's radio buttons work. When one button is pushed,
that "station" plays. The "station" remains the same until you
push another radio button.

O ScKen
# Fpintep
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To select from among a group of radio buttons via the keyboard,
use the arrow keys to move from one button to another. When
the button you want to use is marked, press the space bar to
push the button.

To use a pointing device to select a radio button from among sev
eral in a group, point to the button you want to push, and click.

Check Boxes. Check boxes offer you settings that you can tog
gle on and off to keep them in effect or not, as you choose.

Bouble Space
ause Mwen Pages

USeM

A setting that is on is marked with an X or a check beside it. A
setting that is off shows no mark beside it.

To toggle a setting via the keyboard, position the marker on the
appropriate setting, and press the space bar.

To toggle a setting via a pointing device, point to the appropriate
setting, and click.

Push Buttons. Every dialog box contains push buttons. These
buttons let you tell Personal DeskMate that you're Hnished
working with the dialog box. "Vbu can push a button to proceed
or one to cancel the command you requested.

i

m

To use a push button via the keyboard, use I tab I and | shift I fWl
to alternate between the push buttons until the button you want
to push is marked. Then, press the space bar. Pressing | enter I is
an accelerator (short cut) to the OK button. Pressing is an
accelerator to the CANCEL button.
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The accessories, the help windows, and some applications have
buttons at the bottom of the screen. Pressing | ctrl I and the first
letter of the name of the button is an accelerator to that button.

For example, I ctrl I [o] is an accelerator to the QUIT button. The
I PRINT I key is always an accelerator to the File Menu's Print
option or any PR I NT push button.

To use a push button via a pointing device, point to the button
you want to push, and click.

The Whole Picture. A dialog box might contain any or all of
the components explained above. An entire dialog box might look
something like this:

Left HapgiTi:

Fpinted Lirte Hidth;

lotal Liitts Pep Page:

Printed Liws Per Page: U||
"Touble Space

Pause Betwen Pages
Send control sequence
9 Orphic mde
O Text Mode

This dialog box contains all the components except a list box.
Notice that the box naturally divides into sections: a group of
radio buttons at the top, followed by four edit fields, then a group
of three check boxes, another group of radio buttons, and finally,
two push buttons.

To move around the different sections of a dialog box with the
keyboard, use fWI to move to the next section. Use I shift I [tab I to
move backward through the groups.

Using a pointing device, you can simply point and click on any
option in any section.
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As you use Personal DeskMate, you'll notice that parts of some
dialog boxes appear to be "shadowed." A shadowed part means
that, because of some other setting in effect, the shadowed part
does not apply to you at this time. For instance, in the dialog
box pictured above, you might not be able to change certain
answers in the box because of the type of printer you have con
nected to your computer or because of a page format you choose
for printing information. When you move the marker around in a
dialog box. Personal DeskMate automatically skips the shadowed
parts of the box.

An Example. As your introduction to dialog boxes, you'll use a
simple one that contains nothing but radio buttons and push but
tons. The dialog box you'll use is already on your screen. This
dialog box lets you change the colors on the screen. The top sec
tion of this dialog box shows you the colors currently selected for
the Text application. The next section shows you the colors you
can choose when you change the screen's color arrangement. Fol
low the instructions below to do so.

With the keyboard:

1. First, notice that the button for Color #1 is already pushed.
To change the color, press I tab I to move to the section of the
box that contains the several color choices available.

2. Use the arrow keys to move the marker around among the
different colors. \^en the marker is on a color you think
you'd like, press the space bar to select it. The color you
chose appears immediately on the part of the screen that
uses Color #1.

3. Press I shift 1 1 tab I to move back to the top section of the box.

4. Use the arrow keys to move to Color #2, and press the
space bar to select it.

5. Press I tab I to move to the section containing the color
choices.

6. Continue Steps 2 through 5 until you've chosen all four
colors.

7. Press I tab I until you move the marker to the OK push but
ton, and press the space bar to select it. The dialog box dis
appears, and now the Text screen appears in the colors you
chose. You can use this same technique in any application
to display colors you find attractive.
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With the pointing device:

1. First, notice that the button for Color #1 is already pushed.
Point to a radio button in the section of the box that con

tains the several color choices available. Point to a button

that coincides with a color you think you'd like, and click.
The color you chose immediately appears on the part of the
screen that uses Color #1.

2. Point to Color #2 in the top section, and click.

3. Point to another color in the lower section that you like, and
click.

4. Follow Steps 2 and 3 until you choose all four colors.

5. When you've chosen all four colors, point to the DK push
button at the bottom of the window, and click. The dialog
box disappears, and now the Text screen appears in the
colors you chose. You can use this same technique in any
application to display colors you find attractive.

How to Use Help. If you find that you want on-screen help dur
ing the Sample Session, press I alt I 0, or point to the question
mark icon at the top right of the screen, and click. Information
on using Help is in Chapter 11, "General Information and
Concepts."

Exiting a File and Application
When you finish working with a file and want to return to the
desktop, you must exit the file. The same procedure is used in
the Sample Session to exit all the files you create and use.

To exit a file via the keyboard, pull down the File Menu, and
choose the Quit option. If you changed any information in the
file, you'll see a message asking if you want to save those
changes, along with three push buttons. To save the changes,
push the YES 'outton. To exit the file without saving any changes
you made, push the NO button. To keep working with the file,
push the CANCEL button. When you exit the file, you might need
to replace the diskette in the drive with Diskette #1, the
diskette containing the desktop.

An Example. To exit the Emily.doc file and the Text applica
tion, follow these instructions.
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With the keyboard:

1. Press I ALT I [T] to display the File Menu.

2. Press Q until you mark the Quit option, and press I enter I
to choose it.

3. When the screen asks you to switch diskettes, remove
Diskette #2 from the drive, replacing it with Diskette #1.

4. Press I enter I to choose the DK button.

You see the desktop once again. Because you didn't change any
of the information in the file, you didn't see the Save changes?
message.

With the pointing device:

1. Point to File on the Menu Bar, and press and hold the
button.

2. Drag the pointer down until you mark the Qui t option, and
release the button.

3. When the screen asks you to switch diskettes, remove
Diskette #2 from the drive, replacing it with Diskette #1.

4. Point to the OK button, and click.

You see the desktop once again. Because you didn't change any
of the information in the file, you didn't see the Save changes?
message.

Going Ahead

You now know the techniques needed to perform the procedures
throughout the Sample Session. Wherever you need to use a
technique that hasn't been explained here, you'll see specific
instructions for using that technique. Refer to this chapter as
you go through the sessions if you need help in remembering the
techniques you're using. Chapter 11 in the Reference part of this
manual gives you more detailed information about the concepts
explained in this chapter. Continue reading to find out about the
desktop and a few things you can do with it.
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Chapter 3

THE TANDY DESKTOP

This chapter gets you up and running with Personal DeskMate
and shows you a few things you can do with the desktop. In it,
you'll learn how to:

•  find your way around the desktop

•  change the desktop's appearance

•  tell Personal DeskMate about the printer you're using

If you didn't read Chapter 2, "Getting Started," return to that
chapter now and read it. In it, you load Personal DeskMate and
find out how to use the keyboard or a pointing device during the
Sample Session.

A Tour of the Tandy Desktop

When you load Personal DeskMate, the first thing you see is the
Tandy Desktop. The desktop has on it some of the same things
you probably keep on your desk—a clock, a calendar of the cur
rent month, a notepad for jotting down reminders, and a calcula
tor. But the desktop also has on it several other boxes. These
boxes contain lists of information that Personal DeskMate is
storing for you.

For instance, look at the box entitled CALENDAR. It contains a file
called AGENDA.GAL. This file is a personal appointments agenda.
If you have a desk calendar it might be hiding beneath other
papers. But the desktop organizes information and keeps it
together in a systematic way so that you can find anything you
need, when you need it. The desktop is Personal DeskMate's
"contents" page—it points the way to the different items you can
use Personal DeskMate to store.

A Look at a Menu. Look at the screen's second line, the one
that has small boxes saying File, Directory, Disk, and Bui 1 d.
This is the menu bar. Each box gives you access to a menu that
enables you to perform actions on your information. Just for curi
osity's sake, use the File Menu to look at some information about
the Agenda.cal file.

1. Mark the AGENDA . CAL file in the CALENDAR list box.
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The marker is on the calendar in the upper left. Move the
marker to the AGENDA . CAL file in the CALENDAR list box.

2. Pull down the File Menu.

3. Select the Get Info... command. The screen shows:

File Info

FileneiMe; AQlNDfl.CflL

Size; 205 Bytes

Hodified: 07/01/86 0i;53pM

m

4. Return to the desktop.

The OK button is already marked by the blinking underline.
Select the button.

You're back at the desktop, and now you know a little informa
tion about one of the files. You can use the same procedure to
look at other files you see in application list boxes.

Changing the Tandy Desktop
The way the desktop looks right now isn't necessarily the way
you'll always want to keep it. You can remove some of the boxes
from the screen and display others. As a simple example, you'll
move the calendar to the calculator's position and place the cal
culator in the calendar's old position.

Removing the Calendar and the Calculator, To make Per
sonal DeskMate perform a command on any information, you
must first select that information. You already did this when you
highlighted the AGENDA. CAL file a moment ago. This time, you'll
work with the calendar and the calculator.

1. Be sure that the marker is on the calendar (not the Calen
dar application's list box, but the actual monthly calendar).

2. Pull down the Build Menu.
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3. Choose the Remove option.

That was simple enough. The calendar disappeared (along
with the Build Menu), and now there's a "hole" on the
screen where the calendar used to be.

4. Move the marker to the calculator.

5. Pull down the Build Menu.

6. Choose the Remove option.

Again, the Build Menu and the calculator disappear. The
first step in rearranging the two is complete.

Redisplaying the Calendar and Calculator. Now you'll see
how to put the calendar and calculator back on the screen, but
in different places.

1. Pull down the Build Menu.

2. Choose the Display. . . option. This dialog box appears:

Display Henii

HENU

mMm #n°i I

»j j#

OK "CANCEL

The MENUS section of this window contains a list of every
thing you can display on the desktop. The Menu size section
lets you decide the amount of space you want the "menu"
you choose to occupy on the screen.

3. Select the Calculator for display.

4. Choose the short, wide format from the Menu size section.
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Notice that all the formats except the short, wide one are
shaded. You cannot choose any option that is shaded out. In
this case, the calculator, which is an accessory, must
occupy the format that the screen indicates to you.

5. Finalize your selection.

Press fW1 until you reach the OK button at the bottom of
the box. Select it to tell Personal DeskMate that you've
completed the dialog box and that you want to position the
calculator on the screen.

The upper left of the screen now displays a box of the calcu
lator's size.

6. Choose this location for the calculator's new position.

Press I ENTER I or double click in the upper left of the dotted
box to choose the current location.

The calculator is now in the spot previously occupied by the
calendar, but the screen still has one blank spot left
beneath the notepad.

7. Pull down the Build Menu.

8. Choose the Display... option.

The screen displays the dialog box you saw when you redis
played the calculator.

9. Select the MONTH for display.

The short, wide format is already chosen for you.

10. Finalize the selection.

to the OK button at the bottom of the window. Select it
to tell Personal DeskMate that the dialog box is complete
and that you want to position the calendar on the screen.

The upper left of the screen now displays a box of the calen
dar's size.
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11. Position the box at the bottom left of the screen.

Use the arrow keys to move the marker to the spot just
below the notepad, and press | enter |, or point to the spot just
beneath and toward the left side of the note pad, and double
click.

The calendar is now in the spot previously occupied by the
calculator, and the screen is once again complete.

Setting Up to Print

To print anything as you use Personal DeskMate, you must tell
Personal DeskMate about the printer you're using with your
computer. Follow these instructions to set up Personal DeskMate
for printing.

1. Pull down the Accessory Menu.

2. Select the Printer option from this menu. The screen
shows:

Setup Ppiiitep

Printep naHe; DMF-IBS

Start up ppintep:

□ Line feed filtep

Ppintep contpol codes!

□ Line feed filter

Printer control codes!

Ppi liters

Bold on Bold off

Underline on Unlerline off

tm

3. Choose a printer.

The list box labelled Printers contains a list of printers
you can use with Personal DeskMate. Scroll through the
list until you mark the type of printer you're using, and
then move out of the list box.

The name of the printer you chose appears at the Printer
name : prompt. Move to the next prompt.
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At the start up printer: prompt, you can type charac
ters to be sent to your printer when it starts up. You can,
for example, start your printer in condensed mode. (If you
use a printer that absolutely requires a startup character
to be sent to it, refer to the Reference part of this book to
see instructions on making the proper entry here.)

Some printers require a line feed filter. If your printer dou
ble spaces when printing in Personal DeskMate, check the
line feed filter, and be sure that the Line feed filter
check box is toggled on. If, on the other hand, your printer
tries to print each line over the one it just printed, be sure
that the switch is toggled off. Then, move to the next sec
tion of the dialog box.

The Printer control codes section of the box is filled in

for the printer you chose. Skip through the settings.

4. Finalize your decision.

After you skip the Printer control codes, the DK but
ton is marked. Select it to tell Personal DeskMate that

you've finished defining your printer. The desktop
reappears.

Note: If your printer does not appear on the list, see the Refer
ence part for information on defining your printer.

Final Words

You've seen just a few of the things you can do with the desktop.
As you progress through the Sample Session, you'll return again
and again to the desktop to gain access to other parts of Per
sonal DeskMate. The Reference part of this manual tells you
about all your desktop options. Read it when you're ready to
experiment further with the desktop.

Keep reading to find out about the Text application, where you'll
improve on the Dickinson essay.
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TEXT

This chapter shows you a few features of the Text application. As
you read the chapter and follow the instructions, you'll leam how
to do such things as:

create a file

open an existing file

substitute words with other words

revise text by deleting and adding words

print a document

If you didn't read Chapter 2, "Getting Started," return to that
chapter and read it now. In it, you load Personal DeskMate and
learn how to use the keyboard or a pointing device in the sample
sessions.

Creating a File

The first thing you'll do is create a file and type a paragraph so
that you can get the feel of the way the Text applicafion works.

1. At the desktop, move the marker to TEXT, the title of the
Text application list box, and select it. A screen appears on
which you can type.

2. Type the following paragraph. Don't worry about making
mistakes—in a few moments, you'll learn how to correct
typing errors.

Although many of Emily Dickinson's poems about
nature are also intricate observations on life and

death, she is, in addition, extremely adept at nature
poems of a purely descriptive genre. Her poem begin
ning with "A Route of Evanescence" is a perfect
example of this type of poem.

Press I ENTER I when you finish typing the paragraph. Notice
that as you type, the | marker moves to the right one space
for each character you type. You are working in Insert
mode, meaning that every character you type is inserted at
the marker's current position.
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3. Correct any errors you made in typing by following these
procedures:

To insert a character, move the marker to the space at
which you want to insert, and simply type the correct
character.

To delete a mistyped character, move the marker to the
space directly following the character you want to delete,
and press | backspace |. This deletes the character and moves
the remaining text to the left to "close up" the text.

Opening a File

Now that you've seen how to type text and make simple correc
tions, you'll use a file that is already set up to learn some of
Text's other features.

1. Pull down the File Menu.

2. Choose the Open. . . option. The screen asks whether you
want to save your work.

3. Select the NO button because you don't want to save the
information you typed.

Open File!

EMILLDOC HP

4. Select the EM IL Y . DOC file from the FILES list box.

5. Select the OK button to open the file. The screen shows:
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File I Edit I TextiSearch

flltlioiigli natiy of Ewily Dickinson's poe«s about natre
m also intricate observations on life and death, she is
extre«ely adept at natre poeNS of a purely descriptive
genre, "ft t ' ' ' _ " i i
type of noe«,:

With her rare ability to describe notion, Hiss
Dickinson excels in this portrayal of a himningbird in

ntricate observations on life md.death, she is
i

Poute of Evanescence" is a'perfect exaiipie of th

ltl463H
fl Poute of Evanescence:
With a revolving Wheel--:
ft Pesonance of Enerald--:
ft Push of Cochineal-:
ftnd every Blosson on the Bushi
ftdjusts Its tunbled head-:
The nail fron lunis, probably,:
ftn easy Homing's Pide-:

Enily Dickinson:

is

Line 1 Of Page 1 NorASCII INSERT

Substituting Text

If you read the first paragraph, you'll notice a misspelling. The
word, "nature," is misspelled as "natre." This word is misspelled
throughout the entire document. You could read through the
entire essay, find each place that "natre" occurs, and insert a
"u" in its proper place each time, but there's a much faster way
to do the same thing—via the Search Menu.

1. Pull down the Search Menu.
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. option.Choose the Substitut

Substitute

5. Between the brackets, type the string (the group of charac
ters) that you want to replace.

You want to replace the word "natre", so at the Search
f or : prompt, type natre.

t. Between the brackets, type the string you want to use as a
replacement.

Move to the Replace with: prompt, and type nature.

). Finalize your decision.

Press I ENTER I to select the DK button and let Personal
DeskMate know that you're ready to begin the substitution.

5. Affirm each decision to substitute "natre" with "nature."

Personal DeskMate searches your document from its begin
ning for each occurrence of "natre." As it finds each occur
rence, you see a window asking whether or not you want to
make the replacement.

The YES button is already marked, so select it each time
you see the window appear.

1. Quit using the Substitute. . . command.

After "nature" replaces all occurrences of the misspelled
word, another window appears to tell you the number of
replacements Text made.

The OK button is marked, so select it.

The document now contains no misspelled words.

8. Press | home | to return to the beginning of the essay.
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Revising the Essay

All the words in the essay might he spelled correctly, but correct
spelling is no guarantee that the essay is worthy of a good
grade. In this section, you'll revise the essay and put it in its
final form.

1. Change the first sentence to read: Although many of Emily
Dickinson's poems dealing with nature are also intricate
observations on life and death, she is, in addition, extremely
adept at nature poems of a purely descriptive genre.

The last line of the screen tells you that you're in Insert
mode. Insert dealing with by moving the marker until it is
just before the a of about and typing dealing with.

Next, delete about by pressing | delete | until the word
disappears.

Insert , in addition, by moving the marker directly after
the s of is and typing , in addition,.

2. Delete Miss from Miss Dickinson excels ... in the second
paragraph's first sentence.

Move the marker until it rests just after the s in Miss.
Press I BACKSPACE I five times.

3. This second paragraph also contains an incomplete sen
tence, the one beginning: While the combination of the color
and sound images .... Change this sentence so that it
becomes part of the preceding sentence. When you finish, it
should read: the constant whir of the small bird; while the
combination of the color and sound images ....

Move the marker until it rests just before the period after
bird. Now, move the Overtype mode by pressing I ctrl I 13 or
by clicking on the OVERTYPE button.

Type ; over the period, press the space bar, and type w over
the W.

Return to Insert mode by pressing I ctrl I (T) or by clicking
on the INSERT button.
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4. In the third paragraph, second sentence, delete the last four
words, and is now gone.

Move the marker until it rests just after the t of present.
Press I DELETE I until the period appears just after present.

5. In the nect sentence, delete Miss.

Move the marker to just before the M of Miss, and press
I DELETE I five times.

6. The next sentence ends with that is most vividly described.
Change it to read that is more vividly described.

Move the marker to just before the s of most. Go to Over-
tj^e mode, and tjrpe re over the st. Return to Insert mode.

7. Look back to the first part of the sentence. To emphasize
that the flowers, rather than the poet, react to the depar
ture of the bird, you might want to make their in their
reaction to the hummingbird appear in boldface.

Move the marker vmtil it rests just before the t of their.
Select their by pressing I shif I Q five times or by pressing
the button on your pointing device and dragging the pointer
to the end of their, releasing the button when you finish.

Pull down the Text Menu, and choose the Boldface option.
As soon as you do, the selected word appears in a different
color to let you know that it will print boldfaced.

8. The next paragraph contains an error in noun/verb agree
ment. The part of the sentence that reads speed of the bird
is further underlined should contain are as the verb rather
than is. Change the sentence so that it is correct.

Move the marker until it rests just before the i of is. Press
I DELETE I twice. Then, type are.

9. The next sentence contains the same tjrpe of error—has
appeared should be have appeared. Make the correction.

Move the marker until it rests between the a and s of has.
Press I DELETE I once. Then, type ve.
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10. Look to the paragraph that follows the quote by Shake
speare, the one beginning Through this allusion,....
Change Emily to Dickinson in the first sentence.

Move the marker until it is just before the E of Emily. Type
Dickinson. Then, press I delete I until you delete the
unwanted characters.

11. The next paragraph contains another Miss. Delete it.

Move the marker until it appears just after the last s of
Miss. Press I backspace I five times.

12. Find the sentence in the same paragraph that begins with
She also moves .... Make the sentence contain a somewhat

more parallel construction by changing of "Wheel" and
"Cochineal" to ("Wheel" - "Cochineal").

Delete of by moving the marker directly before the o and
pressing I dLete I three times. TVpe ( to put in the opening
parenthesis. Then, move the marker to just before the a of
and, and press I delete | three times. Tjrpe —. Finally, move
the marker to just after the ending quote of "Cochineal,"
and type).

13. In the last paragraph, delete Miss and splendidly from the
first sentence and exquisitely from the last sentence.

Move the marker until it is just before the M of Miss, and
press I DELETE I five times.

Move the marker until it is just before the s of splendidly.
Press I DELETE I until the word and the space following it
disappear.

Move the marker until it rests just before the e of exquis
itely, and press I delete I until the word and its following
space disappear.
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14. The essay needs no more revision. But you can fill out the
introductory paragraph so that it provides more information
about Dickinson. Return to the first paragraph of the
essay, and change the last sentence so that it reads: "A
Route of Evanescence" is not only a perfect example of this
type of poem, but it is undoubtedly one that she personally
liked and in which she had confidence, as she sent it to six of
her most favored correspondents at various times.

Move the marker back to the first paragraph following the
actual poem, positioning the marker directly before a in
.  . . is a perfect example .... Type not only and press the
space bar. Then, move the marker until it rests just
between the m of poem and the period that ends the sen
tence. Press the space bar, and type but is undoubtedly
one that she personally liked and in which she had
confidence, as she sent it to six of her most favored
correspondents at various times.

The essay is in its final form. Your next step in finishing it is to
print the entire essay.

Printing the Essay

To print the essay, you must set up the way you want each
printed page to look by using Text's Page 3etup option from its
File Menu. After that, you can print the essay. Be sure that you
defined your printer, following the instructions in Chapter 3,
"The Tandy Desktop."

Setting Up a Page Layout. The first thing you need to do is
decide the way you want a printed page to look. To do this, you'll
use the File Menu's Page Setup option. (If your printer prints at
least 80 characters across one line, you can use the settings
explained here. If your printer cannot print as many as 80 char
acters on one line, you'll need to modify the instructions some
what. See the Reference part of this book for instructions on the
Page Setup option.)

1. Pull down the File Menu.

2. Choose the Page Setup... option. The screen shows:
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Left Nai^in:

Feinted Line Hidth:

Total Lines Fee Fage!

Feinted Lines Fee Fage!
ouble Space
Fause Betwen Fages
Send conteol seguence
9 Geaphic mde
O Text mde

3. Choose the general format of your page.

The top part of the window shows you three layouts you can
choose for printing the essay: A "portrait" style, a "land
scape" style, or a "notebook" style. To print a standard
essay on 8 1/2" by 11" paper, push the button for the first
option, the "portrait" style.

4. Set up the margins and limits for a printed page.

At the Left Margin: prompt, type 10 to specify a left
margin of 10 characters (about one inch).

At the Printed Line Width: prompt, tSHpe 60 to specify
that you want no more than 60 actual characters to appear
on a line.

At the Total Lines Per Page: prompt, tj^ie 66 to tell
Personal DeskMate that the paper you're using can print a
maximum of 66 lines on one 8 12" by 11" page. (This
assumes that the printer prints six lines per vertical inch.)

At the Printed Lines Per Page: prompt, type 54 tO
specify that you want to print only 54 lines on one page.
This gives you top and bottom margins of about one inch
each (66 - 12 = 54).
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5. Choose any features you want to use while printing.

At the Double Space prompt, turn double spacing on
(which means that the essay will print double spaced).

At the Pause Between Pages prompt, either toggle the
setting on (if you're using single sheets in your printer), or
leave it oif (if you're using continuous-feed forms).

At the Send control sequence prompt, toggle the choice
to turn it off if you left the Start up printer prompt (in the
Printer accessory) blank. If you entered a sequence to start
up your printer, toggle this setting on.

6. Choose the mode you want your printer to use for the essay.

The next small box lets you choose between printing in
Graphic mode or Text mode. To use the graphic mode (of
a printer capable of producing graphics) for printing the
essay, select Graphic mode. (Note that the essay will print
very slowly and that the quality of the output will be
reduced.) If your printer cannot print graphics, or if you
want to use the text mode of a graphics printer, select the
Text mode button.

7. Finalize your selections.

Press I TAB I to reach the DK button, and select it. The Page
Setup dialog box disappears, and you're back at the essay.

Printing. To print the essay, you'll use the Print option on the
File Menu.

1. Pull down the File Menu.

2. Choose the Print. . . option. A window gives you the
choice of printing on the screen or on a printer.

3. Use your printer to produce a copy of the essay.

Skip the Screen line, and select Printer as the device to
which you'll print the essay.

4. Get your printer ready.

Be sure that your printer is properly connected to the com
puter and that it's turned on. Be sure that the top of the
paper is aligned with the print head. Finally, check to see
that the printer is on line.
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5. Finalize your selection.

Select the DK button. The essay begins printing. When it
finishes, take it from the printer.

Back to the Tandy Desktop

Y)u've seen some of the ways you can use the Text application's
features. The Reference part of the manual explains all the Text
options and features. You can now close the Emily.doc file and
return to the desktop.

1. Pull down the File Menu.

2. Choose the Quit. . . option.

3. At the Save changes? prompt, the YES button is already
marked, so select it. The Emily.doc file closes, saving the
revisions you made to it throughout this chapter. Once
again, the desktop returns to the screen.
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WORKSHEET

This chapter shows you one way to apply the Worksheet applica
tion in developing a monthly expense budget. The budget is a
simple one, hut you can expand it and make it more elaborate to
suit your needs. As you develop the budget and try it out, you'll
learn how to:

label columns and rows to organize the information on the
worksheet

position the budget figures on the worksheet

write simple formulas

calculate a worksheet

shift the positions of rows on the worksheet

plug in several figures to see how they affect the budget

If you didn't read Chapter 2, "Getting Started," return to that
chapter now and read it. In it, you load Personal DeskMate and
find out how to use the keyboard or a pointing device during the
Sample Session.

Creating a File

You'll build the budget from scratch, so you need to create a file
to hold it. Select and open the Worksheet application. The screen
shows:
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Labelling the Columns and Rows
The first thing you need to do is lay out the way your budget
will be presented on the screen.

1. Label the major headings for the columns—EXPENSE CAT
EGORIES, BUDGET AMOUNT, ACTUAL AMOUNT, and
NET AMOUNT.

The marker is in Cell 1,1. 1,1 is the cell's address. Each
cell address corresponds to a row and column number. You
could also read this address as Row 1, Column 1.

In Cell 1,1, type EXPENSE. Notice that LABEL is high
lighted on the bottom line of the screen to indicate the type
of information you're placing on the worksheet.

Move the marker to Cell 2,1, and type CATEGORIES.

Move the marker to Cell 1,2. Press the space bar four
times, and type BUDGET.
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Move to Cell 2,2, press the space bar four times, and type
AMOUNT.

Move the marker to Cell 1,3, press the space bar four times,
and tjrpe ACTUAL.

Move the marker to Cell 2,3, press the space bar four times,
and type AMOUNT.

Move the marker to Cell 1,4, press the space bar four times,
and type NET.

Move to Cell 2,4, press the space bar four times, and type
AMOUNT.

Ifbiu* headings should look like this:

iQ Harcli 2, 1987 Horkslieet - (Uiititled)

1 E!<PENSE
2 CftlEGORIES
3

5
6

2. Label the expense categories (the row labels)—Mortgage,
Phone, Electric, Water, Gasoline, Car Ins, Svc Chg, Credit
Crd, Groceries, and Daycare.

Move the marker to Cell 4,1, and type Mortgage.

Using the arrow keys, move the marker to the following
cells and type the appropriate labels:

In this cell: Type this:

5,1 Phone

6,1 Electric

7,1 Water

8,1 Gasoline

9,1 Car Ins

10,1 Svc Chg
11,1 Credit Crd

12,1 Groceries
13,1 Daycare

Skip Row 14, and in Cell 15,1, type TOTALS.
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Your worksheet should look like this:

iO Harcli 2, 1987 Mopkslieet - (Uiititled)

'1 ' 2 ■ 3 4 5
1 EXPENSE BUDGET flCIUftL NET
2 CAIEGORIES flHOUNI fiHOUNI AHOUNI
3
4 Nortgage
5 Plioiie
8 Electric
7 Water
8 Gasoline
9 Car Ins
10 Soc Ciig
11 Credit Crd
12 Groceries
3 Dagcare

Ik)'55 a« i

LflBE Tm WJHBO INPUT FOHIM

Typing Figures

The worksheet is labelled, and you can now add the budgeted
and actual dollar amounts to it.

1. Enter the budgeted amounts.

Move the marker to Cell 4,2, and type 900 I enter
gets $900.00 per month to

This bud-

the mortgage expense. Notice
that NUMBER is now highlighted at the bottom of the screen
to indicate that you're typing numbers rather than labels.
Notice also that you don't have to type 900.00 to display
your entry in "dollars and cents" format. Worksheet auto
matically assumes this format until you change it.
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Type the rest of the budgeted amounts in these cells:

In this cell: Type this:

5,2 50

6,2 100

7,2 35

8,2 100

9,2 70

10,2 12

11,2 350

12,2 200

13,2 250

Enter the actual amounts.

Move the marker to Cell 4,3, and type 900 I enter |.

Enter the rest of the actual amounts in these cells:

In this cell: Type this:

5,3 32.56

6,3 89.17

7,3 24.88

8,3 114

9,3 70

10,3 12

11,3 341.27

12,3 179.35

13,3 250

Your worksheet should look like this:
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=0 Hapcli 2, 1987 Worksheet - (Uiititled)

'i ■ 2 ■ 3 4 5
EXPENSE BUPGEI flCIUWL NET

2 CfllEGORIES ftHOUNI AHOUNI AHOUNI
3
4 Hortgage 900,00 900.00
5 Phone 50,00 '32,58
8 Electric 100,00 89,17
7 Water 35,00 24,88
8 Gasoline 100,00 114.00
9 Car Ins 70,00 70,00
10 Soc Chg 12,00 12,00
11 Credit Crd 350,00 341,27
12 Groceries 200,00 179,35
13 Daycare 250,00 250.80

Writing Formulas

The worksheet has all the numbers plugged into the right places,
but they won't do you any good until you can calculate totals
and see how much over or under budget you are. To perform cal
culations, you need to give Worksheet some formulas to use.

A Formula to Total the Budgeted Amounts. First, give Work
sheet a formula that will total the budgeted amounts.

1. Move the marker to Cell 15,2.

2. Pull down the Cells Menu.

3. Choose the Formula. . . option. The lower part of the
screen displays this window:
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Edit FoMila

FomuU:
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This window lets you type new formulas or change existing
ones. The Formula: prompt has nothing following it
because the marker is on a blank cell in the worksheet and
because you've entered no formulas yet.

4. Type a summation formula to add the amounts in Rows 4-
13, Column 2.

%u could use the + operator (which stands for "add") and
type R4 + R5 + R6 + R7... and so on, until you
included all the rows you wanted to include in the summa
tion, but Worksheet offers you an easier way. At the
Formula: prompt, tJT)e:

SUM(R4)

This tells Worksheet to display the sum of all the amounts
in the column where the marker is (Column 2), beginning
at Row 4 and ending at the row above the current one (Row
14).

5. Confirm the formula.

Select the DK button.

The window disappears, and your formula is displayed at
the bottom of the screen.

A Formula to Total the Actual Amounts. The formula you
used for totalling budgeted amounts is equally useful in total
ling actual amounts spent. Enter the same formula in the
ACTUAL AMOUNT column.

1. Move the marker to Cell 15,3.

2. Pull down the Cells Menu.

3. Choose the Formula... option.
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4. Type a summation formula to add the amounts in Rows 4-
13, Column 3.

At the Formula: prompt, type SUM(R4).

This tells Worksheet to display the sum of all the amounts
in the column where the marker is (Column 3), heginning
at Row 4 and ending at the row above the current one (Row
14).

5. Confirm the formula.

Select the QK button. The window disappears.

A Formula for Calculating Net Amounts. %u need only one
more formula—one for figuring whether the actual amounts for
each category are under or over budget. This formula will give
you totals for each category and for the total budget amount v
the total actual amount.

1. Move the marker to Cell 4,4.

2. Select Rows 4-15 in Column 4. This lets Worksheet know
that you intend the formula you tj^e to apply to all the
selected cells.

With a keyboard: Hold down I shift I. and press (T] until the
cells through Row 15 are highlighted.

With a pointing device: Point to cell 4,4, and press and hold
the button. Drag the pointer down until the cells through
Row 15 are highlighted, releasing the button when you
finish.

3. Pull down the Cells Menu.

4. Choose the Formula . . . option.

5. Type a formula to calculate net amounts of budget
categories.

At the Formula: prompt, t5^e C2-C3.

This formula takes, for each category (including totals),
the amount in Column 2, subtracts the corresponding
actual amount in Column 3, and displays the net amount
for that category in Column 4.

6. Confirm the formula.

Select the OK button.
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Calculating the Worksheet

You're ready to see what Worksheet does with the figures in this
simple budget.

1. Pull down the Pad Menu.

2. Choose the Calculate option.

Worksheet calculates the entire budget, row by row, one
expense category after another. When calculations finish,
your screen should look like this:

iQ Harcli 2, 1987 yopkslieet (Untitled)

1 EXPENSE
2 CfilEGORlES
3
4 Hortgage
5 Phone
6 Electric
7 Hater
8 Case line
9 Car Ins
10 See Clig
11 Credit Crd
12 Groceries
13 Paycare
14
15 lOIftLS

2  3
BUDGET fiCIUflL
ANOUNI UNOUNI

2087.00 2013.23

The budget looks good. Only the gasoline expense went over
budget, and enough other expenses were under budget so
that the total amount spent, 2013.23, is nicely under the
planned total.
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Repositioning the Worksheet
You can give the worksheet a title so that you'll know which
month's budget you're calculating. To do this, you need to insert
two rows at the top of the worksheet and then type the title. But
what about all the cell addresses you used in the formulas?
Won't those have to change once the two new rows are on the
worksheet? Yes, they'll need to change, but Worksheet does this
work for you. Follow the instructions below to find out how.

1. Move the marker to the beginning of the worksheet.

Press I HOME I, or point to the appropriate scrolling arrow on
the menu bar, and press and hold the button until you
reach the beginning of the worksheet.

2. Pull down the Pad Menu.

3. Choose the Insert row option. The information on the
worksheet shifts down, and Row 1 is now blank.

4. Leaving the marker in its current location, follow the same
procedure again to insert a second blank row. Rows 1 and
2 are now blank.

5. Type the budget's name, BUDGET FOR SEPTEMBER.

Move the marker to Cell 1,2, and type the first part of the
title: BUDGET FOR. Then, move to Cell 1,3. Press the
space bar, and type SEPTEMBER.

6. Move the marker to Cell 17,2.

You can see that the formula has changed to accommodate
the extra rows you added. It now shows SUM(R06).

Using Different Figures and
Recalculating
So far. Worksheet has shown you that it can perform a few calcu
lations. But you could have gotten the same results using a cal
culator. Worksheet takes you a step further, though. Once you
set up a worksheet, you can plug in different figures and see how
they affect calculations—much more quickly than you could go
through the calculations by hand. For instance, you can use the
worksheet to calculate another month's budget by changing the
figures in the ACTUAL AMOUNT column.
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1. Move the marker to Cell 13,3, the ACTUAL AMOUNT for the
Credit Crd category. Suppose that you charged more than
usual due to a wallpapering project in one of the bedrooms.
Change the amount from 341.27 to 463.00.

Type 463. When you type the 4, the remainder of the cell
clears to let you type a new number.

2. Move the marker to Cell 14,3, the Groceries category.
Change 179.35 to 258.75 to reflect a higher grocery total
because of a party you gave.

Type 258.75 I enter |.

3. Pull down the Pad Menu.

4. Choose the Calculate option.

Worksheet recalculates the budget, and you can quickly see the
difference between the first budget and this latest one.

Naming the File and Returning to the
Tandy Desktop

You're finished with the file for now, so you can give it a name
and return to the desktop. The Reference part of the manual
explains all the Worksheet features.

1. Pull down the File Menu.

2. Choose the Quit option.

The screen asks. Save changes?

3. Save the worksheet as it now stands.

The YES button is marked, so select it. Now the screen
asks. Save as:.

4. Name the worksheet BUDGET.

Type BUDGET | enter | as the filename.

You return to the desktop.
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FILER

The Filer application lets you track anjrthing you might keep in
a filing cabinet on a form. Using Filer, you create a database (a
filing cabinet drawer) to hold records (individual file folders) that
contain fields (the information in the folder). This chapter shows
you about Filer, teaching you how to:

•  create a form to hold information

•  add records to the database

•  sort the records in any of several orders

•  create and print a report about the records

")5)u'll leam how to work with Filer by setting up a file to hold
information about charitable contributions.

If you didn't read Chapter 2, "Getting Started," return to that
chapter now and read it. In it, you load Personal DeskMate and
find out how to use the keyboard or a pointing device during the
Sample Session.

Warning: If you're using a single-drive computer, you
must keep the Filer program (PMFILER.PDM) and
any data files you create on the same diskette. If
you're using multiple drives, you can store PMFI
LER.PDM and its data files on separate diskettes.

Whether you use one or two drives with Filer, never
switch diskettes unless and until the screen instructs

you to do so. If you switch diskettes at any other time,
you risk destroying both program and data files.

If you're not using subdirectories, continue with this
chapter. If, however, you are running the Filer appli
cation from a subdirectory, that subdirectory must
appear in the list of paths used by the path com
mand. For example, if you include the path command
in your autoexec.bat file, it might look like this:

path = a: \ pathl ;a: \ deskmate

where deskmate is the subdirectory in which Filer
resides.
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Creating a File
To open the Filer application and create the file you'll use, follow
these instructions.

1. Move the marker to the title line of the FILER list box on

the desktop.

2. Press I enter |, or double click to run the application.

3. Pull down the File Menu, and choose the New option.

A blank screen appears with the file name, (Untitled).
This is the screen on which you create the record format,
the form that will hold the information.

Creating the Record Format
To set up a database, you need a way to organize and type the
information you want to track. To do this, you create a record
format. The record format is similar to a sheet of paper in a file
folder. To create the format, follow these instructions.

1. Position the marker toward the center of the screen, on the
second line from the top.

2. Type Charitable Contributions~1987 | enter |.

3. Move the marker two or three lines down, 20 spaces from
the left margin of the screen.

4. Pull down the Field Menu, and choose the Add option.

5. Define the size of this field, or unit of information, as eight
characters.

With the keyboard: Press [£] seven times to display eight
character slots, or squares that hold characters. Press
I ENTER |.

With the pointing device: Position the marker where you
want the first character to appear. Press and hold the but
ton, and drag the pointer until eight character slots (small
squares that hold characters) appear. Release the button.

This dialog box appears:
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Data Type
Oteidff nuHbep

Label
Oleft 9top Vhidden

OK CftNCEL

Give the field a label of Date:.

At the Label: prompt, type Date:

The buttons in the Outlined, Data Type, and Label sec
tions of the box are already set to the definitions you want
for this field. Skip these sections of the box.

Finalize your choices.

Select the GK button at the bottom of the dialog box.

Move the marker to different locations on the screen, and
create the following fields, following the procedures in Steps
4-8 and using these guidelines.

Outlined Data

Type
Label

Type
Number of

character

slots:

Label:

When adding the receipt field, simply press I enter I when
defining the field's size.
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You can position these fields anywhere on the screen that
you find useful and attractive. Remember to leave enough
space for field labels. When you finish adding fields, your
screen might look something like this:

File H Edit B Hecopds i Field i Text B teport i Index
iQ Harcli 2, 1987

Method of Payment! Q

Receipt? C

loiintl li

Charitable Conti(>ibittioiis--1987

Adding Format Characters. You can add characters that will
become permanent parts of fields and save you the boredom of
typing, for instance, parentheses and dashes every time you type
a phone number. These characters are called format characters.
To add format characters to the Date: and Amount; fields, follow
these instructions. Be sure to use the arrow keys to move the
marker to slots where you'll type format characters. Don't use
the space bar. Filer considers spaces to be format characters.

1. Move the marker to the Da t e: field, and select it.

Press the space bar if you're using the keyboard, or point to
the field and click if you're using a pointing device.

2. Pull down the Field Menu, and choose the Format option.
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3. Format the Date: field so that dates will appear in a
mm/dd/yy format.

Use the arrow keys to move to the third character slot, and
type /. Skip two more characters, and type another /. Then,
press I ENTER |.

4. Move the marker to the Amount: field, and select it.

5. Pull down the Field Menu, and choose the Format option.

6. Format the Amount: field so that it begins with a dollar
sign and contains a decimal point in the third-to-last slot.

Type $ in the first character slot. Move to the third-to-last
slot in the field, and type a period (.). Finally, press I enter |.

The record format is now complete. You can begin adding records
to the file.

Adding Records

"Vbu have a form on which you can enter information. Now you
can add information about your contributions to the database.
Follow the instructions below.

1. Pull down the Records Menu, and choose the Change
option.

The Add option automatically becomes active because you
have no records in the file yet.

2. The record format appears on the screen, and the marker is
in the Date : field. Type 021087.

Notice that the marker skipped over the slashes you
included as format characters.

3. Move to the Amount : field.

With the keyboard: Press I tab I to move the marker from
one field to the next, top to bottom, left to right. Use I shift |
I TAB I to move backward from one field to another.

With the pointing device: Point to the Amount: field, and
click.
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4. Type 350 as the amount of this contribution.

The number appears as 3.50 because of the decimal point
format character.

5. Move to the Organizat ion: field, and tjHpe Birdville ISD.

6. Move to the Method of Payment : field, and type cash.

7. Move to the Receipt? field, and t5^e N.

8. Move to the Comment s : field, and type Candy Sale.

9. Store the first record, and prepare to add a few more.

To store a record and continue adding, simply pull down the
Records Menu, and choose the Add option (or press I ctrl I
(T)). Filer stores the record, and you see another blank
form, ready for you to complete.

10. Add the following records, following the same procedure as
you used in adding the first one, and using the information
below. After you add the last record, do not pull down the
Record Menu and choose Add again. Continue reading the
next section.

Date: 021987

Amount: 2000

Organization: United Way
Method of Payment: check
Receipt ? Y
Comment 5 : Monthly Contribution

Date: 022387

Amoun t: 2200

Organization: Girl ScOUts
Method of Payment: check
Receipt? Y
Comments: Cookies

Date: 030987

Amoun t: 5000

Organ i za t i on: USA for Africa
Method of Payment: Visa
Receipt? Y
Comment 5 : (leave this field blank)
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Date: 031887

Amount : 6000

Organization: KORA-TV
Method of Payment : AmEx
Receipt? Y
Comment 5 : 1 year of public TV

Da t e : 031987

Amount : 2000

Organization: United Way
Method of Payment: check
Receipt? Y
Comments: Monthly contribution

Date: 040487

Amount : 7500

Organization: Gospel Mission
Method of Payment: gOOds
Receipt? Y
Comment 5 : Donated old bed

Sorting Records

You have seven records in the file, enough to see the way Filer
can arrange and present the information for you. As you added
the records, you might have noticed that you added records in
order of when the contributions were made, beginning with ear
lier dates and ending with later ones. The records were already
sorted according to date. Filer can, however, sort your records for
you in any order you like. For instance, in this section, you'll see
how to make your records appear in order of smallest contribu
tions to largest ones.

1. The last record you added should be on the screen. Pull
down the Records Menu, and choose the Sort option. You
see this dialog box:
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OK CLEAR CANCEL

Notice that the box is divided into several sections. The
blank lines preceded by radio buttons is the section in
which you establish priorities you want Filer to use when it
sorts your records.

Scroll through the FIELDS list box until you mark the
label, Amount :.

Move out of the FI ELDS list box, back to the blank lines.

Filer places Amount: in the first blank, meaning that when
it searches your records. Filer will scan the Amount; field
in each record, see which record has the least amount
listed, and display it first. Then, it will display the record
with the next larger amount, and so on, until finally it
shows you the record containing the largest amount.

Push the radio button for the second priority (the second
line in the section).

Move to the FI ELDS list box, and mark the Dat e : label.

Move out of the FIELDS list box, back to the priorities
section.

Filer places Date: in the second priority slot. If Filer
encounters two records containing the same amounts (the
first priority), it will then search through the Date: field of
each record and list the two records in order of the contri
bution made earliest.
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7. Finalize the priorities.

Push the DK button at the bottom of the dialog box to
establish these priorities. If you had several records and
they contained many fields, you could have defined as many
as five priorities for sorting.

Displaying Records

You can see the results of the sorting priorities you established
by displaying the records in the file and noting the order in
which they appear. Use the following instructions to display the
records in order of amount and organization.

1. Pull down the Records Menu, and choose the Display
option.

The record that contains the least amount, the one for the
Birdville School District's Candy Sale, is the first record
you see.

2. Display the next record.

With the keyboard: Press I ctrl I ® to activate the NEXT
button at the bottom of the screen.

With the pointing device: Point to the NEXT button, and
click.

The record for the United Way contribution on 2/19/87
appears. There are two records for United Way contribu
tions of the same amount, but this is the contribution that
was made earliest.

3. Continue displaying records, one by one, using the NEXT
button.

4. When you see the record for the Gospel Mission contribu
tion, you've reached the end of the records. (Notice that the
NEXT and LAST buttons are shadowed.) Display the first
record again by pushing the FIRST button at the bottom of
the screen.

With the keyboard: Press I ctrl I [T|.

With the pointing device: Point to FIRST, and click.
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Limiting the Records That Appear

Sometimes you might not need to see every record in your file,
but only those containing certain information. You could look
through every record, searching for the ones you want—but why
bother, when Filer can search for the records and display them
for you?

Suppose that you want to see only records for contributions of
$50.00 or greater. To make Filer find and display only these rec
ords, follow the instructions below.

1. Pull down the Records Menu, and choose the Find option.
This dialog box appears:

Find Records

Find all records in uhich;

anization
Method of Pa

to
iill%~t equal to
iP'Less or equal to
•Creator or equal to
• in between

Value;

Notice the section of the box entitled Find all records

in which. The section is empty. Your search criteria will
appear here after you tell Filer information about the rec
ords you want to see.

Tell Filer that you want to see records in which the number
in the Amount: field is greater than or equal to $50.00.

This is a matter of "composing a sentence" that tells Filer
the field that must meet a standard, the relationship
between information in the field and the standard it must

meet, and the standard itself.
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Look at the FIELDS list box. Scroll through the list until
you mark the Amount; field, and then move the marker to
the group of radio buttons beside the section containing the
relationships: equal to, not equal to, and so on. The field
label you marked appears in the first line of the Find all
records section.

Move to the radio button beside Greater or equal to,
and push the button. Then, move the marker to the edit
field below the Value; prompt. Notice that the relationship
now appears as well as the field name in the Find all
records section.

In the blank edit field, type 5000 to specify $50.00 as the
standard against which the information in the Amount:
field will be judged. Then, move the marker to the DK push
button at the bottom of the window. The value you t5rped
now appears in the Find all records section, and the
"sentence" is complete.

3. Select the OK button to put this search criterion into effect.

You could specify other criteria by pushing the radio but
tons in the succeeding lines of the Find all records sec
tion and composing more sentences, but this example is
enough to show you the concepts involved in limiting the
records you want to see.

The record for the USA for Africa contribution appears.
Because the sorting criteria you established is still in
effect, the records containing amounts of $50.00 or more
appear in order of least amount to greatest amount.

4. Use the NEXT button to see the next record that meets the
search criteria—^the KORA contribution of $60.00.

5. Use NEXT again to see the Gospel Mission contribution of
$75.00.

Notice that the NEXT and LAST buttons now appear shad
owed. This tells you that this is the final record that meets
the criteria. There is no "next" record to see.

6. Use the FIRST button to display the USA for Africa record
again.
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Changing the Search Criterion
You need to change the criterion already established to one that
shows you only records from March, 1987. Follow these
instructions:

1. Pull down the Records Menu, and choose the Find option.

The radio button beside the first line in the Find all

records section is already pushed. "Vbur previous search
criterion still appears.

2. Be sure the marker is in the FIELDS list box, and mark
the Dat e : field.

3. Move to the "relationships" section of the box, and push the
radio button for I n between.

4. Move to the first edit field below the Value: prompt, and
type 030187. Move to the second field, and type 033187.

This tells Filer that you want to find records that fall in a
date range between 03/01/87 and 03/31/87, including the
1st and the 31st.

5. The new criterion should now he on the first line of the

Find all records section. Select the □ K button to put the
criterion into effect.

Setting Up a Report
You can see that Filer, even with a file this small, is a powerful
tool. To see another way you can use the application to organize
your information, you'll develop a report that shows you all the
contributions you made in March, 1987.

Putting Headings on the Report. Now that you've told Filer
which records you want to see, you need to set up the report.
Begin by placing headings on the report.

1. Pull down the Report Menu, and choose the Define option.
The screen shows:
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Notice the four sections on the screen: Header, Body, Sum
mary, and Footer. These sections are ones in which you
define different types of report information.

In the Header section, move the marker to slightly left of
the center of the screen on the second line, and type Con
tributions for March I enter |.

On the same line, move the marker to about 15 spaces
before the right margin of the screen. Pull down the Report
Menu, and choose the Today's date option.

MMM DD, YYYY appears at the marker position. When you
see the report, the date you entered when you started up
the computer will appear instead of the MMM DD, YYYY
symbol.

Move the marker to the last line of the section. About three

spaces in from the left margin, type Date | enter |.

Move the marker about 9 spaces to the right on the same
line, and type To I enter |.



DeskMate Sample Session

6. Move the marker 33 spaces to the right on the same line,
and type Amount I enter |.

Positioning Fields. You have a rough idea of the column posi
tioning for information on the report. Now you need to tell Filer
the fields you want to see on the report.

1. Move the marker to the Body section of the report. On the
first line of the section, position the marker just under the
Date heading you typed.

2. Pull down the Field Menu, and choose the Add option. This
dialog box appears:

i;!f5 Add Field to Report

LalielilDate;

] FIELDS [
DaFei

The Date: label already appears in the edit field.

3. Move the marker to the DK button, and select it.

Eight character slots appear to let you know that a field is
positioned at this place on the report.

4. Move the marker on the same line until it is directly
beneath the T o heading you typed.

5. Pull down the Field Menu, and choose the Add option.

6. Move the marker to the FIELDS list box, and mark the
Organization: label.

7. Select the OK button.

Thirty character slots appear where the marker is
positioned.



8. Move the marker on the same line until it is directly
beneath the Amount heading.

9. Pull down the Field Menu, and choose the Add option.

10. Move the marker to the FIELDS list box, and mark the
Amount : label.

11. Select the DK button.

Formatting Summary Information. You've determined the
fields whose information will appear in the different columns of
the report. You can also place summary information on the
report. For this report, place a total of the contributions you
made in March in the Summary section by following these
instructions.

1. Move the marker to the first line of the Summary section. A
few spaces in from the left margin of the screen, type Total
Contributions Made: I enter |.

2. Skip two or three spaces. Then, pull down the Report
Menu, and choose the Summary. . . option. Leave eight slots
for the field, and press I enter |. This dialog box appears:

Outlined
'uesOno

Label
O lefts top S hidden

♦  FELDS ♦

CANCEL

At the Label: prompt, type TOTALS. Move to the section
entitled Out 11 ned.



DeskMate Sample Session

4. Press the radio button for no outline around the sum

mary field.

5. Move to the Label section of the dialog box, and press the
radio button for hidden.

6. Move the marker to the F1 ELDS list box, and scroll through
the box until you mark the Amount: field.

7. Move to the group of radio buttons that specify the type of
summary you want to see. Press the button for Total.

This tells Filer to show you a total of the amounts that are
listed on the report. (You could have chosen to see an aver
age of the amounts or a count of the number of contribu
tions you made by pressing the other radio buttons in this
group.)

8. Select the OK button to create the summary field.

9. Format the summary field.

Pull down the Field Menu, and choose Format. Type $ in
the first slot. Use the arrow keys to move to the third slot
from the end, and type a period. Then, press I enter |.

Finishing the Definition. You've finished defining the report
format. Notice that you didn't put any information in the Footer
section of the report. Because the file as a whole is so small, the
entire report requires less than a page, making an element like
a page number unnecessary.

The next thing you'll do is print the actual report. Pull down the
File Menu, and choose the Page setup option. This gets you
ready for the next step.

Getting Ready to Print

If you performed the steps in Chapter 3, "The Tandy Desktop,"
you've already set up your printer. If you haven't defined the
type of printer you're using, return to Chapter 3 now, and follow
the instructions.

If your printer is already set up and you followed the instructions
in "Finishing the Definition," the Page setup dialog box is on
the screen. Follow these instructions to set up the report so that
it prints on an 8 1/2" by 11" sheet of paper.
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1. Be sure that the radio button for the first type of format,
the portrait style, is pushed.

2. Set up the limits for a printed page.

At the Printed Line Width; prompt, type 80 to specify
that you want no more than 80 actual characters to appear
on a line.

At the Total Lines Per Page: prompt, tjrpe 66 to tell
Personal DeskMate that the paper you're using can print a
maximum of 66 lines on one 8 1/2" by 11" page.

At the Printed Lines Per Page: prompt, type 54 to
specify that you want to print only 54 lines on one page.
This gives you top and bottom margins of about one inch
each (66 - 12 = 54).

3. Choose any features you want to use while printing.

At the Pause Between Pages prompt, leave the setting as
it is. The report is only one page in length, so it doesn't
matter whether you use single sheets or continuous-feed
paper.

At the Send control sequence prompt, toggle the choice
to turn it off if you left the Start up printer prompt (in
the Printer accessory) blank. If you entered a sequence to
start up your printer, leave this setting on.

4. Choose the mode you want your printer to use for the
report.

The next section lets you choose between printing in
Graphic mode or Text mode. To use the graphic mode (of
a printer capable of producing graphics) for printing the
report, select Graphic mode. (Note that the report will
print very slowly and that the quality of the output will be
reduced.) If your printer cannot print graphics, or if you
want to use the text mode of a graphics printer, select the
Text mode button.

5. Finalize your selections.
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Select the OK button, and the Page setup dialog box
disappears.

Printing the Report
You're ready to print the report. Follow these instructions to pro
duce the report.

1. Pull down the Report Menu, and choose the Display
option.

2. Pull down the File Menu, and choose the Print option.

3. Specify that you want to print the report on your printer
rather than on the screen.

Push the Printer button to make the choice.

4. Get your printer ready.

Be sure that your printer is properly connected to the com
puter, that it's turned on, loaded with paper, and on line.
Roll the paper so that the print head is six lines from the
top of the page.

5. Finalize your selection.

Select the OK button. The report begins printing. When it
finishes, take it from the printer.

Notice that all the contributions for March, 1987, are listed on
the report and that you can see the total amount you spent on
contributions at the bottom of the report.

Naming the File and Returning to the
Tandy Desktop

You've seen some of the things that Filer can do to help stream
line your filing system and organize your information. Filer con
tains other features, such as indexing, that offer you even more
possibilities. The Reference part of this manual explains all Fil
er's features in detail. For now, name the file you created, and
return to the desktop by following these steps.

1. Pull down the File Menu, and choose the Qui t option.

The screen asks. Save changes?

74



6 / Filer

2. Save the file as it now stands.

Select the YES button. The screen shows, Save as:.

3. Name the file DONATION.

T5^e DONATION I enter |. You return to the desktop.
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Chapter 7

PAINT

This chapter shows you one way to use the Paint application.
Paint lets you become an artist on the computer screen. You can
draw freehand pictures or let Paint draw some standard shapes
for you. In this chapter, you'll learn how to:

•  put text characters into a picture

•  use different tools to create a picture

You'll paint a very simple picture of a train to try out a few of
Paint's features. Because some of the keyboard and pointing
device procedures in this application differ from the ones used
normally in Personal DeskMate, instructions are provided for
both pointing device and keyboard users when necessary. Note
that if you are using a pointing device with Personal DeskMate,
you cannot use the keyboard to move the marker on the canvas.

Running the Paint Application

To load and run the Paint application, move the marker on the
desktop to the PAINT list box, and press I enter | or double click.
The screen shows:
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;Q Harch 2, 1987
'' inniiiMiifBiiiiiBinia
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Along the bottom of the screen are the colors Paint is currently
using. You'll use these colors as you create your painting. The
left of the screen shows you the different tools you can use. You'll
use a few of these tools as you paint in this chapter.

Choosing Colors
The first thing you'll do is choose the four primary colors with
which you'll paint. These colors will appear as the first four
along the bottom of the screen. The next six colors are combina
tions of the four primary ones you choose. To choose colors, follow
these instructions:

1. Pull down the Accessory Menu, and choose the Color
option.

2. Select blue as the first color.

Push the radio button for color #1 in the Palette
colors: section. Then, move the marker to the next sec
tion, and press the button for Blue.
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3. Select green as the second color.

Move the marker back to the top section, and push the
radio button for color #2. Move the marker back to the

Color Choices: section, and press the button for Gr een.

4. Select light yelloiv as the third color.

Move the marker back to the top section, and push the
radio button for color #3. Move the marker back to the

Color Choices: section, and press the button for Light
Yellow.

5. Select red as the fourth color.

Move the marker back to the top section, and push the
radio button for color #4. Move the marker back to the

Color Choices: section, and press the button for Red.

6. Finalize your color selections.

Move the marker to the OK button at the bottom of the win

dow, and select it.

The window disappears, and you can see the colors you
chose along the bottom of the Paint screen.

Placing Text on the Screen
The next step is to put a label at the top of the picture. To do
this, follow these instructions.

1. Pull down the Text Menu, and choose the Color option. You
see this dialog box:

79



DeskMate Sample Session

2. Push the radio button that corresponds to red.

3. Finalize your color selection.

Select the DK button to make all text you type appear in
red.

4. You're back at the canvas, ready to choose the Text tool, the
tool that looks like this:

With the keyboard: Press I shift I | tab | to move to the Tools
section of the screen. Use the arrow keys to mark the Text
tool. Press the space bar to use the Text tool. Then, press
I TAB I to move back to the canvas.

With a pointing device: Point to the Text tool in the Tools
section of the screen. Click to use the tool. Then, point at
the canvas again.

5. Position the marker near the top of the screen, slightly left
of the center.

With the keyboard: Press (T] until the marker is near the
top of the canvas. Then, press Q to move it near the center
of the line. Press the space bar.

With a pointing device: Point to a line near the top of the
canvas, slightly left of the center of the canvas, and click.

6. Type TRAIN | enter |, and press the space bar or click again.

Notice that the word appears in red.

Setting Line Width and Color
Drawing the body of the train involves using another tool, the
solid square. Before you draw the rectangles that make up most
of the train, you need to set the line width and color so that the
parts appear outlined the way you want.

1. Pull down the Options Menu, and choose the Line option.
You see this dialog box:
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Liiie width;

-• -• mn -m

Lilie colop;

■« Do

CANCE

2. Choose the widest line width.

Move the marker to the third radio button (the one for the
widest line), and push it.

3. Move to the next section of the box, and choose yellow as
the line color.

Move the marker to the radio button corresponding to the
yellow color, and push it.

4. Move the marker to the OK button, and select it.

This lets you use a fairly wide, yellow line as the outline
around the rectangles.

Drawing the Rectangles
Next, you need to choose a color for the rectangles to use. You'll
use the palette of colors and patterns at the bottom of the screen
to do this. Then, you can draw the different rectangles.

1. Select red as the current color.

With the keyboard: Press I tab | to move the marker from
the canvas to the colors and patterns at the bottom of the
screen. Press Q until you mark the red color square, and
press the space bar to choose it. Then, press I shift I I tab I to
move back to canvas.
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With a pointing device: Point to the red color square at
the bottom of the screen, and click to choose it. Then, point
at the canvas again.

Choose the Solid Square tool:

With the keyboard: Press I shift | | tab | to move to the Tools
section. Press (T) until you mark the Solid Square tool.
Then, press the space bar to select it. Press I tab | to move
back to the canvas.

With a pointing device: Point to the Solid Square tool in
the Tools section, and click to choose it. Then, point at the
canvas again.

Draw a rectangle that resembles this:

[] Marcli 2, 1987
RfHiliiiTllingliliT

Paint - IRfllN.PNI
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With the keyboard: Start by using the arrow keys to
move the marker to the top left corner of the square. Press
the space bar. Then, using Q and Q, "pull" the bottom
right corner of the square to a size near the one pictured
above. Press the space bar again. The rectangle appears,
filled with red and outlined in yellow.

With a pointing device: Point to where the top left corner
of the square will be. Press and hold the button, and drag
the pointer to "pull" the bottom right corner of the square
to a size near the one pictured above. Release the button.
The rectangle appears, filled with red and outlined in
yellow.

Use the same method you used in Step 3 to draw the other
rectangles needed for the train. When you finish, the pic
ture should look like this:

IjQ Marcli 2, 1937 Paint - (Untitled) 8;58 aw
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Putting Wheels on the Train
The next step in creating the train picture is to put wheels on it.
To do this, you'll use the Solid Circle tool.

1. Select hlue as the current color.

With the keyboard: Press | tab | to move the marker from
the canvas to the colors and patterns at the bottom of the
screen. Press the space bar to choose the blue color square.
Then, press I shift | | tab | to move back to canvas.

With a pointing device: Point to the hlue color square at
the bottom of the screen, and click to choose it. Then, point
at the canvas again.

2. Choose the Solid Circle tool:

□
With the keyboard: Press I shift I | tab | to move to the Tools
section. Mark the Solid Circle tool. Then, press the space
bar to select it. Press I tab | to move back to the canvas.

With a pointing device: Point to the Solid Circle tool in
the Tools section, and click to choose it. Then, point at the
canvas again.

3. Draw wheels on the train. When you finish, the screen
should look something like this:
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Q March I, 1987
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With the keyboard: Use the arrow keys to move the
marker to a location at the approximate center of the first
wheel you want to draw. Press the space bar. Then, using
any arrow key, "pull" the circle to the size you want. Press
the space bar again. The circle appears, filled with blue
and outlined in yellow.

With a pointing device: Point to where the center of the
circle will be. Press and hold the button, and drag the
pointer to "pull" the circle to the size you need. Release the
button. The circle appears, filled with blue and outlined in
yellow.

Use the procedure from Step 3 to draw the other wheels on
the train.
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Drawing the Cowcatcher

To draw the cowcatcher on the front of the train, use the Line
tool.

1. Choose the Line tool:

With the keyboard: Press | shift | | tab I to move to the Tools
section. Mark the Line tool. Then, press the space bar to
select it. Press I tab I to move back to the canvas.

2.

With a pointing device: Point to the Line tool in the Tools
section, and click to choose it. Then, point at the canvas
again.

Draw the cowcatcher. The screen should look similar to this

when you finish:

Hapcli 2, 1987

0

Paint - (Untitled)

TRAIN

#□

9:07 m

MSSii

i
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With the keyboard: Use the arrow keys to move the
marker to where the top of the cowcatcher should be. Press
the space bar. Then, move the marker with the arrow keys
until the end-point of the line matches the bottom of the
train's body. Press the space bar again.

Again, press the space bar, and use Q to move the marker
along the same line until the end-point of the line connects
to the train's body. Press the space bar one more time to
complete the cowcatcher.

With a pointing device: Point to where the top of the cow
catcher should he. Press and hold the button. Then, move
the marker until the end-point of the line matches the bot
tom of the train's body. Release the button.

At the same point, press and hold the button, and move the
marker until the end-point of the line connects to the
train's body. Release the button to complete the cowcatcher.

Finishing the Picture

The last thing you need to do is paint some smoke coming from
the smoke stack. Use the Spray Can tool to do this. (This tool
uses the current color. You can use the blue color already chosen
for the smoke.)

1. Choose the Spray Can tool:

With the keyboard: Press I shift I I tab I to move to the Tools
section. Press Q until you mark the Spray Can tool. Then,
press the space bar to select it. Press I tab I to move back to
the canvas.

With a pointing device: Point to the Spray Can tool in the
Tools section, and click to choose it. Then, point at the can
vas again.

2. Draw the smoke. The screen should look like this when you
finish:
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|Q Harcli I, 1987 Paint - (Untitled)

miN

□C #

9:15 an

i :=: II o w m 11II i i

With the keyboard: Use the arrow keys to position the
marker just above the smoke stack. Then, press the space
bar. Use I alt I FH in combination with (T] and Q to draw
smoke blowing up and to the left. Press the space bar when
you finish.

With a pointing device: Point to just above the smoke
stack. Press and hold the button, and drag the pointer up
and to the left to draw the smoke. When you finish, release
the button.

Exiting the Paint Application
You've finished painting the picture. To save it so that you can
display it later for admirers, follow the instructions below. The
Reference part of the manual explains Paint's features in detail.

1. Pull down the File Menu.

2. Choose the Save as . . . option.

3. At the Save as : prompt, type train.
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4. Move to the SAVE button, and select it.

The picture is saved, and now you can exit Paint.

5. Pull down the File Menu, and choose the Qui t option.

Paint closes, and the desktop reappears.
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Chapter 8

CALENDAR

This chapter shows you the basics about the Calendar applica
tion. As you work through the chapter, you'll learn how to:

find the month and day on which you want to schedule an
event

schedule personal events

change the dates of already scheduled events by using the
clipboard

display a weekly calendar

print a weekly calendar in "notebook" format

If you didn't read Chapter 2, "Getting Started," return to that
chapter now and read it. In it, you load Personal DeskMate and
find out how to use the keyboard or a pointing device during the
Sample Session.

Opening the File
For your work in this chapter, you'll use the Agenda.cal file.
This file already contains sample events for you to see and use.

The first thing you must do is open the Agenda.cal file and dis
play the correct day.

Open the AGENDA file. You see a screen similar to this:
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iQ Jsniiary 1. 1980 CsleniljP - flGENDfl.WL 8:50 an i

January 1980

8M 82

Your screen will display a calendar for the month you
entered when you started up the computer. If you skipped
entering a date, your screen shows a monthly calendar for
January, 1980.

Finding the Correct Date
You need to make the screen display Friday, April 3, 1987, so
that you can add an event to the day's schedule. To do this, you
must first make Calendar display a daily event list rather than
a monthly one. Then, you can search for the correct date.

1. Pull down the Display Menu.

2. Choose the Dai ly option.

The screen now shows you a daily event list similar to this:
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Jaiuijpy 1,

■iiai] izsi EEca
Calendar - flGENDfi.CflL

V s

3.

4.

5.

Pull down the Search Menu.

Choose the Find dat e .

Find April 3, 1987.

option.

At the Date: prompt, type 04031987. Notice that you don't
have to type slashes between the month, day, and year.
Calendar supplies these for you.

6. Finalize your entry.

The OK button is marked, so select it. The screen now
shows the agenda for Friday, April 3, 1987. Notice that the
day already has one event scheduled—Paige's birthday.

Adding Events
The cursor is on the entry for Paige's birthday. Suppose that
April 3 is also Jane's birthday.

1. Add Jane's birthday to the list of events for the day.
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Move the marker to a blank line, and type Jane's birth
day I ENTER |. (Notice that you are typing in insert mode.
Each character you type is inserted at the cursor's current
position, pushing existing text to the right.)

Now, you need to remind yourself to send a birthday card
to Jane.

2. Page back through the daily event lists until you reach Fri
day, March 27, 1987.

You could use the Search Menu to find the date, but
instead, press | Ctrl | [p] (or point to PREV and click) to acti
vate the PREV button near the top of the screen. The screen
now shows the events for Thursday, April 2, 1987. Continue
paging back, noting the different events that are scheduled
on each day, until the screen displays an event list for
March 27, 1987.

3. Add to the list a reminder to send Jane a birthday card.

The cursor is on the first entry for the day. Move to the
first blank line, and type Send birthday card to Jane
I ENTER 1.

Changing Events to Other Dates

You have something else to do on March 27—Softball practice at
6:30 p.m. Suppose, though, that practice has been changed to
Saturday, March 28, at 3:00 p.m. You need to move the event to
the new date and change its time.

1. Select S: 30--softbal 1 practice.

Move the marker to the line containing the softball prac
tice. Then, select the entire line.

2. Pull down the Edit Menu.

3. Choose the Cut option. The event disappears from the
schedule for March 27.

4. Display the events for March 28, 1987.

Press I CTRL I fFI (or point to the NEXT button and click) to
display the next day, March 28.

5. Pull down the Edit Menu again.
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6. Choose the Paste option. The softball practice now appears
on the correct date.

7. Change the time of the practice to 3:00 p.m.

Position the marker just before the e of G: 3 0. Press | delete |
four times to erase the time. Then, type 3:00.

Displaying a Weekly Calendar

To see a calendar showing you the week of Sunday, March 29,
1987 through Saturday, April 4, 1987, use the Display function.

1. Display the daily event list for March 29, 1987.

Press I CTRL I (or point to the NEXT button and click) to
display the correct day.

2. Pull down the Display Menu.

3. Choose the Week ly option. The screen shows:

■0 Harch I, 198? Calendar - flGENM.CflL

Harcli 29, 1987 - ftpril 4, 1987

Holiday 30

Tuesday 31 9:00 Ewia's Dr. appointtient

Wednesday 1

Iliursdau 2 Intergiew daycare
7:30 Life Insurance appointnent
Friday 3 Paige's birthday

11!03 an
■inc3

You can see the events scheduled for the week on this
screen.
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Printing a Weekly Calendar
To print the calendar, you must first tell Personal DeskMate
about the printer you're using via the Printer accessory. (If you
followed the instructions in Chapter 3, "The Tandy Desktop,"
you've already done this.) Next, you must set up the way you
want each printed page to look by using Calendar's Page setup
option from its File Menu. Finally, you can print the calendar.

Setting Up a Page Layout. You need to decide the way you
want the calendar to look when it prints. To do this, you'll use
the File Menu's Page setup option.

1. Pull down the File Menu.

2. Choose the Page setup. . . option.

3. Choose the general format of your page.

The top part of the window shows you three layouts you can
choose for printing the calendar: A "portrait" style, a "land
scape" style, or a "notebook" style. If you aren't using a
printer with a graphics mode, choose the "portrait" style
format. To print a calendar that you can use as a page in a
notebook, you'll use the "notebook" style. It is already
marked, and none of the other prompts apply to printing a
calendar.

4. Finalize your selections.

The OK button is marked for selection. Select it, and the
Page setup window disappears. You're hack at the calendar.

Printing. To print the calendar, you'll use the Print option on
the File Menu.

1. Pull down the File Menu.

2. Choose the Print... option.

3. Use your printer to produce a copy of the calendar.

Select the Printer button to choose your printer as the
device to which you'll send the calendar.

4. Get your printer ready.

Be sure that your printer is properly connected to the com
puter, that it's turned on, loaded with paper, and on line.
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5. Finalize your selection.

Select the QK button. The calendar begins printing. When it
finishes, take it from the printer.

Returning to the Tandy Desktop

You've learned about a few features of the Calendar application,
so you can now close the Agenda.cal file and return to the desk
top. The Reference part of the manual details all the Calendar
features.

1. Pull down the File Menu.

2. Choose the Quit option.

3. At the Save changes? prompt, the YES button is already
marked, so select it. The Agenda.cal file closes, saving the
revisions you made to it throughout this chapter. The desk
top returns to the screen, and you're ready to move on to
another session.
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TELECOM

This chapter introduces you to Telecom, the application that lets
you communicate with other computer systems. You can use
Telecom to "talk" to information services, bulletin board groups,
or even another computer connected to yours by a cable. In this
chapter, you'll learn how to:

create an autolog file for use with an autodial modem

call an information service

place information you receive and send in the communica
tions buffer

disconnect from an information service

save the contents of the buffer in a file

Because you might not be an information service user, this
chapter presents the steps you would take, without giving you
specific information, such as actual phone numbers to dial, baud
rates to use, and so on. If you like, return to this chapter when
you are ready to actually call and communicate with an infor
mation service, and follow the instructions.

Before you perform the procedures in this chapter, be sure that
you've read all the information that came with your modem, that
you know how to connect it, and that you know the settings your
computer service requires you to use. Be sure that you use the
Communication accessory to define your modem type.

Running Telecom

First, run the Telecom application. Move the marker to the title
line of the Telecom list box on the desktop. Press I enter |, or dou
ble click to run the application.

A blank screen appears with the filename, (Untitled). This
screen is the one you use in developing an autolog file, a file that
gives Telecom instructions for automatically dialing and logging
onto an information service. You also set up your communica
tions parameters on this screen, even if you aren't developing an
autolog file.
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Setting Communication Parameters. The first part of an
autolog file or any preparation for communications should always
be where you set, or define, your communication parameters,
technical information that tells Telecom about the modem you're
using and the way you want it to handle certain standard tele
communications features. To set up your own parameters, follow
these instructions:

1. Pull down the Commands Menu, and choose the Set option.

This dialog box appears:

CoMwiinications ParsMeters

Baud
300 • 600 O1200

Uord Length 9 7 bits O 8 bits
Parity 9 Even 9 Odd o Ifone
Stop Bits a I 9 2
FIdn control (Kon/Koff) O On 9 (tff

Oscii filter
Self echo
Add line feed

2. Set the baud rate to the transmission speed that your ser
vice uses.

Push the radio button for the correct baud rate.

3. Set the Word Length to the setting your service requires.

Push the button for either 7 bits or 8 bits.

4. Set the Par i ty to your service's requirements.

Push one of the three buttons: Even, Odd, or None.

5. Define the number of Stop Bits your service uses.

Push either the 1 or 2 button.
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6. Specify whether you want flow control on or off during
communications.

Use flow control if yoim service uses it. If your service
doesn't use flow control, you cannot. Push the appropriate
button, On or Off.

7. Finalize your selections.

Select the GK button to put the autolog file on your screen
into effect. The command screen returns, and you now see a
window similar to this:

CowMands Parameters

1200, 8, H, 1, OFF

The next section, "Developing an Autolog File," is for those who
want to use an autodial modem for communications. If you do
not have an autodial modem, skip the next section, and continue
with "Making the Connection."
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Developing an Autolog File
If you have an autodial modem, you can create a special file,
called an autolog file, that Telecom can use in calling and log
ging onto an information service. To develop a file, follow the
instructions in this section.

Using the Command Menu. After you set parameters, the rest
of the autolog file consists of commands that tell Telecom what to
do as it tries to connect and log on to another system, as well as
the order in which it should carry out the commands. Different
systems use different methods of connecting and logging on. The
autolog file usually contains the telephone number you want to
call and a series of messages you want to send and expect to
receive. The order and type of the "send" and "wait" message, of
course, varies from system to system.

The Command Menu gives you the development tools to put the
necessary information into the autolog file. You used the menu
when you defined the communication parameters. In the steps
that follow, you use the Call, Wait, and Send options on the
menu to set up the procedure your service requires when you log
on to it. The steps are not necessarily in the order you need for
logging on to your particular information service. They are,
instead, general guidelines you need to follow when using the dif
ferent options on the Command Menu. To develop the autolog file
for actual use, you must determine the order in which you use
the options.

1. Pull down the Commands Menu, and choose the Call. . .
option.

When you choose Call..., you see:

Df f j 116 PllO 116 iufflb6l6

Phone nuMbep; ̂
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2. T5T)e the telephone number you must dial to connect to
your service.

Use no more than 30 clmracters. "K)u can include dashes
between area codes, exchanges, and numbers.

3. Confirm the phone number definition.

Select the OK button. Notice, as you confirm settings and
return to the command screen, that the information you're
setting up appears on the screen in columns—Commands
and Parameters. Each time you add information to the
autolog file, the information appears in this command
screen window.

4. Pull down the Commands Menu, and choose the Send...
option.

When you choose Send, you see:

□  cappiage petupn

t Sei^ bNak sequeiffie

Usually, you must get the attention of the other system by
sending it either a string of clmracters or a break sequence.
"Vbur service provides you with the information you need to
send. Push the radio button for the tjrpe of information you
want to send, either a string or a break sequence. If you
choose to send a string, toggle the Add carriage return
switch on if your service requires lines to end with a car
riage return.

5. Confirm the information you want to send.

Select the OK button at the bottom of the dialog box.
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6. Pull down the Command Menu, and choose the Wait
option.

When you choose Wait, you see this dialog box:

O Nait for striitg;

i  I
IiiKout;|lj seconds

# Hait fop tine pepiod;

seconds

After you send information to the other system, you usually
expect it to answer you by requesting more information, or
you expect to send more information after a certain number
of seconds. In this dialog box, press the radio button that
corresponds to the type of waiting you need to do, either for
information from the service, or for a time period to elapse.

If you choose Wait for string:, type the information you
expect to receive. Fbr example, after you dial a service and
send a break sequence (or other information), the service
might respond with a request for the name you've chosen
as your "user name." In the field below the Wait for
string: prompt, you'd type the message you receive from
your service, such as login:.

After tjqiing the string you expect to receive, tjq)e the
greatest number of seconds you expect to wait before
receiving the string. Telecom automatically uses 30 seconds
as its wait time. Feel free to change it to the number of
seconds you realistically expect to wait.

If you choose Wait for time period:, tjq)e the number
of seconds you need to wait before sending more information
to the service.
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7. Confirm the information you supplied.

To place the Wa i t information in the autolog file, select the
OK button. CVbu'll see the string in quotes, followed by the
timeout period.)

8. Continue using the Send. . . and Wa i t... options until you
define the complete sequence needed to connect to and log
on to the service.

9. After you finish, check your work on the command screen.

If you find that you've omitted a necessary line in the auto
log sequence, position the marker on the line that should
fall just below the missing one. Then, pull down the Com
mands Menu, and choose the Insert option. This inserts a
blank line, and you can choose another menu option to
define the line that needs to appear here.

If you've included an unnecessary line, move the marker to
the line you want to delete. Pull down the Commands
Menu, and choose the Delete option. The line disappears,
and all the lines below move up to accommodate the deleted
one.

Saving the File. Once you develop a complete and correct auto
log file, you need to store it on disk so that you can use it again
and again. To save an autolog file to disk, follow these steps.

1. Pull down the File Menu, and choose the Save as. . .
option.

Tjqje a name you want to give this autolog file, using eight
or fewer characters.

2. Confirm the filename.

Select the SAVE button to save the file using the name you
t3q)ed. The command screen remains on display, and you
now have an autolog file you can use.
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Making the Connection
Whether you have an autodial modem or not, you can now call
your information service and begin communicating. Be sure that
all your communication equipment is connected and that all
switches on your modem are properly set for communicating.
Then, follow the steps that pertain to the type of modem you're
using—autodialing or non-auto-dialing.

Auto-Dialing Modem Owners:

If you have an autodial modem, pull down the Commands Menu,
and choose the Execute option.

You move immediately to the terminal screen, where you can see
the communications taking place. A small window on the screen
shows you the progress of your call. The window disappears after
the connection is established. You then see the results of your
Wait and Send commands.

Non-auto-Dialing Modem Owners:

1. Pick up the receiver, and dial the telephone number of your
service. When the other system answers the phone and you
hear a high-pitched noise, connect the phone to the acoustic
coupler on your modem (or hang up the phone if you use an
internal modem card).

2. Choose the Terminal option by pressing | F101.

This displays the terminal screen, where you can see the
communications taking place. You should see On line at
the bottom of the screen.

3. Press any keys required by your service (usually | enter I or
I BREAK I).

4. Answer any prompts sent by the service for logging on.

Using the Buffer
By now, you should be communicating with your service. As you
use the service, you might find that you want to keep some of
the information you are receiving so that you can review it later.
You can place information in the buffer, an area of memory
reserved specifically for holding communicated information. You
can later display the content of the buffer or save it as a file.
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Turning On the Buffer. To turn on the buffer and begin "cap
turing" characters for later review, press I alt | [¥].

The buffer is on, and Telecom is placing everything you see into
the buffer as you send or receive the information. You should see
the message. Buffer on, on the bottom line of the terminal
screen.

Turning Off the Buffer. When you finish capturing informa
tion in the buffer, turn it off by pressing | alt | (j] at the terminal
screen. The buffer turns off, and you no longer see the Buffer
o n message on the bottom line of the terminal screen.

Disconnecting the Line

When you finish a session with your service, you need to log off
the service and disconnect your phone from the line. To do so,
follow these instructions.

1. Exit the service by typing the characters your service
requires for logging off.

2. Press I alt | 0 to return to the command screen.

This disconnects the telephone. If you aren't using an auto
dial modem, place the phone receiver back in its cradle. If
you're using an autodial modem, your phone is ready for
other use.
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Saving the Buffer Contents

Now that you've finished communicating with the service, you
can use the information you placed in the buffer. You can display
the contents, clear them from the buffer, print them, or save
them in a file. This section shows you how to save the buffer con
tents in a file that you can use with the Text application.

1. Pull down the Buffer Menu, and choose the Save as. . .
option.

2. At the Save as : prompt, give the file a name.

Type a name containing eight or fewer characters. The line
below the prompt tells you the drive and directory in which
the file will reside.

3. Select the SAVE button to save the file.

Telecom saves the file and adds the extension, .doc, to it.
When you return to the desktop, the file will appear in the
Text application's list box.

4. Clear the contents of the buffer now that you have the infor
mation in a file on disk.

Full down the Buffer Menu, and choose the Clear option.
The buffer is once again empty, ready to hold more informa
tion from your next telecommunications session.

Returning to the Tandy Desktop
You've finished using Telecom, so you can return to the desktop.
To do so, pull down the File Menu, and choose the Quit option.
A dialog box asks whether you want to disconnect the device.
Select the YES button.

Note: You are not asked whether you want to save buffer
contents when you exit Telecom, so be sure to save the con
tents (if you like) via the Buffer Menu's Save as option.

When the desktop reappears, you can move the marker to the
file you created, which appears in the TEXT list box, and review
the file if you like. Be sure to return to the desktop when you
finish reviewing the file.
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ENDING THE SAMPLE SESSION

%u've seen a few ways to use Personal DeskMate, and you
should now be more familiar with the way DeskMate works. 15)u
can continue to experiment with the sample data you created
and changed until you feel completely at ease in running Per
sonal DeskMate.

When you're ready to use Personal DeskMate for your own pro
jects, delete the sample data files you created or used during the
Sample Session. 15)u can make new copies of the master diskettes
and then delete the files that exist on the new copy, or you can
use the diskettes you used throughout the Sample Session, delet
ing all the files you developed. If you created an autolog file dur
ing the Telecom sample session, you might want to consider
keeping the file (if it's one that actually runs correctly for the
tj^e of telecommunications you normally use).

To delete files, follow the steps below for each file you see listed
in an application's list box on the desktop.

1. With the desktop on the screen, move the marker to the file
you want to delete.

2. After you mark the appropriate file, pull down the File
Menu.

3. Choose the Delete option from the File Menu.

4. The file whose name you marked appears at the File
name : prompt. Select the QK button to delete the file.

5. Follow Steps 1-4 for each file you want to delete.

After you delete the sample data files, you're ready to go.
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Chapter 11

GENERAL INFORMATION AND
CONCEPTS

This chapter gives you instructions about loading and exiting
Personal DeskMate and provides information about the two
menus that most applications use—the File Menu and the Edit
Menu. The chapter also discusses the concepts and techniques
you use in working with Personal DeskMate. If you read Chap
ter 2, "Getting Started," at the beginning of the Sample Session,
you'll find much of that information repeated here, as well as
additional procedures you didn't use during the Sample Session.
Instructions are provided for both keyboard and pointing device
users.

Installing Personal DeskMate

Personal DeskMate comes to you on two diskettes. To gain valu
able diskette storage space, we strongly urge you to transfer Per
sonal DeskMate onto at least three diskettes. You'll do this by
using the install command, explained below.

First, decide whether you want to keep Personal DeskMate's
built-in help information on a diskette separate from the
diskettes that contain the other programs and files. If you do,
format four diskettes. If you do not, format three diskettes.
Instructions on formatting diskettes are in Introduction to MS-
DOS. Temporarily label the diskettes as destination diskettes 1,
2, 3, and 4 (if you formatted four diskettes).

Next, with the A > prompt on the screen, insert the diskette that
contains the file, install.exe, in Drive A. (You can type dir | enter I
at the A > prompt to see a list of the files on any diskette in the
drive.)

With the correct diskette in Drive A, type install | enter |. The
diskette that is currently in Drive A is called source disk #1.
The other Personal DeskMate diskette is called source disk #2.
The formatted diskettes you made are called destination disks
#1, #2, #3, and #4 (if you formatted four diskettes).
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Follow the instructions on the screen carefully. The screen asks
you to make choices about the types of files you want to store on
each diskette and then instructs you to switch diskettes in Drive
A several times. Be sure to insert the correct diskettes when
the screen requests them. If you insert a diskette the screen
did not ask for, you can start the procedure again.

When the computer finishes, the A> prompt returns to the
screen. Be sure to note the contents of each destination diskette
(by using the MS-DOS dir command) and to label each diskette
in a way meaningful to you. Use the three or four new diskettes
to run Personal DeskMate, and store the original diskettes in a
safe place.

Loading Personal DeskMate
To load Personal DeskMate, first be sure that the system prompt
is on the screen. Introduction to MS-DOS contains instructions
on starting up the computer and displaying the system prompt.

Next, be sure that the diskette containing the PMMENU.PDM
and DESK.EXE files is in Drive A. Type dir I enter I with a
diskette in Drive A and the A> prompt on the screen to deter
mine which diskette contains these files.

Then, be sure that you are working from the directory in which
Personal DeskMate resides. Instructions for changing to the cor
rect directory are also in Introduction to MS-DOS.

Once you have the system prompt on the screen, the correct
diskette in Drive A, and are working in the correct directory,
type desk I enter I at the system prompt.

The desktop appears, and you are ready to begin using Personal
DeskMate.

Exiting Personal DeskMate
To exit Personal DeskMate, be sure that the desktop is on the
screen. Then, pull down the File Menu, and choose the Quit
DeskMate option. (If you worked through the Sample Session,
you know how to pull down a menu and choose an option. If not,
this chapter contains specific instructions for doing so.)
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After you choose the Quit DeskMate option, the desktop disap
pears. You might be asked to place a diskette containing COM
MAND.COM in the drive. Insert your MS-DOS diskette, and
press I ENTER I.

Using a Pointing Device

To use a pointing device (a mouse, joystick, or Touch Pad), the
first thing you need to do is tell Personal DeskMate about the
device. See the instructions in Appendix B to set up Personal
DeskMate for a pointing device.

Once you define the pointing device, you can use it throughout
Personal DeskMate. To use the device to your best advantage,
you need to become familiar with the following terms that
describe the way you move the pointer (the marker):

To point Move the device until the pointer rests on
the information to which you want to point.

To press Hold down the button on the device.

To click Quickly press and release the button.

To double click Click the button twice in rapid succession.

To drag Hold down the button while moving the
pointer.

Opening Files and Running Applications
If you haven't already loaded Personal DeskMate, do so now, fol
lowing the instructions in "Loading Personal DeskMate," earlier
in this chapter. After you load Personal DeskMate, the desktop
appears on the screen:
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To use one of the applications, you need to either open an exist
ing file or run the application without opening a file. On the
desktop, notice the several hoxes headed with the application
names—TEXT, WORKSHEET, FILER, and so on. These boxes are
called list boxes. Any names that appear in an application's list
box are the names of files that make use of that particular
application. For instance, the CALENDAR list box contains a file,
AGENDA.GAL.

To open a file and its appropriate application, follow this
procedure.
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With the Keyboard. Press I TAB I to move the marker to the list
box containing the file you want to open. If you move past the
list box you want, hold down I shif | and press fWI to move the
marker back. When the marker is on the correct list box, press
rn until the marker is on the file you want to open. If the list
box contains more files than will fit in the box, use ITI or [71 to
scroll the list one item at a time, until you mark the correct file.
When the file you want to use is marked, press I enter | to open
the file and run the appropriate application. (You might have to
switch diskettes to run certain applications. The screen will tell
you when you need to switch. Note that you can open an applica
tion and develop a data file, saving the data file on a separate
diskette. Be sure you use formatted diskettes to store data files.
Filer is the exception to this—see Chapter 16 for information
about storing Filer data files.)

Sometimes you must run an application without opening an
existing file at the same time, such as when you create a new
file. To run an application without opening a file at the same
time, press [W| to move the marker to the title of the appropri
ate list box (using \ shif I I tab I to move back if you pass the box
you want). When the marker is on the list box for the application
you want to run, press I enter I or the space bar. Again, you might
have to switch diskettes.

With the Pointing Device. Use the device to point to the file
you want to open. If the list box contains more files than will fit
in the box, point to one of the scrolling arrows in the list box
title, and click. This scrolls the list one item at a time in the
direction of the arrow. To scroll more than one item, point to the
appropriate scrolling arrow, and press and hold the button.

After you point to the file you want to use, double click to open
the file and run the appropriate application. (You might have to
switch diskettes to run certain applications. The screen will tell
you when you need to switch.)

To run an application without opening a file at the same time,
simply point to the title of the list box for the application you
want to use, and double click. Again, you might have to switch
diskettes.
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An Alternative. You can also run an application with or with
out opening a file at the same time by using the File Menu.
Press I ALT I (T|, or point to the File Menu, and press and hold the
button. Choose the Run option by pressing 0 until you mark
that option and then pressing I enter |. With a pointing device,
drag the pointer until you mark the Run option, and then release
the button. You see this dialog box:

wtext,PpogpaM;

Mi file: 1

CPU clock speed; ONoFMal

iHP

'Fast

At the Program: prompt, type the name of the application you
want to run. You must supply a filename extension. Press | tab |,
or point to the Data file: prompt. At this prompt, type the
name of the data file you want to use in conjunction with the
application. (To run an application without opening a data file at
the same time, leave the Data file: prompt blank.)

Next, select the DK button to run the application (and optional
file). Do this by pressing | tab | until you mark the OK button and
then pressing the space bar, or by pointing to the OK button and
clicking. (You can press I enter | without marking the button.)
Select the CANCEL button (via the I tab I key or by pointing and
clicking) to cancel running the application and return to the
desktop.

Moving Around on the Screen
Most of the time, moving the marker around on a screen is a
matter of pressing arrow keys or pointing and clicking. Several
techniques help you move the marker farther and faster.
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With the Keyboard. Generally, you can press an arrow key to
move the marker one character in the direction indicated on the

key. When you're working with information that isn't character-
oriented (for example, a field in the Filer application), use the
I TAB I key to move forward from field to field or | shift | itabi to move
backward from field to field. In addition to the arrow keys and
the I TAB I key, these keys help you move around on the screen;

I CTRL I m or Moves the marker to the same column at
IPG UP I the top of the screen. If you're already at

the top of the screen, I Ctrl I m moves you to
the top of the previous screen (if any).

I CTRL I rn or Moves the marker to the same column at
I PG ON I the bottom of the screen. If you're already

at the bottom of the screen, I Ctrl I (T) moves
you to the bottom of the next screen (if
any).

I CTRL I rn Moves the marker to the right margin of
the screen. If you're already at the right
margin, I CTRL I Q scrolls the marker to the
right margin of the next screen to the right
(if any).

I CTRL I m Moves the marker to the left margin of the
screen. If you're already at the left margin,
I CTRL I m scrolls the marker to the left mar
gin of the next screen to the left (if any).

I HOME I Moves the marker to the beginning of the
file's information.

I END I Moves the marker to the end of the file's
information.

With the Pointing Device. Position the marker anywhere on
the screen by pointing to the appropriate location and clicking.
To move the marker to different screens, use the scrolling arrow
icons on the screen's menu bar. (The menu bar is the second line
on the screen. It shows the different menus you can use in an
application and the scrolling arrow icons.)
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Point and click on: To move the marker:

Up one line. If you're at the top line of
the screen, the marker moves to the
last line of the previous screen (if any).

<Z>- Down one line. If you're at the bottom
line of the screen, the marker moves to
the first line of the next screen (if
any).

Right one character. If you're at the
right margin of the screen, the marker
moves to the left margin of the next
screen to the right (if any).

^  Left one character. If you're at the left
margin of the screen, the marker
moves to the right margin of the next
screen to the left (if any).

To scroll more than one line or character at a time, point to the
appropriate arrow icon, and press and hold the button. This lets
you scroll continuously until you release the button.

Selecting Information in a File

Another technique you'll use frequently is selecting information
in files to manipulate. For instance, to move a block of informa
tion to another part of your file, you must first select that infor
mation, then move it. Generally, selecting information follows
procedures like the ones presented below. These procedures
assume that you are using Insert mode, the mode Personal
DeskMate automatically assumes when you type. The Text appli
cation lets you use either Insert or Overtype mode. The sample
session for Text shows you how to select in either mode.

With the Keyboard. To select information with a keyboard, use
these keys:

I SHIFT I m To select all previous characters through the
same column position on the previous line

I SHIFT I rn To select all following characters through
the same column position on the next line

I SHIFT I rn To select the next character

118



11 I General Information and Concepts

I SHIFT I rn To select the previous character

(Tn m To select all previous characters through the
same column position at the top of the
screen

(TTI rn To select all following characters through
the same column position at the bottom of
the screen

(TTI rn To select all following characters through
the rightmost character on the same line

fpn m To select all previous characters through the
first character on the same line

Pressing these keys a number of times adds characters to those
already selected. Pressing keys that move the marker in the
direction opposite to the one you were using for selection removes
characters from the selected group. Any other cursor movement
cancels the entire selection process.

With the Pointing Device. To select information with a point
ing device, point to the location at which you wish to begin
selecting information, and press and hold the button. Then, drag
the pointer in the direction in which you want to select informa
tion, releasing the button when all the information you want to
select is marked.

Pulling Down Menus and
Selecting Options
You access most of an application's features by pulling down
menus. The menus you can use appear on the second line of
every screen in Personal DeskMate, in the line known as the
Menu Bar, with the exception of the Accessory Menu, which
appears as the Tandy icon in the upper left corner of the screen.

With the Keyboard. To pull down a menu by using the key
board, hold down | alt |, and press the key that corresponds to the
first letter of the menu name. An exception to this is the Acces
sory Menu, which you display by pressing I alt I and the space bar.
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If the menu bar contains two or more menus that begin with the
same letter, when you press |alt| and the first letter of the menu
name, the marker moves to the first menu beginning with the
letter. Use the arrow keys to move back and forth along the
menu bar until you reach the menu you want to use.

To choose an option from a menu, use the up and down arrow
keys to m£u*k the option you want to use. Y)u can also type the
first letter of the option you want to use. This moves the marker
to that option. Each time you tj^e the letter, the marker moves
to the next option beginning with that letter. Press I enter I to
choose a marked option. Cancel display of a menu by pressing

With the Pointing Device. To pull down a menu and choose an
option by using the pointing device, point to the menu you want
to display, and press and hold the button. Drag the pointer down
to display and mark different menu options. When you mark the
option you want to use, release the button. Cancel display of a
menu by moving the pointer outside the menu and releasing the
button.

Shadowed Options in Menus. Depending upon the application
you want to use and the point you've reached in developing a file,
some menu options might appear "shadowed." This means that
the menu option is unavailable to you. Y)u might later be able to
use the option after progressing further in developing the file.
For instance, you cannot display a report in the Filer application
until you add records, so the options on the Report Menu appear
shadowed.

Accelerators. Throughout Personal DeskMate, some menu
options that you use frequently have accelerators, keys you can
press rather than pulling down the menu and choosing the
option. For instance, the Edit Menu has accelerators for the Cut,
Copy, and Paste options—O, and I Fia i. To use an accelera
tor, simply press the appropriate key.

Applications also use accelerators to let you perform other func
tions, such as I CTRL I Q] to use insert mode in the Text application,
or I CTRL I (T) to see the "next" page of a daily calendar in the Cal
endar application. Available accelerators are discussed in each
application's reference chapter. Note that the I print | key is an
accelerator to the File Menu's Print option.
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Working With Dialog Boxes
Usually, when you use an application's features, Personal
DeskMate tries to perform the function you choose, but occasion
ally, it needs more information from you before it can carry out
your command. Whenever you need to supply information, you'll
see a dialog box, a window in which you and Personal DeskMate
have a short "dialog."

A dialog box can consist of several components. Each component
is explained in the paragraphs that follow.

Edit Fields. An edit field is a line following a prompt. In an edit
field, you supply information by typing it or by changing infor
mation that already appears in the field.

When you move the marker to an edit field (or when the dialog
box appears with the edit field already marked) there are several
techniques for editing an answer that already appears in the
field. Typically, when you see an edit field, the default reply for
the field is already selected. So, to type a completely new answer,
simply begin typing. The information you type replaces the
selected information in the edit field.

To change characters in an edit field, use Q or Q to move to
just before or after the unwanted character(s). Then, use | shift I
rn or I SHIFT I rn to select the unwanted character(s). Type the
new information to replace the selected ones, or press | delete I to
erase the selected character(s). Ifou can also use I backspace I to
delete characters.

To add characters in an edit field, move the marker to the posi
tion at which you want to add characters, and type the new
information.

List Boxes. A list box is a list of information from which you
choose for display in an edit field to save time rather than typing
the information directly in the edit field.
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To choose an answer that appears in a list box via the keyboard,
use the arrow keys to move to the answer you want to choose. If
the list box contains more choices than can display in the box,
use the arrow keys to scroll through the list until you mark the
answer you want to use. Then, after marking your answer, press
[W]. Personal DeskMate places that information in the edit
field, and the marker moves to the edit field, which is now filled
in. You can press fW] again to move past the edit field, or you
can edit the answer now displayed in the field.

To use an answer that appears in a list box via the pointing
device, point to the answer you want to use. If the list box con
tains more choices than can display in the box, click on one of
the scrolling arrow icons in the list box title. To scroll continu
ously, press and hold the button while pointing to the icon,
releasing the button when you see the answer you want. Mark
your answer by pointing to it, and click. The answer appears in
the edit field when you move the pointer out of the list box and
click.

Radio Buttons. Sometimes you'll see groups of choices with
small buttons beside them. These buttons are radio buttons^
which means that they work the same way as, for instance, an
automobile's radio buttons work. When one button is pushed,
that "station" plays. The "station" remains the same until you
push another radio button.

To select from among a group of radio buttons via the keyboard,
use the arrow keys to move from one button to another. When
the button you want to use is marked, press the space bar to
push the button.

To use a pointing device to select a radio button from among sev
eral in a group, point to the button you want to push, and click.

Check Boxes. Check boxes offer you settings that you can tog
gle on and off to keep them in effect or not, as you choose.

A setting that is on is marked with an X or a check beside it. A
setting that is off shows no mark beside it.

To toggle a setting via the keyboard, position the marker on the
appropriate setting, and press the space bar.

To toggle a setting via a pointing device, point to the appropriate
setting, and click.
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Push Buttons. Every dialog box contains push buttons. These
buttons let you tell Personal DeskMate that you're finished
working with the dialog box. Every dialog box contains an
affirmative button, ususdly labelled OK. Selecting this button
tells Personal DeskMate to accept the information and proceed.

Some dialog boxes contain a NO button. Selecting this button
answers the question asked by the dialog box in a negative man
ner and tells Personal DeskMate to proceed.

The CANCEL button tells Personal DeskMate not to perform the
operation at all. Ear example, if you try to exit an application
without saving your work, the dialog box asks whether you want
to save the work or not before quitting. "Vbu can answer YES
(save the work and quit), ND (quit without saving the work), or
CANCEL (do not quit).

To use a push button via the keyboard, use I tab I to move through
the push buttons, until the button you want to push is marked.
Then, press the space bar. Pressing I enter I is an accelerator (short
cut) to the affirmative or OK button in every dialog box you use.
Pressing flscl is an accelerator to the CANCEL button.

To use a push button via a pointing device, point to the button
you want to push, and click.

The Whole Picture. A dialog box might contain any or all of
the components explained above. An entire dialog box might look
something like this:
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Left Hapgin:

Ppinted Line Hidth;

Total Liiws Pep Page:

Ppinted Lines Pep Page!
Auble Space
LPause Betveen Pages
□Seiri contpol sequence
# GpapMc Mode
a Text Mode

This dialog box contains all the components except a list box.
Notice that the box naturally divides into sections: a group of
radio buttons at the top, followed by four edit fields, then a group
of three check boxes, another group of radio buttons, and finally,
two push buttons.

To move around the different sections of a dialog box with the
keyboard, use itab I to move to the n®rt section. Use | shift I fWl to
move backward through the groups.

Using a pointing device, you can simply point and click on any
option in any section.

Shadowed Choices in Dialog Boxes. As you use Personal
DeskMate, you'll notice that parts of some dialog boxes appear to
be shadowed. A shadowed part means that, because of some other
setting in effect, the shadowed part does not apply to you at this
time. Pbr instance, in the dialog box pictured above, you might
not be able to change certain answers in the box because of the
tj^e of printer you have connected to your computer or because
of a page format you choose for printing information. When you
move the marker around in a dialog box. Personal DeskMate
automatically skips the shadowed parts of the box.
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The File Menu

The File Menu is available in each application, in much the same
form from application to application. The options on the menu
cover procedures that pertain to a data file for that application.
You'll find that each File Menu might have different options;
however, most File Menus contain a core of common options that
remain the same across the applications. These options are the
ones discussed in detail in this section. If you are using a File
Menu that contains options other than the ones described in the
following paragraphs, look for explanations of those options in
the chapter that explains the application you're using. Also note
in the appropriate chapter any special restrictions the applica
tion might place on its File Menu options (such as the Page
Setup option).

Filenames. The Save as and Open options accept filenames of
as many as eight characters plus an optional extension. All the
applications provide default extensions if you don't type one. You
can, in addition to the eight-character name and optional three-
character extension, begin the filename with a disk drive letter
and a colon, such as b:. You can also type a directory pathname
before typing the actual filename. Use no spaces in filenames or
between parts of a pathname.

A small section of the dialog box shows you the current drive
and directory names.

Displaying the File Menu. To pull down a File Menu, either
press ["Airn [T], or point to the menu name, and press and hold the
button. The standard options on this menu are:

New This option clears from the screen and from
memory any existing information and lets
you create a new file. If you've changed
information since the last time you used the
Save or Save as options, a message asks:

Save changes?
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Open.,

Select the yes button to save the informa
tion on the screen as it now stands and then

clear the screen for the new file. Select the
ND button to discard any changes made to
the file and clear the screen for the new file.

Select the cancel button to cancel clearing
the screen and continue working with the
file currently displayed.

Use this option to open an existing file.
When you choose this option, you see;

Open File; |

llEHILVJOC I

At the Open File: prompt, you can type
the name of the file you want to display, or
you can scroll through the list box entitled
FILES until you mark the file you want to
open. Move the marker out of the list box to
place the marked filename in the Open
File: edit field. You can also choose a file
name by pressing the space bar or clicking
on that filename.

Select the OK button to open the file, or
select the CANCEL button to cancel the file
opening and return to the screen you were
using.
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This option lets you store the currently dis
played file using the filename that appears
in the title bar. (You cannot use this option
with an untitled file. Use the Save as

option instead.)

This option lets you store the file currently
on the screen using a filename different
from the one that appears in the title bar.

At the Save as: prompt, type a name that
you want to use for the file. The section
below the Save as: prompt shows you the
drive and directory in which the file will be
saved.

Select the save button to save the file

under the new name, or select the CANCEL
button to cancel saving the file under a new
name.

This option lets you choose the way you
want any information in this file to appear
when printed. When you choose this option,
this dialog box appears:

Left Hargin:

Printed Line Uidth; a
Total Lines Per Page: flU
Printed Lines Per Page: LJjl

DBouble Space
.Pause Between Pages
jSend control sequence
9 Graphic node
O Text node
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Depending upon the application you're
using and other factors (such as the printer
you've set up), different areas of the dialog
box are shaded out, unavailable to you for
change. Following are explanations of the
various components.

Select one of the three formats available in

the top section: the "portrait" style format,
the elongated "landscape" style format, or
the standard "notebook" format.

At the Left Margin: prompt, type the
number of character spaces you want to
leave as a left margin before characters
actually begin printing on a page.

At the Printed Line Width: prompt, type
the total number of characters you want to
print on one line. (Be sure that the entry
for Left Margin plus the Printed Line
Width entry does not exceed the width of
your paper.)

At Total Lines Per Page:, type the
total number of lines on one sheet of the
paper you plan on using. Fbr instance,
8 1/2" by 11" paper contains 66 lines when
figured at six lines per vertical inch, the
standard used by most printers.

At the Printed Lines Per Page: prompt,
type the total number of lines you want to
appear on one page. For instance, if your
paper can hold 66 lines and you want top
and bottom margins of six lines each, sub
tract 12 from 66 to arrive at 54, the num
ber you will type at this prompt.

128



11 I General Information and Concepts

Next, select any or all of the three features
that follow: Double space, Pause
between pages, or Send control
sequence. Selecting Double space causes
the file to print double spaced rather than
single spaced. Selecting Pause between
pages causes the printer to stop as it com
pletes each page so that you can insert a
new sheet of paper (if you aren't using con
tinuous forms). Selecting Send control
sequence allows you to send a control
sequence established via the Printer acces
sory to your printer before printing begins.

Select either Graphic mode or Text mode.
Graphic mode enables you to print boldfaced
and underlined text on a printer that can't
handle boldface or underline in text mode.
Selecting Graphic mode slows down print
ing considerably and reduces the quality of
printed output. Text mode lets you print
using the text mode of your printer.

After you furnish the information requested
in this window, select the OK button to put
that information into effect, or select CAN
CEL to cancel the setup and return to the
screen you were using.

Print... This option prints the file on your screen or
printer in the format you specify via the
Page setup option.
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Push the radio button for either Screen or
Printer, and then select OK to print or dis
play the file. Select cancel to cancel print
ing the file. If you push the radio button for
Screen, your file's information appears in
the major part of the window, in the format
you chose via Page setup. Notice that you
can pull down an Edit Menu on this screen.
The only options you can choose from this
menu are the Copy and Select all
options. Use the arrow keys or the pointing
device techniques to select any rectangular
portion of the screen and place it in the
clipboard. The Select all option on this
menu selects the entire "page" of informa
tion for copying to the clipboard. Informa
tion you select and copy remains on the
screen as well as on the clipboard. To copy
data from either Worksheet or Filer into
another application, you must first perform
a "print to screen," explained previously,
and then select information from the result
ing display. Information clipboarded by
using any other procedure in Worksheet or
Filer can be pasted only within that specific
application.

At the bottom of the screen are push but
tons that let you display the next page of
the file or quit using the Print to screen
option. I CTRL I [n] and ("ctrlI are the
respective accelerators to these buttons.

If you push the radio button for Printer in
the Print dialog box, select the OK button,
and your file prints, using the format you
specified in Page setup.... A new mes
sage box appears. If you selected the Pause
between pages option in Page setup, press
the Next page button (or press | CTRL I (J]) to
print the next page as each page completes
printing. Press the CANCEL button to stop
printing.
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Quit Use this option to exit the file and applica
tion you're using. If you made any changes
to the file since you last saved it, you see
this message:

Save changes?

Select YES to close the file, storing the
changes you made. If the file is one not yet
named (one you just created), a message
asks:

Save as:

Type a filename, and select the SAVE button
to save the file or the CANCEL button to can

cel closing and saving the file.

Select NG at the Save changes? message
to close the file without storing the changes
you made. If the file is one not yet named
(one you just created), selecting NG cancels
any information you typed in the document
and returns you to the desktop without cre
ating the file.

Select the CANCEL button to cancel closing
the file and to continue working with it.

The Edit Menu

The Edit Menu is available in most applications, in much the
same form from application to application. The options on the
menu cover procedures that pertain to manipulating information
you select in a data file. Some Edit Menus might have different
options; however, most Edit Menus contain common options that
remain the same across the applications. These options are the
ones discussed in detail in this section. If you are using an Edit
Menu that contains options other than the ones described in the
following paragraphs, look for explanations of those options in
the chapter that explains the application you're using. Also note
in the appropriate chapter any special restrictions the applica
tion might place on its Edit Menu options.

To pull down an Edit Menu, either press I alt I [T], or point to the
menu name, and press and hold the button. The standard options
on this menu are:
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Cut (or [ra]) Use this option to remove selected informa
tion from the screen and place it on the
clipboard, replacing any previous clipboard
contents. Y)u can paste the cut information
at another place in the same file or in
another file. See the explanation of the
Paste option in this section for restrictions
in pasting information into a file used by a
different application.

Copy (or [^) Use this option to place selected information
on the clipboard without removing it from
its current position on the screen. The cop
ied information replaces any previous clip
board contents. You can paste the copied
information at another place in the same
file or in another file. See the explanation of
the Paste option in this section for restric
tions in pasting information into a file used
by a different application.

Paste (or I fio |) This option takes information currently on
the clipboard and inserts it at the cursor's
current position, leaving it on the clipboard
as well. Y)u can paste cut or copied infor
mation into another place in the same file
or into another file used by the same
application.

Not all applications can accept information
cut or copied from all other applications. If
an application cannot paste information cur
rently on the clipboard, the Paste options
appears shadowed on the Edit Menu. "Vbu
cannot paste data into Paint from any other
application. Data clipboarded from the
Worksheet and Filer applications cannot be
directly pasted into other applications' files.
However, data clipboarded by using a "print
to screen" in these applications is treated
as plain text and can be pasted elsewhere.

Clear Use this option to delete selected informa
tion from the document. When you use this
option, the information does not move to the
clipboard but is completely erased from the
file.
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Select all Use this option to select all information in
the file, from beginning to end, so that you
can perform another function on it.

Help Windows

As you use Personal DeskMate, you can receive helpful informa
tion without leaving the screen you're using. To see help infor
mation about the application you're using, either press | alt | (T],
or point and click on the question mark icon in the title bar of
the screen. A window similar to this appears:

Find lal»l finds a group of characters in a
lahel on the wrksheet.

Find nuMber finds a numric value you've
entered in a cell.

Find cell finds a specific cell address on
the wrksheet.

li'jiipjn itaujui Maaiii ilMMMi

FFile Menu
FFdit Henu
FPad Menu
FCells Henu

O Search Henu
9
9
9

I  General iHiiiTW Functions HP

The bottom of the window contains four push buttons you can
use. You can move the marker from button to button to choose

the type of information you want to see: general information
about an application, specific "how to" information for instruc
tions about accomplishing different tasks in application, or
descriptive information about the menus and their functions. You
can also quit viewing help information via the Quit button. The
accelerators to these push buttons are:
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I CTRL I General help
I CTRL I [5] How to help
I CTRL I [T] Functions help
rcTRil [3 Quit

Select the appropriate button, and a group of radio buttons for
even more specific choices becomes active. For instance, you can,
if you're using Filer, select the How to button and then push a
radio button for Define a record format. The large area in
the top section of the window then shows you the help informa
tion you requested.

While you view help information, you can use the four push but
tons in the middle of the window—Prev topio, CPG UP],
CPG ON], and Next topic. Selecting the Prev topic button
automatically pushes the radio button previous to the one cur
rently pushed and displays the appropriate information.

Selecting the [PG UP] button displays a previous "page" of help
information about the current topic, if one exists. Selecting the
[PG DN] button displays the next "page" of help information
about the current topic, if one exists. Selecting the Next topic
button automatically pushes the radio button after the one cur
rently pushed and displays the appropriate information. The
accelerators to these buttons are:

I CTRL I fPl Prev topio
PG UP| CPG UP]

CPG DN]

I CTRL I f¥1 Next topic

Exiting a File and Application

When you finish working with a file and want to return to the
desktop, you must exit the file. To exit a file via the keyboard,
pull down the File Menu, and choose the Quit option. If you
changed any information in the file, you'll see a message asking
if you want to save those changes, along with two push buttons.
To save the changes, push the YES button. To exit the file with
out saving any changes you made, push the N □ button.
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THE TANDY DESKTOP

After you load Personal DeskMate, you see the Tandy Desktop.
From here, you choose the applications and files you want to run,
as well as change and create information you want to see on the
desktop. Opening files and running applications is explained in
Chapter 11, "General Information and Concepts," as is the proce
dure for using either the keyboard or a pointing device to move
the marker on the screen and select information.

The Title Bar

The title bar lets you display the Accessory Menu via the Tandy
icon, shows you the date you entered when you started up the
computer and the title of the package (Personal DeskMate), and
gives you access to any help windows available for the desktop
via the question mark icon.

The Accessory Menu. When you select the Tandy icon, you see
the Accessory Menu. Detailed explanations of the accessories are
in Chapter 13, "Accessories."

The Help Windows. To view help windows for the desktop,
select the question mark icon. Help windows are explained in
Chapter 11, "General Information and Concepts."

The Menu Bar

The menu bar, just below the title bar, gives you access to the
four menus you can use from the desktop: the File Menu, the
Directory Menu, the Disk Menu, and the Build Menu.

The File Menu. The File Menu lets you perform functions
related to the files you see listed on the desktop. The desktop's
File Menu is different from the standard File Menu explained in
Chapter 11. The desktop's File Menu options are:

Get Info... Selecting this option from the File Menu
displays a window you can use to see the
size of the selected file as well as the date
and time you last worked in the file.

Select the DK button to return to the desk

top after viewing file information.
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Run... Select the Run option to run an application.

At the Program: prompt, type the name of
the application or program you want to use.
At the Da t a: prompt, type the name of the
data file you want to use with your chosen
application. If you leave the Data: prompt
blank. Personal DeskMate runs the applica
tion/program you specify without opening a
corresponding data file. (\bu can run non-
Personal DeskMate applications if you like.
Personal DeskMate leaves a small program
in memory so that it can return when you
finish using the other application.)

Push one of the buttons for the CPU clock
speed. Choosing Normal runs the CPU at
normal speed. Choosing Fast runs the CPU
at a faster rate and lets you process Per
sonal DeskMate information more quickly.
Some non-Personal DeskMate applications
might require running at normal speed to
operate properly.

Select the OK button at the bottom of the
window to run the application (and file, if
you specified one).

Select the cancel button to cancel your
entries and return to the desktop without
executing an application/program.

Copy... This option enables you to place a copy of a
file in your current directory or in another
directory. Y)u can select several files from
the same application's list box if you like by
first moving the marker to the list box. Use
(T) or (T] to move the marker to the first
file you want to select. Next, move the
marker to another file using | alt| m or [Ailfl
rn. Pressing the space bar selects the new
file, or, if the file is already selected,
removes it from the selected group. Using
[T) or (T] causes the most recently selected
file to be the only one marked. Continue
making selections until you select all the
files you want to copy from the list box.
Then, choose the Copy option.
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At the From: prompt in the dialog box that
appears, enter the name of the file you want
to copy (including a pathname if you are
going to copy it from another directory), ̂ u
can specify the drive in which the file you
want to copy resides. %u can use * as a
"wildcard" to accept any number of charac
ters, for instance, *.doc for all files that
have the extension, .doc. You can restrict a
wildcard by beginning with specific charac
ters, for example, ab'^.doc to find all files
beginning with ah and that have the exten
sion, .doc. If you select a file on the desktop,
that filename is the default entry in the
edit field.

At the T o: prompt, enter the name you
want the copied file to have, including a
pathname if the destination is another
directory, as well as a drive name if you
like. To copy the file to a new drive or direc
tory, enter only the drive and/or directory
information.

Note: If you have only one drive, you can
specify Drive A at the To: prompt
and Drive B at the From: prompt.
You'll then be prompted to switch
diskettes when it is necessary during
the copying process.

Select the OK button to carry out the copy.
If you are using a single-drive computer
and specified Drive B at the To: prompt,
the screen asks you to switch diskettes.
When the file is copied to the new file, the
desktop reappears.

If you're copying multiple files, the second
filename you selected appears at the From:
prompt. Select the OK button to copy this
file. The process repeats until you copy all
the selected files.

Select the cancel button to cancel the
entire copying operation and return to the
desktop.
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Delete... This option lets you delete a file or files
from Personal DeskMate. You can select
several files from one application's list box
for deletion. First, move the marker to the
list box. Use Q] or (T] to move the marker
to the first file you want to select. Then,
move the marker to another file using |alt|
rn or fAilfl rn. Pressing the space bar
selects the new file, or if the file is already
selected, removes it from the selected group.
Using [T] or (T) causes the new file to be
the only one marked. Continue selecting
files from the same list box until you select
all the ones you want to delete. Then,
choose the Delete option.

At the Filename; prompt in the dialog box
that appears, enter the name of the file you
want to delete, including a full pathname if
the file is not in your current directory. You
can use * as a "wildcard" character to spec
ify any number of characters in a filename.
For instance, you could type *.doc to delete
all files that have the extension, .doc. You
can restrict a wildcard by beginning with
specific characters, for example, ab*.doc to
find all files beginning with ah and that

. have the extension, .doc.

Select the DK button to carry out the dele
tion and redisplay the desktop once the file
is deleted.

If you are deleting multiple files, each file
name appears, one by one. Select OK to
carry out deletion of the displayed file.

Select the CANCEL button to cancel your
entry and return to the desktop without
deleting the file.

Select the ALL button to delete all the files
you specified (either on the desktop or with
the * wildcard) without pausing between
each filename.
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Rename... This option enables you to change the name
of a file.

At the From: prompt, tjrpe the name of the
file you want to rename. At the T o: prompt,
type the new name for the file.

When renaming a file, it is important that
it retain its original extension to function
correctly in Personal DeskMate. Because
Personal DeskMate does not automatically
assume an extension, be sure to specify one
at the T o: prompt. Normally, the extension
will be the same as the one shown at the

From; prompt.

Select the OK button to go ahead and
rename the file, or select the CANCEL button
to cancel your entries without renaming the
file and return to the desktop.

The Directory Menu. When you select this menu, you can cre
ate, delete, and change directories without exiting Personal
DeskMate and using MS-DOS to do the job. The Directory Menu
options are:

Create.

Delete..

Select this option to create a new
subdirectory.

At the Path: prompt, enter a pathname for
the subdirectory you want to create. Select
the DK button to create the subdirectory, or
select the CANCEL button to cancel your
entry without creating a new subdirectory.
The desktop reappears.

This option lets you delete an existing sub
directory. You can delete a subdirectory
only if you first delete all the files and other
subdirectories within that subdirectory.
(Use the Delete function on the File Menu
to delete individual files.) When you select
De 1 e t e, a new dialog box appears.

At the Path; prompt, enter the pathname
of the subdirectory you want to delete.
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Select the LIST button to display the direc
tory structure of the disk in your current
drive in "outline" form—subdirectories

indented under higher level subdirectories.
%u can move the marker around on the list

to choose directories you want to delete.
Select the OK button at this list to delete
the subdirectory and return to the desktop.
Select the cancel button at this list to
return to the desktop without deleting the
subdirectory.

Select the OK button to delete your chosen
subdirectory. The desktop returns to the
screen.

Select the CANCEL button to cancel your
entry without deleting the subdirectory and
return to the desktop.

Change... This option enables you to change the direc
tory in which you are currently working to
a new one.

At the Path: prompt, enter the pathname
of the directory to which you want to move.
"%u can enter nothing at this prompt and
select the LIST button, explained below, to
see the contents of the directory you are
currently using.

Select the list button to display the direc
tory structure of the disk in your current
drive in "outline" form—subdirectories
indented under higher level subdirectories.
"Vbu can move the marker around on the list
to choose a directory to which you want to
change. Select the DK button at this list to
return to the desktop and change to the
new subdirectory. Select the CANCEL button
at this list to return to the desktop without
changing to a new subdirectory.

If you didn't display the directory list, select
the OK button at the Change window to
switch to your new directory and begin
working in it. The desktop reappears.
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Select the CANCEL button at the Change
window to cancel your entry without chang
ing directories. The desktop reappears.

The Disk Menu. When you select this menu, you have access to
several functions that deal with your diskettes or hard drive.
The Disk Menu options are:

Get Info...

Format...

This option shows you the available free
space on the diskette in the current drive,
along with the volume name. Use the
Change option on the Directory Menu to
change the current drive.

Select the □< button after, you review the
information to return to the desktop.

This option lets you format a diskette, pre
paring it to store information. When you
select this option, you see this dialog box:

Drive: U
□install operating sgsten

mm in

At the Drive: prompt, enter the name of
the drive on which you want to format a
diskette—either A or B.

Toggle on the check box at Install oper
ating system if you want to install MS-
DOS on the diskette you format.

Select the DK button to proceed with the for
mat. Select the CANCEL button to cancel
your entry and return to the desktop with
out formatting a diskette.
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Diskcopy...

If you select the DK button, Personal
DeskMate runs the program, format.com.
(You might need to insert a copy of your
MS-DOS diskette in Drive A at this point.)
Format.com asks you to insert a blank
diskette into the drive you specified. Insert
the diskette, and press any key to begin for
matting. (Refer to Introduction to MS-DOS
for more details about the format.com pro
gram.) When you finish, you have a format
ted diskette in the drive you specified.
Replace the formatted diskette with your
Personal DeskMate diskette if necessary.

This option lets you make a copy of a
diskette. When you select Diskcopy, this
window appears:

FpohI I

To: t

At the From: prompt, type the name of the
drive that will contain the diskette you
want to copy.

At the T o: prompt, type the name of the
drive to contain the formatted diskette that

will become your new copy of the original
diskette. Select the QK button to make the

copy. Select the CANCEL button to cancel
your entries and return to the desktop with
out copying a diskette.
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Personal DeskMate then runs the program,
diskcopy.com. (You might need to insert a
copy of your MS-DOS diskette at this point.)
(Refer to Introduction to MS-DOS for details
about the diskcopy.com program.) If you
specified Drive B at the Copy to; prompt
when you're using a single-drive computer,
the screen asks you to swap diskettes sev
eral times as it copies the diskette.

When the copy procedure is completed,
replace the diskette in Drive A with your
Personal DeskMate diskette if necessary.

Swap This option reads the current directory of
the diskette in the current drive. Place a

diskette in the drive, and then choose this
option.

The Build Menu. This menu gives you access to the functions
that create and change the way the Main Menu looks. You can
choose to display applications and their associated data files (in
the current directory) and the Notepad, Calendar, Calculator,
and/or Phone directory accessories. The Build Menu options are:

Create This option lets you create a list box for dis
play on the desktop that contains the name
of an appliation or program and its associ
ated data files. When you choose this
option, the screen shows:

Hem title! |,

FpograH nane! |
Data File Extension! |

cm clock speed! #Noml OFast

♦  PBOGRflHS ♦
Mliil
PMHENU.PDH
PHTEXT.PDH
PHUOPE.PDH
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At the Menu title: prompt, enter the
name you want to display at the top of the
box.

At the Program name: prompt, either type
a name (including the name and its exten
sion), or scroll through the PROGRAMS list
box and mark a name. When you move the
marker out of the list box, the name you
marked appears at the Program name:
prompt.

At the Data file extension: prompt,
type the extension that all data files for
this application/program use. The exten
sions for Personal DeskMate application
data files are:

Text .doc Paint .pnt
Worksheet .wks Calendar .cal
Filer .fil Telecom .log

At the CPU clock speed: prompt, select
either Normal, which processes information
through the computer's CPU at the normal
rate, or Fast, which processes information
at a faster rate. (Select Fast to run Per
sonal DeskMate applications. Some non-Per
sonal DeskMate applications might require
running at normal speed to operate
properly.)

When you finish, select the OK button to
create the list box and return to the
desktop.

Select the CANCEL button to cancel your
entries without creating the new list box
and return to the desktop.

Delete... This option enables you to delete definitions
of boxes that list applications and their
associated data files.

Scroll through the list box until you mark
the application whose list box you want to
delete.
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Redefine..

Display...

Select the OK button to delete the specified
list box and return to the desktop.

Select the cancel button to cancel the dele
tion and return to the desktop, leaving the
application list box definition intact.

This option lets you change any responses
you previously set up via the Create option.
First, move the marker to the title line of
the list box you want to redefine, and then
choose this option. When you select the
Redefine option, you see the same dialog
box that you use in the Create option.

Follow the instructions previously explained
for the Build Menu's Create option to
change any already defined information.

This option enables you to choose list boxes
or accessories you want to display on the
desktop.

Scroll through the MENUS list box until you
mark the list box or accessory you want to
display. When you mark the appropriate
item, move the marker to the Menu size
section. Depending on the item you marked
in the MENUS list box, you might be
restricted to choosing a specific menu size.
Pbr instance, all accessories must use a spe
cific menu size—^the choices appear shad
owed to let you know that you have no
choice of menu size.

Choose the size of menu you want to dis
play, and push its radio button.

To cancel displaying the menu or accessory
and redisplay the desktop, select the
CANCEL button at the bottom of the window.

145



DeskMate Reference

Select the OK button at the bottom of the
window to display the desktop and a "float
ing box" for positioning the menu. Use the
arrow keys or the pointing device to move
the box around to different screen locations.
When the box is in the position you want,
press I ENTER I, or double click the button.

If you choose a location that does not con
tain enough room to hold a menu of the size
you chose, a message tells you that the
menu Will not fit. Select the OK button
to erase the message and then reposition
the menu, or select the CANCEL button to
cancel the operation. Then, use the
Display option again, choosing a different
size.

Remove This option lets you remove a menu or
accessory from the desktop display. First,
position the marker on the title line of the
menu or accessory you want to remove, and
then pull down the Build Menu and choose
this option. The menu/accessory immedi
ately disappears from the screen. However,
it is not completely deleted. You can use the
Display option to display it at the same
location or at another screen location.
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ACCESSORIES

The Personal DeskMate accessories are ten utilities that you can
use when you're running applications or from the desktop. You
can install the calculator, the phone list, the notepad, and the
calendar on the desktop for display purposes so that you can
quickly see information you often need.

The Accessory Menu
The Tandy icon, in the upper left corner of every Personal
DeskMate screen, lets you display the Accessory Menu. When
you pull down the menu, you see:

Calculator
Phone List
Note Pad
Calendar
Clipboard

Color
CoHMunications
Me d Tine
Mouse
Printer

The Calculator

Choose the Calculator option from the Accessory Menu to use
a five-function calculator that has an internal memory and a
"tape" display of the calculations you perform.

When you choose the Calculator option, you see this window:
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1 1 e.iBigD
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l&u can see as many as 15 digits (minus decimal points and
exponents, but not commas) on the calculator's display line. The
display line uses exponential notation to show larger numbers.

Use the calculator as you would any normal hand-held calcula
tor. Enter numbers (.operands) smd functions, and see the dis
played results. If you see ERROR on the calculator display, use
the CA function before you continue.

With the K^hoard. To use the calculator from the keyboard,
simply tjrpe the operands and functions. To enter the Sign, Clear
Entry, Clear Accumulator, Memory -I-, Memory -, Memory
Clear, or Memory Recall functions, tjrpe the characters displayed
on the appropriate calculator buttons. To quit using the calcula
tor, press fcrfel [o] or FescI.

With the Pointing Device. To use the calculator with a point
ing device, click on each operand or function you want to use. To
quit using the calculator, point to the QUIT button, and click.

The Functions. The calculator functions are:

S  Use this function to change the sign of a number.

CE This function clears the current operand for quick
correction.

CA This function clears the calculator.

+  This function adds the currently displayed number
to the next one you enter.

This function subtracts the next number you enter
from the one currently displayed.
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X  This function multiplies the currently displayed
number by the next one you enter.

/  This function divides the currently displayed num
ber by the next one you enter.

%  This function uses percentages in calculations. To
use a percentage of a number in a calculation, enter
a formula similar to this example: 200 - 3% =.
This calculation produces the result of 200 minus
3% of 200.

M + Use this function to add a number to the amount in

the calculator's internal memory.

M- Use this function to subtract a number from the
amount in the calculator's internal memory.

MC Use this function to clear any amount from the cal
culator's internal memory.

MR Use this function to recall to the display the
amount in the calculator's internal memory.

Use this function to display the accumulated result
of a calculation.

Installing the Calculator on the Tandy Desktop. For infor
mation about installing the Calculator accessory on your desk
top, see Chapter 12, "The Tandy Desktop." Note that when you
install the calculator on the desktop, it is for display purposes
only. You cannot use the calculator that appears on the screen to
perform calculations. Use it only to see the last result you accu
mulated on the calculator. You can, however, pull down the
Accessories Menu and use the calculator from the desktop.

The Phone List

The Phone list accessory gives you a quick way to look up names
and phone numbers, and even a way to make Personal DeskMate
dial a number you want to call (if you have an auto-dialing
modem connected to your computer).

When you choose the Phone list option from the Accessory
Menu for the first time, a dialog box appears. In the box, move
the marker to the CREATE button, and select it. You see this
window:
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FhoTie List

NEyilEDIIIilDELEIEII PRINT 11 CALL11

If you haven't entered names and numbers yet, the page is
blank. Otherwise, the list shows as many as eight names and
the last 12 characters of their corresponding numbers.

Reviewing Numbers on the List. To see numbers not currently
displayed, use one of the following methods.

Use the scrolling techniques discussed in Chapter 11, "General
Information and Concepts," to scroll the list line by line, page by
page, or in a continuous motion.

To see the part of the list that contains a specific name, type the
first letter of the entry you want to see. The display moves to
that area of the list. For example, if you typed Doe, John as an
entry, you could type D to see the first "D" on the phone list
plus the next seven entries. You could then scroll to the Doe,
John entry. If the entry were John Doe, you'd type J to see the
first "J" on the list, plus the next seven entries.

To see complete information about a specific name on the list,
including comments you entered about the name, use the arrow
keys or the pointing device to mark the name, and do one of the
following:

•  choose the EDIT function (described in the following
section)

•  press I ENTER I after you mark the name
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The Phone List Functions. The master list contains six func
tions you can use. The functions are:

NEW Click on this button, or press rcTRLl [n] to
add an entry to the list. When you push the
NEN button, you see a small window that
lets you add an entry to the list.

At the Name: prompt, type a name contain
ing as many as 30 characters. The Phone
list accessory alphabetizes the name accord
ing to the first character you type.

At the Phone; prompt, type as many as 30
digits for the telephone number. You can
include area codes if you like, as well as P
(or a character your modem recognizes) to
indicate a pause in the dialing sequence.

At the Notes: prompt, type any notes you
like, such as addresses, using no more than
90 characters on three lines.

When you finish adding one entry and want
to add another, press [ ctrl I [o], or click on
the QUIT button. At the master list, push
the NEN button again to add another
number.

EDIT To change information about the entry on
which the marker rests in the master list,
click on this button, press [ ctrl I (T), or press
I ENTER 1.

The window that appears shows you all the
information you typed for the entry—the
name, the phone number, and any notes
(such as addresses) about the entry.

Make any changes you like to the entry,
remembering that you are working in
insert mode. Use the keyboard techniques
explained in Chapter 11, "General Informa
tion and Concepts," to change the entry.
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DELETE

PRINT

CALL

QUIT

To display and edit the entry previous to
the current one, press I ctrl I (T], or click on
the PREV button. To see and edit the entry
that occurs after the current one, press
I CTRL I f¥l, or click on the NEXT button. To
stop editing entries and redisplay the mas
ter list, press I Ctrl I [o], or click on the QU IT
button.

To delete the entry on which the marker
currently rests on the master list, press
I CTRL I in, or click on the DELETE button.
Personal DeskMate immediately deletes the
entry, and the rest of the master list
adjusts accordingly.

PRINT I. or click on the PR I NT button to

master list of entries. A

Press
print the entire
message box asks you whether you want to
print in "portrait" style or "notebook" style.
Select the button for the type of format you
want to use. The entries then print. Note
that if your printer does not support graph
ics, you do not see the message box, and the
list prints in "portrait" style.

Press I CTRL I [3, or click on the CALL button
to have your autodial modem dial the num
ber on which the marker currently rests. Be
sure that your modem is properly connected
and functioning before you use the CALL
function. (See the ̂ planation of the Com
munications accessory later in this chap
ter.) Pick up your receiver when the dialing
finishes.

Press fcTRLl [q] or [Iscl. or click on the QUIT
button to quit using the Phone list acces
sory and return to the application you were
previously using.

152



13 I Accessories

Installing the Phone list on the Tandy Desktop. For informa
tion about installing the Phone list on your desktop, see Chapter
12, "The Tandy Desktop." Note that when you install the Phone
list on the desktop, it is for display purposes only. You cannot
use any of its functions from the list displayed on the desktop.
Instead, you see the page from the master list that was on dis
play the last time you used the accessory. You can, however, pull
down the Accessory Menu and use the Phone list option from the
desktop to work with the information.

The Note Pad

The note pad lets you type and keep track of short notes, "to-do"
lists, and other quick reminders that don't require the more
sophisticated Text application. When you choose the Note pad
option from the Accessory Menu for the first time, a dialog box
appears. In the box, move to the CREATE button, and select it.
You see this window:

The note pad holds five pages. On the page, type any notes you
like. Remember that you're typing in insert mode. See Chapter
11, "General Information and Concepts," for information about
using this mode to type and edit.
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To see a previous page of notes, press I Ctrl I [p], or click on the
PREV button. To see the next page of notes, press I ctrl I (¥], or
click on the NEXT button. 15)u can move the marker only to the
top and bottom of the page. CVbu can move the marker to display
previous and next lines and/or pages of notes.)

The Note Pad Functions. The accessory contains four functions
you can use. The functions are:

CLEAR

PRINT

SAVE

QUIT

Use this function to clear the entire note

pad of all notes. When you press I ctrl | or
click on the CLEAR button, the note pad
clears, and you can type new notes on it.

Press I PRINT I. or click on the PRINT button to
print the entire note pad. A message box
asks you whether you want to print in "por
trait" style or "notebook" style. Select the
button for the type of format you want to
use. The note pad then prints. Note that if
your printer does not support graphics, you
do not see the message box, and the note
pad prints in "portrait" style.

To store updated contents of the entire note
pad, press I ctrl I [s], or click on the save
button. The page that was on display
remains on the screen after you save the
note pad. If you change information on the
page or add to it later, be sure to use this
function again to store the most current
version of the notepad.

This function lets you quit using the note
pad. When you press I ctrl I fol (or | esc I) or
click on the QUIT button, the window disap
pears, saving information you changed if
you specify, and you return to the applica
tion you were previously using.
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Installing the Note Pad on the Tandy Desktop. For informa
tion about installing the Note pad accessory on your desktop, see
Chapter 12, "The Tandy Desktop." Note that when you install
the Note pad on the desktop, it is for display purposes only. You
cannot use any of the note pad functions from the one that
appears on the screen. Instead, you see the page that was on dis
play the last time you used the accessory. You can, however, pull
down the Accessory Menu and use the Note pad option to revise
contents of the note pad from the desktop.

The Calendar

This accessory lets you quickly look up dates on a monthly calen
dar. When you choose the Calendar option from the Accessory
Menu, you see a window similar to this:

January 1987

1  2 3

4  5 6 7 8  9 10

11 12 13 14 15 16 17

18 19 20 21 22 23 24

25 26 27 28 29 30 31

The calendar you see will be for the month you typed when you
started up the computer. If you entered no date at that time, you
see a calendar for January, 1980.

To see the the previous month's calendar, press or click on
the window's top left button.

To see the next month's calendar, press Q, or click on the win
dow's top right button.

To see a calendar for the same month in the previous year, press
I CTRL I rn, or click on the window's bottom left button.

155



DeskMate Reference

To see a calendar for the same month in the next year, press
I CTRL I rn. or click on the window's bottom right button.

To quit using the Calendar accessory, press I Ctrl I [o] or I Esc I, or
click on the QUIT button.

Installing the Calendar on the Tandy Desktop. For informa
tion about installing the Calendar accessory on your desktop, see
Chapter 12, "The Tandy Desktop." Note that when you install
the Calendar on the desktop, it is for display purposes only. You
cannot use any of its functions from the calendar that appears
on the desktop. Instead, you see the month to which the system
date is currently set (the date you entered when you started up
the computer or set if you used the Date 4 Time accessory,
described later in this chapter). You can, however, pull down the
Accessory Menu and use the Calendar option to change the cal
endar to different months.

The Clipboard

This accessory lets you see the contents of any information cur
rently residing on the clipboard or a message that tells you the
type of content the clipboard is currently holding. The informa
tion on the clipboard is anything you've cut or copied (via the
Edit Menu). If you have non-ASCII information from the Work
sheet or Filer applications on the clipboard and use this acces
sory, you'll see a message telling you the type of information
that is on the clipboard, not the information itself. Information
from other applications appears intact on the clipboard because
it is either ASCII-based information or high-resolution graphics
information.

To quit displaying the Clipboard contents, press fCT^ [o] or flscl,
or click on the QUIT button.

The Color Accessory

This accessory lets you choose a set of colors in which you want
the screen to appear. In the Paint application, you can choose
different color sets for each picture you create.

When you choose the Color option from the Accessory Menu,
you see this window:
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Define Colors
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The colors currently in effect appear in the top section of the
window. To change any palette color, push the radio button next
to the color you want to change. Move to the Color Choices
section, and push the radio button next to the new color. That
color immediately takes effect, changing the appropriate parts of
the screen.

Change any or all of the four colors. When you finish, select the
QK button to continue using the application. The window disap
pears, and you return to the application you were using. To can
cel the color changes you made, select the CANCEL button, or
press IESC |. To reset the colors to the ones displayed before you
chose the Color accessory, select the RESET button.

The Communications Accessory
Use this accessory to tell Personal DeskMate about the telecom
munications hardware you plan to use. When you choose this
option from the Accessory Menu, you see this window:
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At the Communications port: prompt, push the radio button
for the communications port on your computer that you use for
connecting equipment, either Port 1 or Port 2. You can choose
only one port at a time for communications.

At the Connection: prompt, push the radio button that
describes the type of connection you'll use in telecommunica
tions—either a Modem connection or a Direct connection

through a cable to the other computer.

To answer the Modem name: prompt, use the Modems list box to
select the modem you'll use. The list box shows the different
modems you can use for telecommunications in Personal Desk-
Mate. Scroll the list until you mark the appropriate modem, and
then select it to display it in the Modem name: field.

When you finish, select the DK button to use the settings you
chose, or select the CANCEL button (or press | Esc |) to cancel your
setup. The window disappears, and you return to the application
you were previously using.
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The Date and Time Accessory
This accessory lets you specify a new date and time to use in
running Personal DeskMate. When you choose the Date & time
option from the Accessory Menu, you see this window:

Set Date flnd liMe

Date;

TiMe:

I— HP

At the Date: prompt, type a date in mmddyyyy format.

At the Time: prompt, type a time in hhmmss format.Use mili
tary (24-hour) time in making your entry.

Select the OK button to put the date/time change into effect, or
select the CANCEL button (or press | Esc |) to cancel the date/time
change. The window disappears, and you return to the applica
tion you were using.

The Mouse Accessory

This accessory enables you to set the double click speed for the
pointing device you're using. Before you use the Mouse accessory,
be sure that your pointing device is properly connected to your
computer and that it is ready for use. (See Appendix B for
instructions on setting up to use a pointing device.)

When you choose the Mouse option from the Accessory Menu,
you see this window:
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Fast
Double Click Speed

ml o3 94 95
SlOH

In the Double Click: section, push a button, 1-5, for a speed
you want to use when you double click. Then, point to the Test
button, and double click. The button reacts if you double clicked
at a speed in the range you chose. If nothing happened, you dou
ble clicked too slowly for the speed range you chose.

Continue selecting different speeds and testing them until you
find the speed that is right for you.

When you finish using the window, select the OK button to put
the setting into effect, or select the CANCEL button (or press | Esc |)
to cancel the setting. The window disappears, and you return to
the application you were using.

The Printer Accessory

The Printer accessory lets you choose the printer you want to
use with Personal DeskMate and tell Personal DeskMate about

the way your chosen printer handles certain hardware-controlled
settings. When you choose the Printer option from the Accessory
Menu, you see this window:
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To answer the Printer name: prompt, use the list box to the
left of the prompt. Scroll through the list of printers, using
either the arrow keys on the keyboard or the scrolling arrows at
the top of the list box. When you mark the printer you want to
use, select it to transfer its name to the Printer name: field.

The Start up printer: prompt lets you type any sequence of
decimal numlaers that you want to send to the printer when you
print anything in Personal DeskMate. This prompt is where you
would enter a decimal sequence to start your printer in, for
instance, condensed mode. Personal DeskMate sends this
sequence to the printer only when you print in Text mode, using
a portrait format. See your printer instruction manual to deter
mine the decimal sequence you'd type to make the printer print
in a special way. (See Chapter 11, "General Information and
Concepts," for details about Text mode and the portrait format.)

The Line feed filter toggles between on and off. Check your
printer's switch. If it is on, leave this setting toggled on. Other
wise, toggle it off.
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The choices in the Printer control codes: section of the

window default to the decimal sequences for boldfacing and
underlining used by the printer you previously chose. You can
type different decimal sequences if you're using a printer that
doesn't appear on the list. Choose the printer that most closely
resembles yours, and then enter its appropriate decimal
sequences for the boldface on, boldface off, underline on, and
underline off print codes. Use this "customizing" procedure on
only one printer from the list.

When you finish setting up the information in this window,
select the OK button to put your settings into effect, or select the
CANCEL button (or press I esc I) to cancel the setup. The window
disappears, and you return to the application you were previ
ously using.
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TEXT

The Text application offers you a simple word-processing system
so that you can prepare essays, letters, or anything else that you
might normally use a typewriter to produce.

The Text Screen

After you access the Text application, you see a screen that is,
for the most part, blank. (If you opened an existing file, you see
the first screen of the document.)

The screen contains a title bar that contains access to the Acces
sory Menu, the application's title and your document title (if you
opened an existing document), and a question mark icon for
accessing a help window about the Text application.

Below the title bar is a menu bar that gives you access to the
File Menu, Edit Menu, Text Menu, and Search Menu. Also on the
menu bar are up and down arrow icons that enable you to scroll
the screen via a pointing device.

The majority of the screen is your workspace. You can type or
display as many as 20 lines of text on one screen.

The bottom line of the screen contains a reference pointer that
tells you the line and page number of the document on the
screen. Also on this line are the INSERT and OVERTYPE buttons
that, when you select one, enable you to switch between using
insert mode and overtype mode. I ctrl I [T] is the accelerator to the
INSERT button, and | ctrl I fol is the accelerator to the OVERTYPE
button. Finally, the line contains a message that tells you
whether your document is currently in non-ASCII or ASCII
format.
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Using Text

To start a new document, simply begin typing. When you first
access a document, you automatically begin in insert mode. (You
can see that the INSERT button at the bottom of the screen is

pushed down.) As you type, the | marker moves to the right each
time you type a character, and any existing characters also move
right to accommodate the characters you type. Note that the
I BACKSPACE I key works differently, depending upon whether you are
working in insert or overtype mode. When in insert mode, press
ing I BACKSPACE I deletes the previous character and closes up text.
In overtype mode, explained later, | backspace I replaces the pre
vious character with an open, blank space.

To end a paragraph, press I enter |. To leave a blank line in your
document, press I enter I when the cursor is at the beginning of a
new line. To force a page to end before you've typed an entire
page's worth of text (the number of lines currently stored in the
Page setup option of the Accessory Menu), type .N I enter I in the
first two positions of a new line. Type nothing else on the line.

To see part of a document not currently on the screen, either use
the keys described in Chapter 11, "General Information and
Concepts," or select one of the arrow icons in the menu har.

The features available to you as you type or edit a document are
explained in the remainder of this chapter.

The Title Bar

The title har lets you display the Accessory Menu via the Tandy
icon, shows you the name of the application (Text) and the name
of the document currently on the screen (until led if the docu
ment is one you just created), and gives you access to any help
windows available for the application via the question mark icon.

The Accessory Menu. Detailed explanations of the options on
the Accessory Menu are described in Chapter 13, "Accessories."

The Help Windows. To view help windows for the application,
select the question mark icon. Help windows are described and
explained in Chapter 11, "General Information and Concepts."
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The Menu Bar

The Menu Bar gives you access to the four menus you can use in
the Text application: the File Menu, the Edit Menu, the Text
Menu, and the Search Menu.

The File Menu. The File Menu lets you perform functions
related to the document file as a whole. To see the File Menu,
press I ALT I (T|, or point to the menu name, and press and hold the
button.

Detailed explanations of most of the options on this menu are in
Chapter 11, "General Information and Concepts." Following are
detailed explanations of the Merge, To ASCII, and From ASCII
options.

Merge...

lb ASCII

Use this option to insert text from another
file into the currently open file at the cur
sor's current position.

Use the arrow keys to scroll through the
box that contains filenames available for

merging. When you mark the appropriate
file, move out of the list box, and select OK
to insert the document at the cursor's cur

rent position, or select CANCEL to cancel the
merge and return to the text screen.

Selecting this option makes Text delete any
non-ASCII characters from your document.
When you create a document, it is in a non-
ASCII format so that you can use boldfaced
and underlined text. However, when you use
the To ASCII option. Text removes the bold
face and underline codes from the file. You

can clipboard parts of the document for use
in other ASCII-based programs or send an
ASCII file via telecommunications to

another computer. Note that you cannot use
the Boldface and Underline options on
the Text Menu when your file is in ASCII
format.
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From ASCII Selecting this option enables you to insert
non-ASCII characters in a document so that

you can use boldfaced and underlined text.
When your file is in non-ASCII format, you
can use the Boldface and Underline

options on the Text Menu.

The Edit Menu. This menu gives you the means to move, copy,
and delete selected text from a document. First, select the text
you want to manipulate, and then display the menu. (If you are
working in overtype mode. Text automatically selects the charac
ter beneath the cursor, plus any other characters you choose to
select. In insert mode, no character is selected imtil you actively
select it.)

Detailed explanations of the options on this menu are in Chapter
11, "General Information and Concepts."

The Text Menu. This menu lets you make selected text appear
and print either in a standard way, in boldface, or underlined.
The Text Menu options are:

Plain Use this option to make selected text appear
in a normal fashion on the screen and print
in the standard way your printer prints
text. (Text automatically assumes this
appearance and printing characteristic. Use
this option to change text that you've bold
faced or underlined back to normal.)

Bold This option lets you make selected text
appear and print in boldface. You can
make plain or underlined text bold.

Underline Use this option to make selected text appear
and print underlined. You can underline
either plain or bold text.

Note: Y)u can print bold or underlined characters on printers
that support bold and underline control codes. If you're
using a dot matrix printer that doesn't support these
codes, you can print a document in graphics mode to
achieve the bold or underlined effect; however, printing
speed is greatly reduced.

The Search Menu. This menu enables you to find a string of
characters in your document or find the string and substitute
another one in its place. The Search Menu options are:
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Find... Use this option to locate the first occur
rence of a string in a document.

At the Search for: prompt, type the
string of characters you want to find (up to
the maximum of 38 characters). Then,
select OK to carry out the option or CANCEL
to cancel the option and return to the text
screen.

If you select OK, Text starts searching from
the current cursor position for the string
you specified, ignoring upper-/lowercase dis
tinctions. (If your search string is WORK,
Text will find occurrences of WORK, Work,
and work.)

If Text finds the string, the part of the doc
ument containing the string appears, and
Text positions the cursor at the beginning
of the string. If Text cannot find the string,
you see a message—Search string not
found. Select the OK button to continue

working with the document.

Find next Use this option to locate subsequent occur
rences of a string you specified in the Find
option. Simply select this option, and the
cursor moves to the next occurrence of the
string.

Substitute This option enables you to have Text search
for a particular string of characters and
replace it with another.

At the Search for: prompt, type the text
string you want to find and replace, using
no more than 38 characters. Press I tab |.

At the Replace with: prompt, type the
text string you want to use as a replace
ment, using no more than 38 characters.

After you specify the search and replace
ment strings, select the OK button to begin
the search, or select CANCEL to cancel the
function and return to the text screen.
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If you select OK, Text begins searching from
the currrent cursor position for the text
string you specified. If it finds it, the part
of the document that contains the string
appears, and a dialog box asks whether or
not you want to make the substitution at
this occurrence.

Select Y E S to go ahead with the replacement
and have Text continue searching for
another occurrence of the string. Select NO
to make Text skip this replacement and con
tinue searching for another occurrence of
the string. Select CANCEL to skip this
replacement and cancel the Substitute
function, returning to the text screen.

If all the text in an occurrence of a string
found by the Substitute function is bold
faced or underlined, the text that replaces it
will also be boldfaced or underlined. If only
part of the text in the found occurrence is
boldfaced or underlined. Substitute
replaces it with plain text.

After Text finds and replaces the last occur
rence of a string, it tells you the number of
occurrences it found and replaced. Select OK
to continue working with your document.

The Bottom Line

The last line on the screen displays your location in the docu
ment and the format, ASCII or non-ASCII, of your document. In
addition, the line displays two buttons that let you switch
between using the insert and overt3T)e modes.

Line and Page Numbers. The Line and Page messages show
you the cursor's location in a document. The number of lines per
"page" equals the number of printed lines per page that resides
in the Page setup option (on the File Menu). So, if you chose 54
as the number of printed lines that you want to appear on a
page and the cursor was on the 55th line of a document, the
location would be Line 1 , Page 2.
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Insert and Overtype Modes. When you first create or open a
document, Text sets you up to tjrpe in insert mode. This means
that an5d;hing you type is inserted at the cursor's location. All
text that follows the cursor moves to the right to accommodate
the insertion. If you are using overtjpe mode and want to switch
to insert mode, select the INSERT button by pointing and click
ing or by pressing I ctrl I (T).

Overtjpe mode, on the other hand, makes any character you
tjpe replace the one at the cursor's current position. The cursor
moves to the right as you tjpe each character, removing the
character previously there. To switch to overtype mode from
insert mode, select the OVERTYPE button by pointing and click
ing or by pressing I ctrl I [3.

ASCII and Non-ASCII Format. When you create a document.
Text sets you up to tjpe a non-ASCII, word-processing tjpe doc
ument. Y)u can, by using the To ASCII option on the File Menu,
change your document to ASCII format. ASCII format means
that all characters in the document can be translated into

ASCII code for use in telecommunications or other ASCII-based

programs. If your document is in ASCII format, you cannot use
boldfaced or underlined characters in the document. The bottom
line of the screen shows that the document is an ASCII-
formatted one.

Non-ASCII format means that you can use boldfaced and imder-
lined characters in your document; however, you cannot use
parts of the document with other ASCII-based programs. When
your document is in non-ASCII format, the bottom line of the
screen tells you.
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WORKSHEET

The Worksheet application provides you a way to set up and
arrange numeric information in tables of as many as 99 rows
and 99 columns. Worksheet can calculate and display answers
for complex formulas quickly and help you keep track of anything
from gas mileage to tax deductions.

The Worksheet Screen

After you access the Worksheet application, you see a screen that
is, for the most part, blank. If you open an existing file, you see
the worksheet held in that file. The screen contains a title bar

that gives you access to the Accessory Menu via the Tandy icon,
the application's title and the file's name (if you opened an exist
ing file), and access to help information via the question mark
icon.

Below the title bar is a menu bar that lets you use the Work
sheet menus: The File Menu, the Edit Menu, the Pad Menu, the
Cells Menu, and the Search Menu. Also on the menu bar are
four arrow icons that enable you to scroll the screen using a
pointing device.

The major part of the screen is the worksheet. Although you can
see only a small part of the available workspace, you can use as
many as 99 rows and 99 columns in a particular worksheet.

Row numbers are on the left side of the screen. Column numbers

appear across the top of the worksheet area. Each intersection of
a row and column is called a cell. The marker highlights an
entire cell. Position the marker on any cell in which you want to
type information. Type the information, and it appears in the
cell.

The bottom line of the screen shows you the types of information
you can type on a worksheet: LABELs to organize columns and
rows, blocks of TEXT that do not fit into column/row format,
NUMBERS, INPUT cells, where you type information only at the
time you calculate a worksheet, and FORMULAS.
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Using Worksheet

To develop a new worksheet, move the marker to the cell at
which you want to place information, and type the information.
Ifou can use any number of features described in the remainder
of this chapter to develop the worksheet.

To see part of a worksheet not currently on the screen, either
use the keys described in Chapter 11, "General Information and
Concepts," or select one of the arrow icons in the menu bar.

Selecting Cells. Any cell on which you position the marker is
the currently selected cell. To add or remove cells to or from the
group already selected, press I shif | and an arrow key. Pressing
rpD and an arrow key selects to the end of the screen page in the
direction you chose.

The Title Bar

The title bar lets you display the Accessory Menu via the Tandy
icon, shows you the name of the application (Worksheet) and the
name of the file currently on the screen ("untitled" if the file is
one you just created), and gives you access to any help windows
available for the application via the question mark icon.

The Accessory Menu. Detailed explanations of the options on
the Accessory Menu are described in Chapter 13, "Accessories."

The Help Windows. To view help windows for the application,
select the question mark icon. Help windows are explained in
Chapter 11, "General Information and Concepts."

The Menu Bar

The Menu Bar gives you access to the five menus you can use in
the Worksheet application: the File Menu, the Edit Menu, the
Pad Menu, the Cells Menu, and the Search Menu.

The File Menu. The File Menu lets you perform functions
related to the worksheet file as a whole.

Detailed explanations of most of the options on this menu are in
Chapter 11, "General Information and Concepts." Following is a
detailed explanation of the Merge option.
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Merge... Use this option to insert another Worksheet
file into the currently open file at the mark
er's current position.

Either type a filename at the Merge file:
prompt, or use the arrow keys to scroll
through the box that contains filenames
available for merging. When you mark the
appropriate file and place it in the edit
field, select the OK button to insert the file
at the marker's current position, or select
CANCEL to cancel the merge and return to
the screen you were using.

The Edit Menu. This menu gives you the means to move, copy,
and delete selected cells from a worksheet. First, select the cells
you want to manipulate, and then display the menu. (The cell on
which the marker is positioned is automatically selected.)

Detailed explanations of the options on this menu are in Chapter
11, "Gleneral Information and Concepts."

Note: Any information you cut or copy can be pasted only into a
Worksheet file.

The Pad Menu. This menu lets you change the displayed width
of columns on the screen, or insert/delete rows and columns. The
menu also enables you to calculate a worksheet. The Pad Menu
options are:

Column width... Use this option to change the width of the
column in which the marker is currently
positioned or all columns if you so choose.
Columns automatically appear with a width
of 10 characters unless you change them. If
you're changing the width of only one col
umn, move the marker into that column (at
any row), and then use this option.

Select either the Current column or All

columns.

At the Width: prompt, tj^e the new width
you want the column(s) to have. "S)u can
specify a maximum of 77 characters and a
minimum of 3 for the new width, although
labels or numbers you tjrpe can be no longer
than 46 characters, including spaces.
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Insert column

Delete column

Insert row

Select OK to make the width change, or
select CANCEL to cancel the width change
and return to the worksheet.

Use this option to insert a new, blank col
umn at the marker's current position. When
you insert a column, the current column
and all columns to its right move right to
accommodate the insertion. If Column 99

contains information and the insertion

would "push" that column off the worksheet,
you see a warning message. Respond to the
message by selecting the appropriate button
to accept or cancel the insertion.

Note that Worksheet takes the column

insertion into account and changes all exist
ing formulas so that they contain revised
and correct column numbers.

Use this option to delete the column at the
marker's current position. When you delete
a column, all columns to the right move left
to "close up" the space left by the deleted
column.

Worksheet takes the column deletion into
account and changes all existing formulas
so that they contain revised and correct col
umn numbers.

Use this option to insert a new, blank row
at the marker's current position. WTien you
insert a row, the current row and all rows
below move down to accommodate the inser
tion. If Row 99 contains information and the
insertion would "push" that column off the
worksheet, you see a warning message.
Respond to the message by selecting the
appropriate button to accept or cancel the
insertion.

Worksheet takes the row insertion into
account and changes all existing formulas
so that they contain revised and correct row
numbers.
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Delete row Use this option to delete the row at the
marker's current position. When you delete
a row, all rows below move up to "close up"
the space left by the deleted row.

Worksheet takes the row deletion into

account and changes all existing formulas
so that they contain revised and correct row
numbers.

Calculate Use this option to calculate a worksheet,
either for the first time or after you revise
information on it. Worksheet calculates
from left to right and top to bottom, skip
ping any non-numeric information. Results
appear in cells in which you typed formulas.

Note: If the insertion or deletion causes a formula to refer to a

non-existent cell, the formula will need to be changed.

The Cells Menu. Use this menu to change the way numbers
appear on the worksheet (in decimal format, integer format, or
"dollar" format with only two decimal places),, specify variable
information that you want Worksheet to ask you to provide each
time you calculate the worksheet, type formulas for calculations
to be performed, or tjT)e text in a "block" format, not associating
it with particular cells. First, tjrpe your entry in the cell (or
select the cells on which you want to perform one of these menu
options). Then, pull down the Cells Menu. The Cells Menu
options are:

Format.. Use this option to change the way selected
cells appear on the worksheet.

In the Align section, select Left to make
all numbers appear aligned to the left or
Right to make numbers align to the right.
Worksheet automatically aligns text to the
left and numbers to the right if you do not
choose an alignment.
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In the Type section, select Decimal to
make numbers appear with decimal points
and a number of decimal places that you
specify. Select Integer to make numbers
appear with no decimal places. Select $
Dollar to make numbers appear with two
decimal places. Worksheet automatically
uses the Dollar format if you do not spec
ify another format.

If you chose Decimal format, type the num
ber of decimal places you want to display at
the Number of decimal digits: prompt.
Specify no more than seven decimal digits.

Select OK to put your format choices into
effect, or select CANCEL to cancel the format
and redisplay the worksheet screen.

Input... Use this option to make Worksheet prompt
you for a cell's contents each time you calcu
late the worksheet.

At the Field Name: prompt, type a phrase
by which you can identify the cell, such as
AMOUNT OF LOAN.

At the Field Value: prompt, type a
response you think you'll most often use in
the field. You can change this default
answer at the time of calculation.

Select OK to use the Field Name you tjrped
and define the cell as a variable one, or
select CANCEL to cancel defining the cell as
a variable and return to the worksheet
screen.

Note that input cells do not display unless
you reference them in a formula.

When you calculate and Worksheet reaches
a formula that references an input field
you've defined, you see:
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Formula...

At the Field Value: prompt, type the
number you want the cell to contain for this
calculation.

Select DK to use the value and continue

with the calculation, or select CANCEL to
cancel both the entry you made for Field
Va 1 ue: and the calculation.

Use this option to write or revise a formula
to a cell or selected group of cells. When you
select the Formula option, the lower part of
your screen shows:

Edit Foi^iila

FonwU: L™.«B]™rona™na«=nH==™-™en==-«™nH^
Operators: +, *, /, !
Functions; AB$,ftTN,ffllG,CMT,COS,£)(F,INT,LOO,MflX,HIN,!IMT,SQi,SIN,SQR,SUM,TflN

CANCEL tMl

Move to the scrolling arrow icons in this
dialog box, and press the space bar or click
to move the worksheet to different cells so
that you can read their contents.

At the Formula: prompt, type the formula
you want to place in the cell(s).

As you write a formula, keep in mind that
math operations are performed left to right.
Parenthetical operations are performed first.
(If you nest parentheses, innermost opera
tions are performed first.) Multiplication
and division are performed second, and
addition and subtraction last.
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Worksheet lets you use the value in another
cell just as you would any number in a for
mula. This value can be a number, or it can
be the result of a previous calculation. If
the cell contains a label or text, its value is
nothing, so any formula that references a
label or text cell does not calculate. To use
the value of a cell in a formula, reference
that cell by typing its row and column num
ber, for example R5C3 to refer to the value
in the cell at Row 5, Column 3. Because
Worksheet calculates formulas beginning
with the one in Row 1, Column 1, and
works to the right through Row 1, then
down through Row 2, and so on, until it cal
culates the last formula, any cell reference
you use must be to cells with either smaller
or equal row numbers and smaller column
numbers.

If your cell reference supplies only a row
number. Worksheet uses the cell in the
same column as the formula, but at the row
specified. If you supply only a colvimn num
ber, Worksheet uses the cell in the same
row as the formula, but at the column
specified.
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Formulas always appear in the currently
selected cell. When you select more than one
cell, Worksheet copies the formula into each
selected cell, using different cell references.
The exact formula is copied into the first
(lowest row and column) cell. For each refer
ence in the formula. Worksheet computes
the relative difference in row and column

number, storing the formula with references
that provide the same relative differences in
column and row position. For example, sup
pose that the first three cells in Column 2
are selected and that you tjrpe the formula,
10-HRlCl. The first selected cell is RlCl,
and the row difference is 0 (the same row),
while the column difference is 1. At each
cell, the reference will he to a cell in the
same row as that cell, but one column over.
That is:

Cell Formula

R1C2 10-I-RlCl

R2C2 10-fR2Cl

R3C2 10 + R3C1

"Vbu can change this rale by placing a # at
the beginning of the reference, for example
10 + #R1C1. This changes the above exam
ple to:

Cell Formula

R1C2 10 +RlCl

R2C2 10 +RlCl

R3C2 10 +RlCl

Once the selected area fills with formulas.
Worksheet discards the # sign, which now
has no effect on subsequent operations, such
as Copy.
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The next two lines on the window show you
the operators and functions you can use in
formulas. Following are descriptions of the
operators and functions. After the descrip
tions are a few examples of formulas that
use the operators and functions.

The arithmetic operators are:

+  Addition * Multiplication
-  Subtraction / Division

!  Power

Several functions operate on a group of
cells. The group is determined as follows: If
the argument is a row, the group includes
all cells from (and including) the cell in the
same column at the indicated row, down to
but not including the cell containing the
formula. If the argument is a column, the
group includes all cells from (and including)
the cell in the same row at the indicated
column, over to but not including the cell
containing the formula.

These functions are:

AVG Sum of the values in the cells

divided by the number of cells

MIN Minimum value in the cells

MAX Maximum value in the cells

SUM Sum of the values in the cells

Two more functions provide an accumula
tion of part of another row or column: CMT
and RMT. These functions are useful only if
you use an absolute reference (one with a #
sign) to a cell (not only a row or only a col
umn). In addition, they should appear in a
selected part of another row or column.
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CMT works as follows: The first cell of the
selected column contains the number from
the referenced cell. The second cell contains
the first cell plus the cell one row below the
referenced cell. The third cell contains the
second cell plus the cell two rows below the
referenced cell. This continues with each
cell containing the previous cell plus the cell
at the same relative position in the refer
enced colimm.

RMT works as follows: The first cell of the
selected row contains the number from the
referenced cell. The second cell contains the
first cell plus the cell one column below the
referenced cell. The third cell contains the
second cell plus the cell two columns below
the referenced cell. This continues with
each cell containing the previous cell plus
the cell at the same relative position in the
referenced row.

Other functions appear below. Note that
results of calculations that use trignonome-
tric functions display in radians.

ABS Absolute value LOG Logarithm
ATN Arctangent SGN Sign
COS Cosine SIN Sine

EXP Exponential SQR Square root
INT Integer TAN Tangent

truncation

A few examples using the operations and
functions follow.

(R1 + R2) Adds two cells in the same column.

(C3)-(R1C4) Subtracts the value of the cell in Row 1,
Column 4 from the value of the cell in Col
umn 3 of the current row.

C1*C2 Multiplies two cells in the same row.

(RlC2)/2 Divides the value of the cell in Row 1, Col
umn 2 by 2.
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C6R3I3

AVG(Cl)

CMT(#R4C3)

MAX(C4)

MIN(Rl)

RMT(#R4C3)

Calculates the cube of the value of the cell
in Row 3, Column 6.

Adds all the values in the current row,
starting with Column 1, up to the current
cell, and divides by the number of cells
added.

Figures a cumulative total for Column 3,
starting with Row 4. For example:

]  c

[  4

[  5

[  6

10.00

20.00

If you select Rows 4, 5, and 6 in Column 4
and enter the example formula, the calcula
tion produces:

]  [

[  4

C  5

[  6

5.00

10.00

20.00

5.(

15.(

35.1

Shows the maximum value of the current

row, starting with Column 4, up to the cur
rent column.

Shows the minimum value in the current
column, starting with Row 1, up to the cur
rent row.

Gives a cumulative total for Row 4, starting
with Column 3. For example:

3

SA

]  [ 5  ]

20.00

If you select Columns 3, 4, and 5 and enter
the example formula, the calculation
produces:

3

5.{

5.{

]  [ 4

I  10.

J  15.

]  [ 5  ]

20.00

35.00
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SUM(R5) Displays the sum of the values in the cur
rent column, starting with Row 5, up to the
current row.

ABS(R2C3) Displays the absolute value of the cell in
Row 2, Column 3 (the distance from 0 of
the value).

ATN(R3C5) Displays the arctangent of the value of Cell
R3C5—^the angle that has its tangent equal
to the value of cell R3C5. (The result dis
plays in radians. Use ATN(^C5)*57.29578
to display an arctangent in degrees.

COS(R3C5) Displays the cosine of the value of cell
R3C5. (Use COS((R3C5)*.01745329) if the
value in Cell R3C5 is in degrees instead of
radians.)

EXP(R4C3) Displays e raised to the power of the value
of cell R4C3 (Naperian, or natural, expo
nential e^').

MT(R4C2) Displays the truncated value of cell R4C2.

LOG(R2C4) Displays the logarithm to the base 10 of the
value in cell R2C4.

SGN(R3C4) Displays the sign of the value in Cell R3C4
(1.00 if the argument is positive or zero,
and -1.00 if the argument is negative).

SIN(R2C1) Displays the sine of the value in Cell R2C1.
(Use SIN((R2C1)*.01745329) if the value in
Cell R2C1 is in degrees instead of radians.)

SQR(R5C1) Displays the square root of the value in Cell
R5C1.

TAN(R2C3) Shows the tangent of the value in Cell
R2C3. (Use TAN((R2C3)*.01745329) if the
value in Cell R2C3 is in degrees instead of
radians.)
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Start text This function defines a selected group of
cells as a text block. Choose this option
when you want to type a block of text that
doesn't fit conveniently into cells—for
instance, notes about parts of a worksheet.
When you use the Text option, Worksheet
gives you standard editing features, and
words wrap to succeeding lines as they do
in the Text application.

Text blocks are like notes attached to a
spreadsheet. Deleting rows and columns
will not affect the text block. However, you
should use caution because worksheet infor
mation moved under Text due to insertions

and deletions of rows and columns will be
lost. To select an existing text block, simply
move the pointer to a position in the block
and press the space bar.

End text Choose this option when you finish typing
or editing text in a block.

The Search Menu. This menu lets you find special parts of the
worksheet—labels, numbers you've entered in cells, or cell
addresses. The Search Menu options are:

Find label... Use this option to find a group of characters
in a label on the worksheet.

At the Label: prompt, type the characters
you want to find. Then, select OK to make
Worksheet find the characters.

Select CANCEL to cancel the option and
return to the screen you were using.

If you select GK, Worksheet begins searching
for the first occurrence of the characters,
from the currently marked cell to the right
and downward. If it finds the characters you
wanted, the marker moves to the cell con
taining the characters. If it cannot find the
characters, you see this message:

Label not found. Search cancelled
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Select the OK button to make the message
disappear and continue using the
worksheet.

Find number... This option enables you to find a numeric
value you entered in a cell.

At the Number: prompt, type the number
you want Worksheet to find. Then, select OK
to make Worksheet find the number, or
select CANCEL to cancel the option and
return to the screen you were using.

If you select OK, Worksheet begins searching
for the first occurrence of the number,
starting at the currently marked cell and
searching to the right and downward. (To
search the entire worksheet, press I home I
before you use the Find number option.) If
Worksheet finds the number you wanted,
the marker moves to the cell containing the
number. If it cannot find the number, you
see this message:

Number not found. Search cancelled

Select the OK button to make the message
disappear and continue using the
worksheet.

Find cell... Use this option to move the marker to a
specific cell address.

At the Column: prompt, type the column
number you want to find. At the Row:
prompt, type the row number you want to
find. Then, select OK to make Worksheet
find the cell, or select CANCEL to cancel the
option and return to the screen you were
using.

If you select OK, Worksheet moves the
marker to the cell you specified.
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Find next Choose this option to find the next occur
rence of a group of characters or a numeric
value you specified using the Find label
or Find number options.

When Worksheet finds the first occurrence,
choose the Find next option, and Work
sheet again searches for the next occur
rence. If it can find no other occurrence, you
see:

Label not found. Search cancelled,

or

Number not found. Search cancelled.

Select the OK button to make the message
disappear and continue using the
worksheet.

The Bottom Line

The bottom line of the screen shows you the five types of entries
you can make on the Worksheet. The type of entry in use by the
cell in which the marker currently rests appears highlighted.
The four types of entries are:

LABEL, for a non-numeric cell in which you enter a maximum of
46 characters of text to serve as a label for a section or row/col

umn of the worksheet.

TEXT, for a non-numeric group of cells in which you enter "free-
form" text that doesn't lend itself to a cell-by-cell format.

NUMBER, for cells in which you enter values to be used in calcula
tions. Values must not exceed 46 characters in length.

INPUT, for cells in which you enter information to be supplied
only when you calculate the worksheet. You also see the actual
value being used in the particular input cell.

FORMULA, for cells in which you enter formulas to calculate por
tions of the worksheet. You also see the actual formula in use by
the cell.
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FILER

The Filer application is an all-purpose information storage and
retrieval system—an electronic filing cabinet. Unlike a filing
cabinet, however, Filer does all the sorting for you, shows you
either an entire record or only the information you want to see,
gives you summary lists of information that meets criteria you
establish, and even displays and prints reports about your
information.

The Filer Screen

When you first access the Filer application, you see a screen that
is, for the most part, blank. The screen contains a title bar that
shows the Tandy icon for access to the Accessory Menu, the
application's title and your file's name (if you opened an existing
file), and a question mark icon for access to help information
about the Filer application.

Below the title bar is a menu bar that gives you access to the
File Menu, Edit Menu, Records Menu, Field Menu, Text Menu,
Report Menu, and Index Menu.

Using Filer

Creating Record Formats. If you are working with a new,
untitled file, the first step in setting up the file (or database) is
to create a form, or record format, to hold the information you
want to store. A brief procedure follows. Use the explanations
later in this chapter for details on the techniques used in the
procedure.

1. Pull down the File Menu, and choose New.

2. Position the marker anywhere on the screen that you want
a field to appear. A field is a unit of information. If you
were keeping an inventory of books, one field might be
"Title of Book."

3. Pull down the Field Menu, and choose the Add option.
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4. Using the arrow keys or pressing the pointing device button
and dragging the pointer, define the number of characters
you want the field to use when you actually type informa
tion about the field in a record. Moving the marker horizon
tally adds or deletes characters in each row, one character
at a time. Moving the marker vertically adds or deletes
entire rows of characters. As you define the field's size,
notice that every tenth character appears shaded to help
you count the number of characters quickly.

5. When the field is the size you want, press I enter I, or release
the button on the pointing device.

6. A dialog box appears, in which you give the field a label for
identification purposes, specify whether or not you want the
field to appear with a box drawn around it, tell Filer the
type of information you'll store in the field (either text or
numeric), and specify where you want the field's label to
appear (to the left of the field, directly above the field, or
not at all). Fields of more than one row must be text only.
Finalize your decisions when you finish the dialog box.

7. Repeat the above steps until you create all the fields you
want. Use the Format option to place format characters in a
field for creating a specific format (such as (xxx) xxx-xxxx
for a phone number). Select the field, and then use the
Format option. Use the arrow keys to move the marker
around in the field, t3q)ing any characters that you want to
make part of the field. Press I enter I when you finish.

8. Add additional, cosmetic text that is not part of a field's
information (for instance, a title or heading for a section of
the record). First, pull down the Text Menu, and choose the
options you want for making the text appear boldfaced or
underlined. Then, position the marker wherever you want to
type the text, and type it. Use the Edit Menu to cut, copy,
or paste this text in different locations.

9. Delete fields or explanatory text by selecting the field or
text and then using the Edit Menu's Clear option.

10. To change the size of an already created field, select the
field, and then use the Field Menu's Size option. Use the
arrow keys, or point to the field's final character slot, and
press and hold the button, dragging the pointer to lengthen
or shorten the field. Press I enter I or release the button when
you finish.
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11. To change a field, first select the field, and then use the
Field Menu's Change option. Yon see the dialog box you
used when creating the field. Change the responses in the
box to reflect your choices. Yon can change numeric fields
into text fields but not text fields into numeric ones. Final
ize your responses when you finish.

12. To move a field to another location, first select the field.
Then, use the Edit Menu's Cut option. Move the marker to
the new location, and use the Edit Menu's Paste option.

When your record format is complete, you can enter information
and develop the rest of your database.

Adding Records. Once you have a record format to hold the
information you want to store, you can begin adding records. Fol
low the procedure below to add information to your database.
Refer to the detailed explanations later in the chapter to com
plete the procedure.

1. Pull down the Records Menu, and choose the Change
option. If no records exist. Filer automatically chooses the
Add option to let you begin adding records. If records
already exist and you want to add more, pull down the Rec
ords Menu, and choose the Change option. Then, pull down
the Records Menu again, and choose the Add option. (I ctrl I
0 is the accelerator to this option.)

2. The form you defined appears on the screen, ready for addi
tional records. Type the information needed for each field.
Information in text fields appears aligned to the left.
Numeric field information aligns to the right. To move to
succeeding or previous fields, use iTABj or I shif I [ tab |. With a
pointing device, point to the field in which you want to
enter data, click the button to select that field, and type the
information.

3. To store a completed record and add another one, pull down
the Records Menu, and choose the Add (| ctrl | 0) option.
Personal DeskMate stores the record currently on display
and presents you with another blank form.

4. Continue adding records as long as you like.

5. When you finish adding records, select any available menu
option (other than the Records Menu's Add option), or select
the FIRST or LAST buttons at the bottom of the screen.

Filer stores the record and performs the action you specify.
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Defining Reports. After your database contains records, you
can see reports about any of the information in those records. To
generate a report on your information, you must first create a
report format. To do so, follow this procedure, referring to the
details later in this chapter.

1. Pull down the Report Menu, and choose the Def ine option.
The screen that appears is divided into four sections—one
for heading information, one for the body of the report
(where the field information will appear), one for any sum
mary information you want to see, and one for "footer"
information. If you used Page setup to define a report
narrower than 80 columns, a vertical line appears on the
screen at your right margin position.

2. The Header section appears at the top of each page of the
report. Type any cosmetic text that you want to appear as
column heading information on the report, including a
report title if you like. Position the marker anywhere you
want the text to appear, and type it.

3. To make the date appear in the heading, position the
marker where you want the date to appear. Then, pull
down the Report Menu, and choose the Today's date
option. A MMM DD, YYYY symbol appears at the marker
position. When you display the report, the actual date will
appear here instead of the symbol.

4. To make the page number of the report appear in the head
ing, position the marker where you want the page number
to appear. Then, pull down the Report Menu, and choose
the Page # option. appears at the marker position.
When you display the report, the actual page number will
appear here instead of the sjnnbol.

5. In the Body section of the report, position the marker
where you want information from a field to appear. Then,
pull down the Field Menu and choose the Add option. A
dialog box appears, in which you choose the field you want
to place on the report. Filer checks to see whether the field
can fit at the marker's position. If the field is larger than
the amount of space available at the marker position, you
can choose whether to drop from the report any characters
that don't fit or cancel adding the field at this location. (%u
can add it at another location.) Finalize your decision.
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Place as many fields in the Body section as you like. You
can also type cosmetic text in this section. This part of the
report repeats as many times on each page as space allows.

6. In the Summary section, you can type cosmetic text and
specify that you want summary information to appear
beneath a column of information in the Body section. First,
position the marker where you want the summary to
appear. Next, pull down the Report Menu, and choose the
Summary option. A marker appears. Define the size of the
summary field in the same way as you defined the size of a
field on the record format. Summary fields can occupy only
a single row because they are numeric fields. When you fin
ish, press I ENTER I or release the button.

7. A dialog box appears. Complete the box, giving the sum
mary field a label, specifying whether you want it to appear
with a box drawn around it, and deciding whether you want
the label to appear to the left of the field, above the field, or
not at all. Specify the type of summary you want to see: a
numeric total, an average of values in the column, or a
count of the number of items listed. Finalize your choices
when you finish. After you add a summary field, you can
use the Field Menu's Format option to add format charac
ters to the field.

8. If you like, place a page number and/or date in the Footer
section, following the procedures in Steps 3 and 4 above.
You can also type cosmetic text in the Footer section if
you like.

9. To change the size of any section on the report, position the
marker in the section whose size you want to change. Then,
pull down the Report Menu, and choose the Resize sec
tion option. A highlighted marker appears.

10. Use the arrow keys, or press the button and drag the
pointer to enlarge or shrink the size of a section. As long as
you see gray space at the bottom of the screen, you can
enlarge a section without affecting the size of any sections
below it. When you've used all the available extra space,
enlarging a section shrinks the section immediately below
it, and vice versa. When you finish changing a section's
size, press I enter I or release the button. Use the same
method to enlarge/shrink other sections of the report.
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11. When you finish creating the report format, use another
menu option. Filer stores the report format and performs
the action you specify.

After you set up your database, you have a wealth of options
available for using and manipulating the information. The
remainder of this chapter is devoted to explaining all the menus
and options available to you in the Filer application.

The Title Bar

The title bar lets you display the Accessory Menu via the Tandy
icon, shows you the name of the application (Filer) and the
name of the file currently on the screen, and gives you access to
any help windows available for the application via the question
mark icon.

Filenames. If you are creating a file and have not yet named it
when a power failure or other mishap occurs, your work is not
likely to be lost. To access the information, display the desktop.
Then, pull down the File Menu, and choose Rename. In the
dialog box specify untitled at the From: prompt and any suit
able filename at the T o : prompt.

Once you rename the file, you can open it and continue using it.

The Accessory Menu. Detailed explanations of the options on
the Accessory Menu are described in Chapter 13, "Accessories."

The Help Windows. To view help windows for the application,
select the question mark icon. Help windows are explained in
Chapter 11, "General Information and Concepts."

The Menu Bar

The menu bar gives you access to the seven menus you can use
in Filer: the File Menu, the Edit Menu, the Records Menu, the
Field Menu, the Text Menu, the Report Menu, and the Index
Menu.

The File Menu. The File Menu lets you perform functions
related to the file as a whole. To see the File Menu using the
keyboard, press I alt I |T). With a pointing device, point to the
menu name, and press and hold the button.
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Detailed explanations of most of the options on this menu are in
Chapter 11, "General Information and Concepts." Following is a
detailed description of the Copy layouts option. Note that Filer
uses a database that resides on your disk. Changes you make to
records are stored on the disk each time you display a new
record.

Warning: If you're using a single-drive computer, you
must keep the Filer program (PMFILER.PDM) and
any data files you create on the same diskette. If
you're using multiple drives, you can store PMFI
LER.PDM and its data files on separate diskettes.

Whether you use one or two drives with Filer, never
switch diskettes unless and until the screen instructs

you to do so. If you switch diskettes at any other time,
you risk destroying both program and data files.

If you're not using subdirectories, continue with this
chapter. If, however, you are running the Filer appli
cation from a subdirectory, that subdirectory must
appear in the list of paths used by the path com
mand. For example, if you include the path command
in your autoexec.bat file, it might look like this:

path = a: \ pathl ;a: \ deskmate

where deskmate is the subdirectory in which Filer
resides.

Copy layouts... Use this option to make a duplicate of exist
ing record formats, report formats, and
index formats to store under another

filename.

At the Copy to: prompt, type a filename
containing eight or fewer characters to
which you want to save the formats. To save
formats on a different drive and/or direc

tory, type a complete pathname, using as
many as 64 characters.

Below the Copy to: prompt, you see the
current drive and directory in which your
existing file layouts are stored.
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When you finish, select the SAVE button to
complete the Copy layouts process, or
select the CANCEL button to cancel copying
the formats. You return to the screen you
were previously using.

Print... This option prints the form currently on the
screen, or if you're displaying a report,
prints the entire report. Forms and indexes
always print in "portrait" format. Reports
print according to the limits you assign via
the Page setup option. See Chapter 11 for
other details about the Print option.

The Edit Menu. This menu gives you the means to move, copy,
and delete selected information from the screen. First, select the
information you want to manipulate, and then display the menu.
To select a field, position the marker on the field itself (not on its
label), and press the space bar.

Detailed explanations of the options on this menu are in Chapter
11, "Loading and General Information." Following are brief
descriptions of the options and limitations on their uses in the
Filer application.

Cut (or (7^) Use this option to remove selected informa
tion from the screen and place it on the
clipboard. You can use this option when you
are defining a record's form to cut cosmetic
text or fields. When changing information in
records, use the option to cut a single field's
information, not including format characters
you might have in the field. Use the option
when defining a report format to cut any
information on the screen. The option is not
available when you are simply displaying
records, displaying reports, defining index
formats, or displaying indexed lists of
records.
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Copy (or [^) Use this option to place selected information
on the clipboard without removing it from
its current position on the screen. Use this
option when defining a record's format to
copy only cosmetic text. When changing
information in records, use the option to
copy a single field's information, not includ
ing format characters you might have in the
field. Use the option when defining a report
format to copy cosmetic text on the report.
The option is not available when you are
simply displaying records, displaying
reports, defining index formats, or display
ing indexed lists of records. "You can use it
after displaying a record, report, or indexed
list via the File Menu's Print to screen

option.

Paste (or I fiq I) This option takes information currently on
the clipboard and pastes it into the file at
the marker's current position. You can paste
the copied information into the file cur
rently in use or, if the information is in
ASCII format, into another file. Field and
report definitions cannot be pasted into
another file. Use this option when defining
a record's format to paste cosmetic text or
field information for the Filer application
only. When changing information in rec
ords, use the option to paste a single field's
information. Use the option when defining a
report format to paste any information onto
the report screen. The option is not avail
able when you are simply displaying rec
ords, displaying reports, defining index
formats, or displaying indexed lists of
records.
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Clear Use this option to delete selected informa
tion from the file. When you use this option,
information does not move to the clipboard
but is completely erased from the file. Use
the option when defining a record's format
to clear cosmetic text or field information. If

you delete a field from a record format, any
data already established in records for the
field is also deleted from your records. When
defining a report format, use the option to
clear any fields or text on the report screen.
The option is not available when you are
simply displaying records, displaying
reports, defining index formats, or display
ing indexed lists of records.

The Records Menu. The Records Menu is for your use in defin
ing a format for a file's records, displaying records, or changing
information in existing records. To pull down the Records Menu
using the keyboard, press I alt I [r]. With a pointing device, point
to the menu name, and press and hold the button.

First, make a selection from the first three options listed—
Define layout. Display, or Change. Then, pull down the
menu again, and choose one of the remaining four options. The
Records Menu options are:

Define layout This option lets you define the format you
want your records to follow when you add
information to them. When you create a
file. Personal DeskMate automatically
selects this menu option so that you can set
up the screen and the fields you want to
use.

Display Use this option to display existing records
one at a time. The records you see are
determined by information you supply using
the Find and Sort options on this menu.
Use the FIRST, NEXT, PREV, and LAST but
tons to display the corresponding records.
The accelerators to these buttons are:

FIRST fMn in
NEXT rCTRLl |T]
PREV rCTRLl (T]
LAST rCTRLl (T)
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Change

Add

Delete.

This option is similar to the Display
option but enables you to change informa
tion in existing records, one record at a
time. Use this option only to change data in
records, not simply to display records.

The records displayed for your editing are
determined by information you supply using
the Find and Sort options on this menu.
Move the marker to a field whose informa
tion you want to change. Then, edit the
information, remembering that you are
working in Insert mode. When you finish
changing information in one record, use
another Filer feature, or display the first,
next, previous, or last record in the file via
the FIRST, NEXT, PREV, and LAST buttons
at the bottom of the screen. The accelera
tors to these buttons are the same as those

used in the Display option. Changes you
make to one record are immediately stored
on diskette when you display another
record.

Use this option to add new records to your
file. Use this option only after yOu choose
the Change option from this menu. When
you choose this option, a blank record
appears on the screen. Ts^pe the information
needed to complete the record. When you
finish adding a record, use the option again
to continue adding records to the file, or use
another Filer option. Records you add are
immediately stored on disk when you dis
play another blank form or use another
option.

Use this option to delete the currently dis
played record. You can use the Delete
option only after you choose the Change
option from this menu.
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Find...

Select the OK button to carry out the dele
tion. Filer automatically deletes the record
from the screen and from the disk, and the
next record in the file appears. Select the
CANCEL button to cancel the deletion and

return to the record display.

This option lets you decide which records
you want to display, change, or include in a
report. When you choose the Find option,
this dialog box appears:

■■■ Find Records

Find all i>ecoi>ds in hMcIi;

Date:
(biount:
Oraanization
Hethod of Fa

^Equal to
P'Not equal to
i'Less OP equal to
^Greatep op equal to
Mn betiieen

Value;

The section of the box entitled Find all
records in which: is the section in

which your Find criteria appears. The first
time you establish criteria, this section is
empty.
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The FIELDS list box lets you scroll through
a list of all field labels in the file. When you
choose a field, you then define criteria that
the information in that field must meet to
be included in the records you want dis
played. Scroll through the list using the
arrow keys or the scrolling arrow icons in
the title line of the box. When you mark the
field whose criteria you want to set, move
out of the list box. The field label appears
in the Find all records in which:

section.

Next, move to the group of radio buttons
that let you determine whether you want
the information in your chosen field to be
equal to ( = ), not equal to (=^^), less than or
equal to (^), greater than or equal to (^),
or inside a range of data that you supply in
the Value: section of the dialog box. When
you deal with alphabetic characters, these
radio buttons imply "alphabetically equal
to," "alphabetically less than or equal to,"
and so on, using alphabetic order. After you
select one of the radio buttons, move out of
this section. The information you chose
appears in the Find all records in
which: section of the dialog box.

The next section lets you specify a standard
against which the information in your cho
sen field will be judged. For instance, you
might choose the Balance field, specify that
you want information in this field to be
greater than or equal to, and then enter in
this section the amount that the balance

must equal or exceed for a record to be dis
played. Type the information. If you chose a
range of values that the information must
fall between, you see two edit fields. Type
the first value in the first field, and the
ending value in the second field.
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You can use two "wildcard" characters when

typing a value—? and *. Typing ? tells
Filer that you don't care what the character
at that position is. Tjrping ?ank would find
sank, bank, or tank, but not Frank.

Typing * tells Filer that the character at
that position and all subsequent characters
should match. Typing a* would find any
word that begins with "a". Typing *ank
would find any word at all, because the
first character is *, meaning that any num
ber of characters of any type should match.

When you finish, move the marker out of
this section of the dialog box. The value you
entered appears in the Find all records
in which: section of the dialog box.

To specify more criteria for your records to
meet, push one of the three remaining radio
buttons in the Find all records in

which: section. Specify as many as four
separate criteria to limit the records you'll
see.

Select the CLEAR button to clear the box of

the information you set up so that you can
begin again. Selecting CLEAR and then leav
ing the dialog box blank displays all the
records in a file.

Select OK to put the criteria into effect and
begin displaying records or setting up the
report. Select the CANCEL button to cancel
the criteria you established and keep any
criteria that existed when you first dis
played this dialog box.

Sort... This option enables you to decide the order
in which your records appear when you dis
play or change them. When you choose this
option, you see this dialog box:
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Mel
AMOUllt;
ONanization
Heihod of Pa
Receipt?

One section of the dialog box is a group of
radio buttons and blank lines. The top radio
button by the first line indicates the first
priority by wbicb Filer will sort records.
Push the radio button for the priority to
wbicb you want to assign a field.

The FIELDS list box in the left of the win

dow lets you scroll through a list of all field
labels in the file. The information in these

fields then determines the order in wbicb

your records will appear when you display/
change them or use them in a report. Scroll
through the list using the arrow keys or the
scrolling arrow icons in the title line of the
list box. Mark a field to wbicb you want to
assign a priority. You can assign five priori
ties for sorting purposes. Filer then sorts
the records in ascending order, according to
the priorities you set. To assign a priority to
a field, mark the field in the list box, and
then move the marker out of the list box.

The field label appears in the Order section
of the dialog box, in the blank next to the
radio button you pushed.
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When you finish assigning priorities, select
the OK button to put the sort order you
established into efifect. To clear the dialog
box of the information you established,
select the CLEAR button. Clearing the box
and leaving it blank displays your records
in the order in which you added or updated
them. To cancel new priorities without
changing the ones previously used, select
the CANCEL button.

The Field Menu. This menu is for your use when you are set
ting up a record or report format. Use the Field Menu after
youVe chosen the Define layout option from the Records Menu
or the Define option from the Report Menu. To pull down the
Field Menu, press I alt I [f], and use the Q arrow key to reach the
menu, or point to the menu name, and press and hold the button.
The Field Menu options are:

Add... This option lets you add a field when defin
ing a record format or a report format. Per
sonal DeskMate adds the field at the
marker's current position on the screen. To
add a field to a record format, position the
marker where you want the field to appear.
Then, choose this option.

Drag the marker, using the arrow keys or
the pointing device, to the position at which
you want the field to end. After you define
the size of the field, press I enter I or release
the button. A dialog box appears.

Type an identifying label you want the field
to have at the Label: prompt. The label
must contain 20 or fewer characters.

In the Outlined section, select a radio but
ton to specify whether or not you want the
field to appear with a box drawn around it.

In the Data Type section, select the radio
button to specify whether information in
this field will be text (alphanumeric charac
ters) or numbers (numeric characters only—
0-9, +, and -).
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In the Label section, select a radio button
to specify whether you want the field label
to appear to the left of the actual field, just
above the field, or not at all.

When you complete this dialog box, select
the DK button to proceed with the field crea
tion. Select CANCEL to cancel creation of the

field. %u return to the screen you were pre
viously using.

To add a field to a report format, position
the marker in the BODY section of the report
format screen, and choose this menu option.

Scroll through the FIELDS list box to find
the label of the field whose information you
want to list on the report. Use the arrow
keys or the scrolling arrow icons in the list
box's title line. When you mark the field
you want to include on the report, move the
marker out of the list box. (You can also
t5^e a field label directly into the edit field
rather than searching for it in the list box.)

Filer checks to see whether the position at
which you want to place the field actually
contains enough space to hold the field's
information. If the field is too large to fit at
the position you chose, a message tells you
so.

To reposition the field on the report, select
the ND button, and add the field at a differ
ent location in the BODY section. To keep the
field at its current location and drop any
characters that do not fit in the space allot
ted, select the YES button. You return to the
report format screen.
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Change... This option lets you change the attributes
you originally set up for a field when you
created it or change the attributes of an
existing summary field in a report format.
First, select the field whose attributes you
want to change. Then, choose this option.
You then see the dialog box that appears
during field creation.

Go through the box, changing any of the
information you like. Select the OK button to
put the changes into effect, or select the
CANCEL button to cancel those changes and
restore the previous information to the
dialog box.

Size Use this option to change the size of an
existing field. First, select the field whose
size you want to modify, and then choose
this option.

A marker appears in the final character
slot of the field. Use the arrow keys, or press
the button and drag the marker until the
field is the size you want. When you finish,
press I ENTER I or release the button.

Caution: If you decrease the size of a field
when you've already set up the format and
added records, your data is truncated to the
new, shorter length.

Format... Use this option to include format characters
in a field. First, select the field you want to
format (either a field on the record format
or a summary field on the report format),
and then choose this option. The marker
appears in the field's first character slot.
Using the arrow keys, move to the character
position at which you want a format charac
ter to appear, and type that character. For
example, you might include (, ), and - as for
mat characters in a phone number field, like
this:

(xxx)xxx-xxxx
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This field would be 13 characters in length.
Remember to plan for format characters
when you decide the size of a field.

When you finish typing format characters
in a field, press I enter |.

The Text Menu. This menu lets you display and print cosmetic
text on your records and reports either plain, boldfaced, or
underlined. Pull down this menu by pressing [liTn (T] or by point
ing to the menu name, then pressing and holding the button. If
you select text before using this menu, only the text you select
uses the attributes you assign. If you don't select text, all subse
quent cosmetic text is affected by the attributes you assign. The
Text Menu options are:

Plain Toggle this switch on to make cosmetic text
appear in a normal fashion on the screen
and print in the standard way your printer
prints text. (Filer automatically assumes
this appearance and printing characteristic.
Use this option to change text that you've
boldfaced or underlined back to normal.)

Bold Toggle this switch on to make cosmetic text
appear and print in boldface. You can use
both bold and underlined text at the same

time.

Underline Use this option to make cosmetic text
appear and print underlined. You can
underline either plain or bold text.

Note: You can print bold or underlined characters on printers
that support bold and underline control codes. If you're
using a dot matrix printer that doesn't support these
codes, you can print in graphic mode to achieve the bold or
underlined effects; however, printing speed is greatly
reduced.

The Report Menu. This menu is for your use in defining report
formats and displaying reports. To pull down the Report Menu,
press I ALT I in, and use the Q arrow key to reach the menu, or
point to the menu name, and press and hold the button.
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First, make a selection from the first two options listed—Def ine
or Display. If you choose Define, pull down the menu again,
and choose one of the remaining four options. Depending upon
the section of the report screen in which you position the
marker, some menu options are not available to you. The Report
Menu options are:

Define This option lets you define the format you
want your reports to follow when you dis
play them. A line appears down the screen
at the column position you designated to be
your right margin in the Page setup's
Printed Line Width setting if the report
is fewer than 80 columns wide.

Display Use this option to display reports. The rec
ords you see on the report are determined
by the criteria you set up using the Find
and Sort options on the Records Menu. Use
the FIRST, PREV, and NEXT buttons to see
corresponding pages of the report. The first
time you want to see the last page of the
report, use NEXT until you reach the last
page. Thereafter, you can use the LAST but
ton. Because the report might be longer
than the screen can display, use the arrow
keys or the scrolling arrow icons to view the
remainder of the current page.

Summary... This option lets you set up a summary field
in the Summary section on the last page of
the report. Choose this option only if you
first chose the Define option from this
menu.

First position the marker where you want
the field to appear. Then choose this option.

Drag the marker, using the arrow keys or
the pointing device, to the position at which
you want the field to end. After you define
the size of the field, press I enter I or release
the button. This dialog box appears:
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OutliTted
dPycsOno

Label
O left# top 9 hidden

FIELDS t

OpgaTiizationl
MM of Paw
Receipt?
CoMRents:

OCount

To answer the Label; prompt, type the
label you wish to appear with the summary
information on the report. To select the field
that you wish to summarize, use the
FIELDS list box that appears at the bottom
left of this dialog box. Scroll through the
list of fields, using the arrow keys or the
scrolling arrow icons in the title line of the
list box. When you mark the field you want
to summarize, move out of the FIELDS list
box.

A summary field does not have to be one
already defined in the Body section. It can
be any field in your record format.

In the Outlined section, press the radio
button that describes the way you want the
summary field to appear—either with or
without a box drawn around it on the
screen.
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In the Label section, press a radio button
to specify whether you want the field's label
to appear to the left of the field, just above
the field, or not at all.

The next group of radio buttons lets you
describe the type of summary you want to
see: a total of numeric data in the chosen
field, an average of the numeric data in the
field, or a count of the number of records
displayed.

When you complete the box, select the DK
button to use the summary field, or select
the CANCEL button to cancel the specifica
tions. Yon return to the report definition
screen.

Y)u can use the Field Menu's Format option
to add format characters to a summary field
you create.

Today's date Use this option to place the system date in
either the HEADER or FOOTER section of a

report format you're defining. Use this
option only if you first choose the Define
option from this menu. Move the marker to
the position at which you want the date to
appear, and then select this option. A
MMM DD, YYYY symbol appears. When you
display the report, the actual date will
appear instead of the symbol.

Page # This option lets you place a page number in
the HEADER or FOOTER section of the report.
Use this option only if you first choose the
Define option from this menu. Move the
marker to the position at which you want
the page number to appear, and then select
this option. A symbol appears. When
you display the report, the actual page
number will appear instead of the symbol.
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Resize section Use this option to change the size of the
section in which the marker is currently
positioned. Choose this option only if you
first choose the Define option from this
menu.

A marker appears in the section. Use the
[T] and [T] keys, or press and hold the but
ton, dragging the pointer. This enlarges or
shrinks the size of the section. As long as
unused, gray space appears at the bottom of
the screen, you can enlarge a section with
out affecting the size of any sections below
it. After all extra space is gone, enlarging a
section shrinks the section immediately
below it. ^u can enlarge a section to the
point that the section below it contains no
space at all, unless the section below con
tains information you've placed on the for
mat. Shrinking a section enlarges the
section immediately beneath it. When you
finish changing a section's size, press I enter I
or release the button. Use the same method

to enlarge/shrink other sections of the
report.

The Index Menu. This menu lets you set up a quick index of
your records, allowing you to browse through a list of informa
tion from fields you select. You can also select a line from the
index and see a complete record. If you don't set up an index.
Personal DeskMate assumes an index list that contains the first

12 characters from each of the first six fields you defined. To pull
down the Index Menu, press I alt I (T), or point to the menu name,
and press and hold the button. The Index Menu options are:

Define... Use this option to define your index format.
When you choose the Define option, you see
this window:
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HaxinuM chaFacters

displayed pep field
anizatiDTi

LalMlilaMj

tonenis

First, decide the number of characters from
each field that you want to display on the
index list. To be sure that you see complete
information if you need it, you can specify
the maximum field length of the longest
field you plan to use in the index. Type your
answer after the prompt. Maximum charac
ters displayed per field.

The next section of the box lets you push a
radio button and enter a field whose infor

mation you want to display on the list. Push
one of the ten buttons, and move the
marker to the FIELDS list box. This list box

lets you find and mark the field. To mark a
field in the list box, use the arrow keys or
the scrolling arrow icons in the title line of
the list box to scroll through the list of
fields. Mark any field you want to include on
the list, and move out of the list box (and
click, if you're using a pointing device) to
place that field in the blank box whose but
ton is pushed.
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Mark as many as ten fields to include in
the index list, pushing radio buttons to add
more fields to the list specification. When
you finish, use one of the three buttons at
the bottom of the dialog box. Selecting
CLEAR clears the dialog box completely of
any information you specified. Selecting OK
creates your index list and immediately dis
plays it. Selecting cancel cancels your
work in the dialog box, returning it to its
previous state. You then return to the
screen you were using.

Display This option lets you display an index list.
(Filer automatically executes this option
after you use the Define option, previously
explained.) When you choose this option,
your list appears on the screen. Use the
FIRST, NEXT, and PREV buttons to see the
corresponding pages of the list if it is more
than one page in length. To see the last
page of £m index list for the first time, use
the NEXT button to reach the page. There
after, you can use the LAST button to see
the page.

Use the up and down arrow keys or the
scrolling arrow icons in the menu bar to
move the marker from line to line.

To display a complete record for any infor
mation on the list, move the marker to any
line and then select the Record Menu's Dis
play or Change option. This enables you to
view or alter the record.
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PAINT

The Paint application enables you to create original art on the
screen using as many as ten colors and 15 patterns. You can
draw lines, shapes, and freehand art, filling different parts of
the screen with colors or patterns, and even inserting text char
acters wherever you like. You can print the masterpieces you cre
ate if you're using a graphics printer.

Paint uses a high-resolution canvas of 640 x 200 pixels. A pixel
is a unit of resolution on the screen. Thus, the canvas has 640
units across and 200 units down.

The Paint Screen

After you access the Paint application, you see a screen that is,
for the most part, blank. If you opened an existing file, you see
the picture stored in that file.

The screen contains a title bar that gives you access to the
Accessory Menu, the application's title and your file title (if you
opened an existing file), and a question mark icon for access to
help information about the Paint application.

Below the title bar is a menu bar that gives you access to the
File Menu, Edit Menu, Text Menu, and Options Menu.

Along the left side of the screen is the palette of tools you can
use in creating pictures. Along the bottom of the screen are the
several colors and patterns from which you can choose while
painting.

The majority of the screen is your canvas. The art you create
appears on this canvas.

Using Paint

To begin painting, choose a tool and a color or pattern. (Use the
Accessory Menu's Color option to choose the four principal colors
you want to use for this picture.) The Options Menu lets you
choose the width of lines you draw and/or the type of brush
stroke you want to use. You can use the Text Menu to alter the
way you want text characters to appear in the picture—plain,
underlined, or in different colors.
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The Edit Menu enables you to erase entire pictures, "undo" the
last change you made to a picture, flip pictures horizontally or
vertically, and move, copy, or clear parts of the picture.

The features available to you as you paint are explained in detail
in the remainder of this chapter.

Using the Keyboard to Draw. If you're using a pointing device
with Personal DeskMate, you cannot use the keyboard to move
the marker on the canvas. To use the keyboard for drawing, first
position the marker at the location where you want to start. Use
the arrow keys to move the marker in the appropriate direction.
In addition, use these key combinations to move the marker
diagonally:

I ALT I in Moves the marker diagonally up and to the right

I ALT I n Moves the marker diagonally down and to the right

I ALT I n Moves the marker diagonally down and to the left

I ALT I n Moves the marker diagonally up and to the left

You can also position the marker by typing a number and then
pressing an arrow key (when moving the marker directly up,
down, right, or left). For example, you can type 20 Q to move
the marker to the right 20 pixels.

To use a tool, press the space bar. Press it again to lift the tool
from the canvas. The same keyboard techniques used in posi
tioning the marker also apply when drawing.

Using the Pointing Device to Draw. To use a pointing device
to draw, move the pointer to the location at which you want to
begin drawing, and press and hold the button. Drag the pointer
in the direction in which you want to draw, and release the but
ton when you finish drawing the line or shape.

The Title Bar

The title bar lets you display the Accessory Menu via the Tandy
icon, shows you the name of the application (Paint) and the name
of the picture currently on the screen ("untitled" if the file is one
you just created), and gives you access to help information avail
able for the application via the question mark icon.

The Accessory Menu. Detailed explanations of the options on
the Accessory Menu are described in Chapter 13, "Accessories."
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The Help Windows. To view help windows for the application,
select the question mark icon. Help windows are explained in
Chapter 11, "General Information and Concepts."

The Menu Bar

The Menu Bar gives you access to the four menus you can use in
the Paint application: The File Menu, the Edit Menu, the Text
Menu, and the Options Menu.

The File Menu. Detailed explanations of the options on this
menu are in Chapter 11, "General Information and Concepts."
Following is a brief description of the Print option as it applies
in this application.

Print This option prints your picture automati
cally. There is no Page setup option to let
you define the way you want the printed
output to look. While printing, you can
press I Esc I to stop. When you stop, or when
the picture finishes printing, you return to
your picture on the screen.

The Edit Menu. This menu gives you the means to restore the
picture to the state it was in previous to the last change; erase a
complete picture and start over; cut, copy, paste, and clear
selected parts of the picture; and flip selected parts of a picture
either horizontally or vertically. First, select the portion of the
screen you want to manipulate, and then display the menu. (To
select portions of the screen, use the Select tool, described later
in this chapter.)

Detailed explanations of most of the options on this menu are in
Chapter 11, "General Information and Concepts." Following are
brief descriptions of the standard options as well as detailed
descriptions of the Undo, Erase, Flip horizontal, and Flip
vertical options.

Undo Use this option to "undo" any changes you
made to a picture since the last time you
used a tool on the canvas or an Edit Menu

option (excluding Undo). When you choose
Undo, the screen returns to its previous
state.
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Erase Choosing this option causes the screen to
clear, displaying only the current back
ground color you're using.

Cut (or (7^) Use this option to remove a selected area
from the screen and place it on the clip
board. (You can generally place as much as
Vi of a picture on the clipboard.)

Copy (or [f^) Use this option to place a selected area on
the clipboard without removing it from its
current position on the screen.

Paste (or IF10 I) This option takes information currently on
the clipboard and pastes it onto the screen.
A box borders the pasted information. With
a pointing device, you can press and hold
the button while the marker is inside the

box. Drag the marker wherever you want
the pasted information to appear on the
canvas. The box moves with the marker.

Complete the moving process by releasing
the button and then clicking outside the
box, which disappears.

With the keyboard, you can press the space
bar while the marker is inside the box. Use

the arrow keys to move the marker wher
ever you want the pasted information to
appear on the canvas. The box moves with
the marker. Complete the moving process
by pressing the space bar and then pressing
it again after moving the marker outside
the box.

Clear Use this option to delete a selected area
from the picture. When you use this option,
the selected area does not move to the clip
board but is completely erased from the
screen.

Flip horizontal This option "flips" the selected area left to
right and displays the flipped area in the
location the original previously occupied.
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Flip vertical This option "flips" the selected area top to
bottom and displays the flipped area in the
location the original previously occupied.

The Text Menu. Use this menu when you want to define the
appearance of text characters in a picture. First, use this menu
to define the way you want the text to look. Next, choose the
Text tool (described later in this chapter). Finally, type the text
in the location you want. Type only one line of text at a time,
and then press [ enter |. After you press ENTER, you can reposition
the marker at another location and press the space bar or click
to type another line of text. The Text Menu options are:

Underline Use this option to make text appear
underlined.

Color Use this option to make the selected text
appear in one of four colors.

Push the radio button for the color you want
the text to be on the canvas. Select the DK
button to put the color choice into effect, or
select the CANCEL button to cancel color

selection.

The Options Menu. This menu gives you the means of choosing
the width and color of lines you draw, choosing the different size
and shape brushes with which you can paint, and changing the
patterns that appear across the bottom of the screen. The options
on this menu are:

Line... Choose this option to define the weight, or
width, of a line you want to use while
drawing.

In the top section of the dialog box, push
the radio button for the line width you want
to use. The last width (the dotted line) is
an "invisible" line. Use this width to draw

solid circles or solid squares. These shapes
are the last two tools displayed down the
left of the screen. The invisible line assures
that only the shape will appear, not the
shape plus an "outline" around it.
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Brush..

Edit pattern..

In the lower section of the box, push the
radio button for the color you want to use in
drawing the line(s). (Color, of course, will
not be apparent when you use the invisible
line width.)

Select the OK button to put the line width
and color definitions into effect. Select the
CANCEL button to cancel changing the line
width and color. You return to your picture.

Use this option to choose from 20 sizes and
shapes with which you can use the brush
tool.

Push the radio button for the brush shape
you want to use. Select the OK button to use
the brush you chose, or select the CANCEL
button to cancel brush selection.

This option lets you change the appearance
of any pattern displayed along the bottom of
the screen. First, select the pattern you
want to change. Then, choose this option.
Depending upon the resolution of the pat
tern you selected (the amount of detail the
pattern can use), one of two windows
appears.

The Pattern: section of the window shows

you the pattern as it looks in actual size.
You'll see the pattern change in this section
as you redesign it.

The grid is for your actual design work.
Push one of the color buttons in the Color:

section of the box, and move the marker to
the grid. Position the marker on the square
you want to be that color, and then click, or
press the space bar. The square becomes
the color you chose.
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Use the color on any number of squares you
like, and change colors as often as you like.
When you finish designing the new pattern,
select the OK button to store the new pat
tern and place it in the colors and patterns
choices on the screen. The new pattern
takes the place of the pattern that previ
ously occupied the position. Select the
CANCEL button to cancel designing the pat
tern and return to the screen.

The Tools

Paint lets you use 14 tools to help you draw your picture. The
tools appear at the left margin of the screen. To select a tool,
point to the appropriate tool and click. With the keyboard, use
fWl (or I SHIFI I TAB I) to reach the tools. (I tab I moves you clockwise
from the canvas, to the colors and patterns, to the tools, and
back to the canvas. | shift | I tab | moves you counterclockwise.)
Once in the tool section, use the arrow keys to mark the tool you
want to use, and then press the space bar to select it.

The tools you can use are:

Select Use this tool to select a portion of the pic
ture. To select portions of the picture, follow
the instructions below.

With a pointing device, move the marker to
one corner of the area you want to select.
Then, press and hold the button to drag the
rectangle to the size you want. Release the
button to finish.

With the keyboard, move the marker to one
corner of the area you want to select. Press
the space bar, and then move the marker to
drag the rectangle to the size you want.
Press the space bar again to finish.
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Zoom

Text

Once you select an area, you can use the
Edit Menu options or move the selected area
to another part of the canvas. To move the
selected area via a pointing device, press
and hold the button while the marker is
inside the box. Drag the marker wherever
you want the selected information to appear
on the canvas. The box moves with the
marker. Complete the moving process by
releasing the button and then choosing
another tool.

To move a selected area via the keyboard,
press the space bar while the marker is
inside the box. Use the arrow keys to move
the marker wherever you want the selected
information to appear on the canvas. The
box moves with the marker. Complete the
moving process by pressing the space bar
and then choosing another tool after moving
the marker outside the box.

This tool enables you to enlarge a section of
the screen so that you can perform detailed
work on it. After choosing this tool, position
the box over the area you want to view more
closely. Then, click, or press the space bar.
"Vbu then see a magnified replica of the area
you chose as well as the original area. Each
small box represents one pixel on the can
vas. Move the marker to a box, and click or
press the space bar to change the color of
that box to the current color. The original
area shows the color change as well. To
redisplay the original picture, select the DK
button. Selecting CANCEL cancels the bit
changes and returns you to your picture.

Choose this tool when you want to place
text characters on the picture. (The Text
Menu lets you define the way you want the
text to appear.) Then, type the text. The
background color of any text you type will
be the color of the canvas.
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This tool erases any pixels over which it
passes when you have the eraser on the can
vas. Choose this tool, and then erase as
small or large a portion as you like.

Use this tool to draw thin lines on the

screen. The width of the line remains the

same, no matter which line width you've
chosen on the Options Menu.

Choose this tool when you want to paint
with brush strokes. Use the Options Menu
to define the type of brush stroke you want
to use.

This tool lets you fill in a part of the screen
enclosed by other lines or brush strokes
with colors or patterns.

Spray can

This tool lets you draw straight lines using
the current line width and line color (from
the Line option on the Options Menu). With
a pointing device, move the marker to one
end-point of the line, and press and hold the
button. Drag the pointer to the other end-
point, and release the button to complete
the line.

With the keyboard, move the marker to one
end-point of the line, and press the space
bar. Move the marker to the other end-

point, and press the space bar again to com
plete the line.

Use this tool to achieve a spray-painted
effect. The tool lets you spray the current
color or pattern on the screen using the cur
rent pattern.



DeskMate Reference

Circle

Square

Polyline

This tool draws circles, using the current
line width and line color (from the Line
option on the Options Menu). With a point
ing device, position the marker at the center
of the desired circle location. Press and hold

the button, and drag the circle to the size
you want. When you finish, release the hut-
ton, and the outline of a circle appears.

With the keyboard, position the marker at
the center of the desired circle location.

Press the space bar, and drag the circle to
the size you want. When you finish, press
the space bar again, and the outline of a
circle appears.

Use this tool to draw squares and rectan
gles, using the current line width and line
color (from the Line option on the Options
Menu). With the pointing device, move the
marker to one corner of the desired square
location. Press and hold the button, and
drag the square to the size you want. When
you finish, release the button, and the out
line of a square (or rectangle) appears.

With the keyboard, position the marker at
one corner of the desired square location.
Press the space bar, and drag the square to
the size you want. When you finish, press
the space bar again, and the outline of a
square (or rectangle) appears.

This tool takes a line you've drawn, using
the current line width and line color (from
the Line option on the Options Menu), and
then connects the two end-points to produce
an enclosed shape. With a pointing device,
move to one end-point of the line, and press
and hold the button. Draw the line, and
release the button at the other end-point.
Paint automatically draws a straight con
necting line to both end-points.



Solid Circle

Solid Square

With the keyboard, move the marker to one
end-point of the line, and press the space
bar. Draw the line, and press the space bar
again at the other end-point. Paint auto
matically draws a straight connecting line
to both end-points.

This tool draws a circle and fills it with the

current color or pattern. The finished circle
is outlined in the current line width and

line color (from the Line option on the
Options Menu). With a pointing device,
position the marker at the center of the
desired circle location. Press and hold the

button, and drag the circle to the size you
want. When you finish, release the button,
and the circle appears.

With the keyboard, position the marker at
the center of the desired circle location.

Press the space bar, and drag the circle to
the size you want. When you finish, press
the space bar again, and the circle appears.

Choose this tool to draw a square or rectan
gle and fill it with the current color or pat
tern. The finished square is outlined in the
current line width and line color (from the
Line option on the Options Menu). With the
pointing device, move the marker to one cor
ner of the desired square location. Press
and hold the button, and drag the square to
the size you want. When you finish, release
the button, and the square (or rectangle)
appears.

With the keyboard, position the marker at
one corner of the desired square location.
Press the space bar, and drag the square to
the size you want. When you finish, press
the space bar again, and the square (or rec
tangle) appears.
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The Colors and Patterns

Paint lets you choose your four primary colors by using the
Color accessory on the Accessory Menu. Once you choose the
four colors, they appear along the bottom of the screen as the
first four color choices. The next six colors are combinations of

the primary four.

Following the colors on this line are the patterns you can use.
You can use the patterns as they are, or you can edit them by
using the Edit pattern option on the Options Menu.

The colors and patterns are for use with the brush, fill, spray
can, solid circle, and solid square tools. To select a color or pat
tern, simply point and click on the color/pattern you want to use,
or use I TAB I to reach the bottom line of the screen, and then use
the arrow keys to reach the color/pattern you want to use. Press
the space bar to select the color.
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CALENDAR

The Calendar application enables you to set up and revise your
schedule and to see or print calendars of several types in several
formats. You can schedule and display events and dates that
range from January 1, 1980, through December 31, 2040.

The Calendar Screen

After you access the Calendar application, you see a screen simi
lar to the following:

|Q March 2, 1987 Calendar - (Untitled) 11:13 aw

File 1 Edit! Search IBisplaa

NEKIMarch 1987iPliEg

Siindaa Monday Tuesday Wednesday Thursday Friday Saturday

The screen contains a title bar that shows the Tandy icon for
access to the Accessory Menu, the application's title and your
file's name (if you opened an existing file), and a question mark
icon for access to help information about the Calendar
application.
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Below the title bar is a menu bar that gives you access to the
File Menu, Edit Menu, Search Menu, and Display Menu. Also on
the menu bar are up and down arrow icons that enable you to
scroll the screen via a pointing device.

The center section of the screen displays a calendar for the
month you entered when you started up the computer. If you
entered no date when you started up the computer, the screen
displays a monthly calendar for January, 1980. Any major holi
days that fall in the month are marked with a special icon, as
are any days on which you've scheduled events.

Using Calendar
To see a list of events for a specific day, use the Display Menu
(explained later in this chapter) to display the daily event list.
You can add and revise events only on the daily event list. The
weekly, monthly, and yearly calendars are for display and print
ing purposes. The daily event list looks similar to this:

Ilitirsday
flppil I, 1587
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If any holidays fall on this date, they appear at the beginning of
the list. You cannot delete or change holiday information. You
can, however, type or display as many of your own personal
events as you like. To add an event, move the cursor where you
want to begin typing information about the event, and start typ
ing. When you type, you use only insert mode. Each character
you type is inserted at the cursor's position, and any existing
characters move right to accommodate the characters you type.

If the day has more events scheduled than can appear on one
screen, you can see the other events either by using the keys
described in Chapter 11, "General Information and Concepts," or
by pointing to one of the arrow icons in the menu bar. Point to
an arrow and click to scroll the screen one line at a time, or
point to an arrow and press and hold the button to scroll the
screen several lines at a time.

To review several daily event lists, you can select the Prev but
ton. To see the next day's events, select the Next button.

The other features available to you as you use the Calendar
application are explained in the remainder of this chapter.

The Title Bar

The title bar lets you display the Accessory Menu via the Tandy
icon, shows you the name of the application (Calendar) and the
name of the file currently on the screen ("untitled" if the file is
one you just created), and gives you access to any help windows
available for the application via the question mark icon.

The Accessory Menu. To see the Accessory Menu, select the
Tandy icon. Detailed explanations of the accessories are in Chap
ter 13, "Accessories."

The Help Windows. To view help windows for the application,
select the question mark icon. Help windows are explained in
Chapter 11, "General Information and Concepts."

The Menu Bar

The Menu Bar gives you access to the four menus you can use in
the Calendar application: the File Menu, the Edit Menu, the
Search Menu, and the Display Menu.
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The File Menu. The File Menu lets you perform functions
related to the file as a whole. Detailed explanations of the
options on this menu are in Chapter 11, "General Information
and Concepts."

The Edit Menu. This menu gives you the means to move, copy,
and delete selected characters/events on a daily event list. First,
select the information you want to manipulate, and then display
the menu. (Because you are always in insert mode, no character
is selected until you actively select it.)

Detailed explanations of the options on this menu sire in Chapter
11, "General Information and Concepts."

The Search Menu. This menu enables you to find a string of
characters in your file or find information for a specific date. The
Search Menu options are:

Find... Use this option to locate an occurrence of a
text string throughout all daily event lists
in the file.

At the Search for: prompt, ts^pe between
the brackets the string of alphanumeric
characters you want to find.

At the Start date: prompt, you See the
date on which the first scheduled event in
this file occurs. To begin the search at the
date displayed at this prompt, move the
marker to the End date: prompt. To
change the date, use the standard editing
methods discussed in Chapter 11.

At the End date: prompt, you see the date
on which the final scheduled event in this
file occurs. To change the date, follow the
same procedure as that used in changing
the Start date.

Select OK to carry out the option or CANCEL
to cancel the option and return to the
screen you were using.
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If you select DK, Calendar starts searching
at the date you specified. If Calendar finds
the string, the daily event list containing
the first occurrence of the string appears,
and Calendar positions the cursor at the
beginning of the string. If it cannot find the
string. Calendar displays this message—
Search string not found. Select the OK
button to continue working with the file.

Find next Use this option to locate subsequent occur
rences of a string you specified using the
Find option. Simply select this option, and
the daily event list containing the next
occurrence of the string appears.

Find date... Use this option to display events for a par
ticular date or a calendar that contains a
particular date.

At the Date: prompt, tjqie the date in mm/
dd/yyyy format that you want to display.
Then, select OK to carry out the Find date
option, or select CANCEL to cancel the option
and return to the screen you were using.

If you chose the option from a daily event
list, a daily event list for the date you speci
fied appears. If you chose the option from a
weekly, monthly, or yearly calendar display,
the corresponding type of calendar that con
tains the date you specified appears.

229



DeskMate Reference

The Display Menu. This menu enables you to display either a
daily event list, a weekly calendar, a monthly calendeir, or a
yearly calendar. First, mark the date for which you wish to dis
play one of thie calendar tj^es. Then, select the Display Menu.
%u can add and revise events only on the daily event list. The
weekly, monthly, and yearly calendars are for display and print
ing purposes. The Display Menu options are:

Daily

Weekly

Monthly

Use this option from the weekly, monthly,
or yearly calendar screens to display the
daily event list for the marked day. When
you choose this option, the screen displays
the appropriate daily event list for your
review. Select the PREV button to see pre
vious daily event lists. Select the NEXT W-
ton to see subsequent daily event lists.

Use this option from the daily, monthly, or
yearly calendar screens to display a weekly
calendar for the week in which the marked
day falls.

Select the PREV button to see the calendar
for the previous week, or select the NEXT
button to see the calendar for the next
week.

■feu can display a daily event list for any
day in the displayed week by moving the
marker to the appropriate day and pressing
I ENTER I or double clicking.
Use this option from the daily, weekly, or
yearly screens to display a monthly calendar
for the month in which the marked day
falls.

Select the PREV button to see the calendar
for the previous month. Select the NEXT but
ton to see the calendar for the next month.

To display a daily event list for a day in the
displayed month, move the meirker to the
appropriate day, and press | enter I or double
click.
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■pearly Use this option from the daily, weekly, or
monthly screens to display a calendar for
the year in which the marked day falls.
Select the PREV button to see the calendar
for the previous year, or select the NEXT but
ton to see the calendar for the next year.

You can display a monthly calendar from
this screen by moving the marker to the
appropriate month and pressing I enter I or
double clicking.
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TELECOM

The Telecom application enables your computer to communicate
with other computers either through a direct connection (via
cable) or through a modem. Using Telecom, you can access bulle
tin hoard systems, news and information services, and other host
systems. You can set up files that, if you have an autodial
modem, automatically call and connect to the other system. Tele
com also lets you transfer files to and from other systems and
"capture" information you receive in a buffer, saving it on disk
for other use or review whenever you want.

Before you use Telecom, be sure to use the Communications
accessory to define your modem for Personal DeskMate.

The Telecom Opening Screen
After you access Telecom from the desktop, you see the command
screen. (If you opened an existing autolog file, you see the com
mands and parameters already defined.)

The screen contains a title bar that gives you access to the
Accessory Menu, the application's title and your autolog file title
(if you opened an existing autolog file), and a question mark icon
for access to help windows about the Telecom application.

Below the title bar is a menu bar that lets you access the four
menus that Telecom uses; the File Menu, the Commands Menu,
the Buffer Menu, and the Options Menu.

Using Telecom
Throughout the chapter, you'll see the word "host" used to refer
to the computer with which you communicate. To use Telecom,
you need to be familiar with four basic steps:

1. You must establish the communications parameters (or set
tings) required by the host. Do this by using the command
screen. Use the Set command on the Commands Menu
(explained later) to set communications parameters.
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2. 15)ur next step is to call the host computer. (If you are
directly connected to the host via a cable, skip this step.) If
you have an autodial modem, use the Call command on
the Commands Menu (after selecting the appropriate
modem via the Communication accessory). If your Tnodftm
doesn't automatically dial for you, dial the host's telephone
number with your telephone, wait for a high-pitched sound
that means you are connected, and then go on to the next
step.

3. Execute the commands issued in the first two steps, and
move to the terminal screen by using the Execute com
mand from the Commands Menu. If you dialed the host
with your telephone, place the handset in its cradle now (or
in the acoustic coupler). %u can now communicate with the
host by typing on the keyboard to send information to the
host and reading information sent by the host on your
screen.

4. When you finish, disconnect by returning to the command
screen. (Press I alt I (3, and use the DisconTiect command
on the Options Menu.)

Calling Again. Once you set the communications parameters
and Execute the Set command, the parameters are stored in
memory, and you can use them the next time you move to the
terminal screen. You can, then, go directly to the terminal
screen by using the Terminal command on the Options Menu if
you don't need to change the settings.

Autolog Files. Y)u might want to communicate with several
hosts that have different communications parameters and differ
ent phone numbers. Many times, the initial part of the commu
nication session is the same. Personal Deskl^te lets you save
the initial peu^; of the session in a file called an autolog file so
that you can later run this file to establish a connection with a
particular host. "Vbu must be using an autodial modem to use
this feature.
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The commands screen actually enables you to build autologin
files and execute tbem. When you select one of the commands,
Set, Call, Wait, or Send, from the Commemds Menu, you're
actually obanging the ciurent line of an autolog file. %u can
position the marker on any line in the file. The Execute com
mand performs, or executes, the ctirrent file and then takes you
to the terminal screen, where a small box shows you the prog
ress of the dialing process. The results of the autolog Send and
Wait commands appear on the terminal screen. You can cancel
the operation while the box is on the screen by pressing IESC I.
After the autolog process is complete, start typing on your key
board to communicate with the host.

You can save the current autolog file by using the Save or Save
as commands on the File Menu. Review or change the file by
using the Open command.

The Terminal Screen. When you are displaying the terminal
screen. Personal DeskMate acts in a different way from the way
it usually does. For instance, you see no title bar or menu bar.
When you press a key, you send the corresponding ASCII code to
the host. If your host requires a control code, you can send that
code by using the | Ctrl | key in combination with the appropriate
second key. For example, pressing I ctrl I [T) sends the ASCII code
10 (a linefeed) to the host. Documentation you get from the host
commonly refers to these codes with the symbol """, that is, "J
for the code produced by pressing I ctrl I (T|.

You can toggle the buffer on or off at this screen by using I alt I
[§]. When on, the words Buffer ON appear on the bottom line of
the terminal screen while the buffer collects information. Y)u
can collect at least 20,000 characters in the buffer.

Return to the command screen at any time by pressing I alt I O-
This lets you issue commands to Personal DeskMate without
interrupting your communication session.

Details about all the procedures discussed above are explained
in the remainder of this chapter.
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The Title Bar

The title bar lets you display the Accessory Menu via the Tandy
icon, shows you the name of the application (Telecom) and the
name of the autolog file currently on the screen ("Untitled" if the
file is one you are creating and haven't yet saved), and gives you
access to help information via the question mark icon.

The Accessory Menu. Detailed explanations of the options on
the Accessory Menu are in Chapter 13, "Accessories." Pull down
the Accessory Menu only from the command screen, and only
when you are not communicating with a host.

The Help Windows. To view help windows for Telecom, choose
the question mark icon. Help windows are explained in Chapter
11, "General Information and Concepts."

The Menu Bar

The Menu Bar gives you access to the four menus you can use in
Telecom: the File Menu, the Commands Menu, the Buffer Menu,
and the Options Menu.

The File Menu. The File Menu lets you perform functions
related to an autolog file. To see the File Menu, press [altI [f],
or point to the menu name, and press and hold the button.

Detailed explanations of most of the options on this menu are in
Chapter 11, "General Information and Concepts." Following are
brief descriptions of the standard options as well as a detailed
explanation of the Run option.

New This option clears from the memory any
existing autolog file to enable you to begin
working with a new, untitled file.

Run... Use this option to load and execute (run) an
existing autolog file. When you choose this
option, a dialog box asks you to confirm a
filename. Then, Personal DeskMate loads
the file and executes it. See the description
of the Execute command for further
details.

Open... Use this option to open an existing autolog
file, replacing any previously displayed file
on the screen.
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Save This option lets you store an existing auto-
log file using the filename that appears in
the title bar. Telecom saves the file, includ
ing any changes you might have made, and
continues to display the screen you were
using.

Save as... This option lets you make a duplicate of the
currently displayed autolog file and store it
on diskette under a filename different from
the one displayed in the title bar (or, if the
file is new, with a name you supply).

Print... This option prints the currently displayed
autolog file in text mode, portrait format.

Quit Use this option to exit the Telecom applica
tion. When you choose Quit, a message box
asks whether or not you wish to disconnect
the device. Whether you're using a modem
or a direct connection, select the YES button
to clear reserved memory necessary for run
ning other applications and exit Telecom.
Select NO to exit Telecom without freeing
the reserved memory. Select CANCEL to can
cel exiting Telecom.

The Commands Menu. The Commands Menu enables you to
set up an autolog file to use in conjunction with your autodial
modem. Once you set up a file, you can tell Personal DeskMate
to use it for automatically dialing and connecting to the other
system.

To pull down the Commands Menu, press I alt I 0, or point to the
menu name, and press and hold the button.

The first four commands on the menu are for your use in setting
up the autolog file. First, use the Set command. Then, use the
other commands in the order required by your host to develop an
autolog file that will properly connect you to the host. You can
repeat the Send, Call, and Nait commands a number of times.
Yom can repeat the Set command, but the need for repeating this
command is uncommon.
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The next two options let you add or delete commands youVe
already set up. The last option lets you execute the autolog file
and move to the terminal screen, where you can actually com
municate with the other system. Note that the commands have
no effect until you use the Execute command.

The Commands Menu commands are:

Set., Use this option to tell Telecom about the
status of the communication line by estab
lishing parameters such as baud rate, word
length, parity, and so on. As you develop an
autolog file, the Set option is the first one
you'll want to use. When you choose this
option, you see:

Set CoMMinications ParaHeters

Baud
9 3(98 9 608 01288
924(98 94888 99688

Hoi>d Length # 7 bits O 8 bits
Parity Even 9 Odd O None
Stop Bits O 1 9 2
FIoh control (Eon/Xoff) O On 9 Off

cii filter
elf ecin
Add line feed
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In the first section of the box, entitled Baud,
push one of the radio buttons to tell Telecom
how fast to transmit information to the

other system. The higher the baud rate, the
faster the transmission. If you use an exter
nal modem or an internal modem card,
choose the baud rate that your modem can
use. The other computer must also use this
same baud rate. If you use a direct cable
connection, you can use any baud rate as
long as the other computer also uses the
same rate. You might not be able to commu
nicate reliably at baud rates exceeding 1200
unless your computer and its host use flow
control. (See the explanation of flow control,
later in this chapter.)

The next group of prompts lets you give
Telecom technical information that tells it
how to code the information it transmits to

and receives from the other computer.

At Word Length, push the radio button for
either 7 bits or 8 bits. At Parity, push one
of the buttons for Even, Odd, or None. At
stop Bits, push the button for either 1 or
2. The correct choices for these options are
usually dictated by the host. Most com
puters use one of the following
combinations:

8-bit word size 7-bit word size

no parity even parity
1 stop bit 1 stop bit
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At Flow Control (Xon/Xoff), push
either the On or Off button. If you turn on
Flow Control, transmission to the other
system stops when it sends an Xoff code.
Transmission resumes when it sends an

Xon code. Telecom sends an Xoff to pause
transmission from the other system when
information is coming in at too fast a rate.
Telecom then sends an Xon to resume

transmission when the buffer can handle

more input. You can use flow control only if
the host uses it as well.

The next section of the dialog box contains
toggle switches for you to turn on or off.
Leaving the ASCII filter switch toggled
on removes all characters above 80 (hexa
decimal) and control characters below 20

(hexadecimal).

Adjust the Self echo switch if you have
problems with displaying characters you
type during transmission. If the characters
you type appear in duplicate, toggle the set
ting off. If, on the other hand, your charac
ters are not displaying at all, toggle the
setting on.

When you finish defining parameters, select
the OK button to put the parameters into
effect and return to the command screen,
which now displays a line containing the
command set and the baud rate, word
length, parity, stop bits, and flow control
parameters.

To cancel setting communication line
parameters, select the CANCEL button. You
return to the command screen.

Call... Use this command to tell Telecom that
when it runs this autolog file, you want it
to dial a number of up to 30 digits.

At the Phone number: prompt, type a tele
phone number of as many as 30 digits.
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Select the OK button to transfer this com

mand to the command screen as part of the
autolog file. Select CANCEL to cancel defin
ing a phone number to dial.

Wait... This command tells Telecom to wait, in an
autolog file execution, for either a string of
characters to be received from the other

system or for a specified number of seconds
to elapse before continuing the autolog file
execution.

Press one of the radio buttons, for either
Wait for string: or Wait for time
period:.

If you choose Wait for string, type the
string of characters you expect to receive
from the other system, and then type the
number of seconds you want Telecom to wait
to receive the specified string. If it does not
receive the string in the number of seconds
you type, Telecom stops running the autolog
file.

If you choose Wait for time period:,
type the number of seconds you want Tele
com to wait before it continues running the
autolog file.

When you finish, select the OK button to
transfer the information to the commands

screen as part of the autolog file. Select
CANCEL to cancel defining the Wait
sequence and return to the command
screen.

Send... Use this option to tell Telecom that, at this
point in the autolog file execution, you want
to send either a string of characters or a
break sequence to the other system.

Push the radio button for either Send

string: or Send break sequence.
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Insert

Delete

Execute

If you choose Send string:, type a maxi
mum of 27 characters you want to send to
the other system. Then, toggle on or off the
Add carriage return setting to either
send a carriage return character after send
ing the string or not.

If you choose Send break sequence, Tele
com will, at this point in executing the
autolog file, send a break sequence to the
other system. Many information services
and other host systems require you to send
a break sequence to gain the attention of
the system's computer.

When you finish, select the OK button to
make this a part of your autolog file and
place the information on the command
screen. Select CANCEL to cancel defining
characters to send and return to the com
mand screen.

This command inserts a blank line before
the current line in your autolog file defini
tion. First, position the marker on the line
that you want. Then, choose the Insert
command. A blank line appears, and the
subsequent lines move down one line.

Use this command to delete an existing line
in your autolog file. Position the marker on
the line you want to delete, and then choose
this command. The line disappears, and the
lines below move up to accommodate the
deletion.

When you finish setting up your autolog
file, use this command to execute (run) the
file. Be sure that your modem is properly
connected and that the switches are set cor
rectly. See your modem manual for
information.
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Telecom performs the commands in the file
and moves ycu to the terminal screen,
where you can monitor the progress of the
dialing process in the small box on the
screen. Press ■ Esc | at any time to end the
dialing process. If you're connected to the
host when you cancel the login process, you
remain connected. If you aren't yet con
nected, press I ALT I to return to the com
mand screen. You can then select the

Execute command again to try the process
again.

The Buffer Menu. This menu gives you access to the terminal
buffer, an area in which you can "capture" characters being
transmitted between your computer and the other system. You
can then save the characters in a file, print or display the con
tents of the buffer, or clear the buffer contents.

When you are connected to and communicating with another
system, you see the terminal screen. To reach the buffer menu
from this screen, press ! alt | This returns you to the com
mand screen, from which you can pull down the Buffer Menu.
Pull down the menu by pressing ! alt I [b] or by pointing to the
menu name and pressing and holding the button. You can return
to the terminal screen by using the Terminal option on the
Options Menu, described later.

The options on this menu are:

Buffer on This switch activated the buffer and lets
you begin capturing characters. Previous
buffer contents are not affected. You can

turn on the buffer from the terminal screen

by pressing I alt I [|]. The words. Buffer ON,
appear on the bottom line of the terminal
screen while the buffer is collecting
information.

Buffer off This switch deactivates the buffer.

Load... This option loads a previously saved ASCII
file into the buffer so that you can display
it, replacing the previous contents of the
buffer.
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Save...

Display

Clear

Print

At the Load file: prompt, either type the
name of an ASCII file you want to load, or
scroll through the FILES list box to mark
the file you want to load. If you use the list
box, mark the file, and then move the
marker out of the box to place your chosen
filename in the Load file: edit field.

Select the OK button to actually load the file
into the buffer. Select CANCEL to cancel

loading the file and redisplay the command
screen.

Use this option to save the contents of the
buffer in a file. The contents remain in the

buffer as well.

At the Save as: prompt, type a name you
want to give the. file, using no more than
eight characters. Telecom supplies the .doc
extension if you don't supply an extension.
The line below the prompt shows you the
current drive and directory you are using
(the location where the file will be stored).

After supplying a filename, select the SAVE
button to save the file.

Select the CANCEL button to cancel saving
the buffer contents and return to the com

mand screen.

Choose this option when you want to display
the current contents of the buffer.

This option clears the current contents of
the buffer. A message asks whether you
want to save the contents or not. Reply by
selecting the appropriate button—YES, NO,
or CANCEL.

Use this option to print the current contents
of the buffer "as is." Be sure that your
printer is properly connected, loaded with
paper, and on line before you choose this
option.
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When you choose Print, Telecom prints the
buffer contents, continuing to display the
command screen.

The Options Menu. The Options Menu enables you to transfer
(send or receive) files between your computer and the host, move
directly to the terminal screen, or disconnect the line.

To pull down the Options Menu, press ! alt I [^, or point to the
menu name, and press and hold the button. The options on this
menu are:

Transfer file... This option lets you send a file to or receive
a file from the other system. When you
choose this option, this dialog box appears:

FMCDEE.HOD
DESK.EKE
FMHENU.FDK
MENUDATfl.IIlN
FHCflLEND.FDH
FHFAINI.FDM

FileTHMe;

a Send
#Receive

oAscii
SKnodeM

9Add line feed after carriaje return
9Stri{) line feed after carriage return
QStraight ascii transfer

tiHeoutlirjl seconds

At the Filename: prompt, either type the
name of the file you want to send or receive,
or scroll through the FILES list box, mark
ing the file you want to transfer. When you
mark the appropriate file, move the marker
out of this section to place the filename in
the F 1 1 ename : edit field.
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Next, press a radio button for either Send or
Receive.

The buttons for X mod em and ASCI I transfer

let you choose between using two file trans
fer protocols. Xmodem is a special protocol
you can use. If you choose Xmodem trans
fer, the other system must also use Xmo
dem protocol. ASCII protocol is for
transferring ASCII characters between the
two computers. (Text application files are
ASCII files if you use the To ASCII option
on a document in the Text application.)
Push the button for the type of protocol you
want to use.

If you choose ASCI I protocol, press one
radio button from the three buttons in the

next group. If you choose Xmodem, the next
group of buttons does not apply to your
transfer.

If you choose Add line feed after car
riage return, Telecom, as it transfers the
file, physically changes it by adding a line
feed each time it sends (or receives) a car
riage return character. Personal DeskMate
and most MS-DOS text files contain both a

carriage return and a line feed at the end
of each line.

If you choose Strip line feed after
carriage return, Telecom takes out line
feeds after carriage return characters. This
results in a carriage return separating text
file lines just as though they were typed on
a keyboard.

If you choose Straight ASCII transfer,
Telecom strips all non-ASCII codes from the
file being transferred. In addition, pressing
this button tells Telecom to automatically
end the transfer and close the transferred

file when it sends or receives an end-of-file
character (lA hexadecimal).
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Terminal

Disconnect

The Timeout: prompt offers you one way of
closing a file and ending a transfer. Type a
number of seconds that you want Telecom to
wait without sending/receiving any charac
ters before it closes the file. If, during the
transfer, the specified time elapses without
Telecom receiving/sending an end-of-file
character, the file closes.

When you finish setting up the transfer
information, select the OK button to begin
the transfer, using the settings you chose. If
you are receiving a file and chose ASCII
protocol, you can use the keyboard to signal
the remote computer that it can begin the
transfer.

While transferring in Xmodem, a transfer
progress window appears. Selecting the
CANCEL button cancels the transfer. (Note
that a pointing device is deactivated during
a transfer, so you must press [1^ to select
the CANCEL button.)

Select the CANCEL button in the transfer
information window to return to the com

mand screen without transferring a file.

This option displays the terminal screen
without executing an autolog file, unlike
the File Menu's Run option or the Com
mands Menu's Execute option. Use this
option to return to the terminal screen dur
ing communication after you use a Buffer
Menu or Options Menu option.

Use this option to disconnect the telephone
line after you finish communications with
the other system. When you choose the
option, the line automatically disconnects.
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Appendix A

PUTTING APPLICATIONS ON
SEPARATE DISKETTES

If you follow the instructions under "Installing Personal Desk-
Mate" in Chapters 2 or 11, you gain more storage space on
diskettes by creating ones that contain fewer applications. After
you perform the installation, you can further reduce the number
of files on the three (or four) diskettes to gain even more storage
space.

First, format a few diskettes, as many as you need for separating
the applications you want onto separate diskettes. Then, you can
use the MS-DOS COPY command to transfer files from your
working Personal DeskMate diskettes onto the newly formatted
ones.

As you format the diskettes, you can include the Is option. This
option transfers enough of the operating system onto the diskette
to start up the computer (ask for the date and time, display the
system prompt, and a few other functions). You can also transfer
your other system files, such as CONFIG.SYS, onto the
diskettes. For instructions on using this option and on using the
COPY command, see Introduction to MS-DOS. Note that using
the /s option reduces diskette storage space by approximately
40,000 bytes.

The files necessary for running Personal DeskMate are:

DESK.EXE the program that loads Per
sonal DeskMate

PMMENU.PDM the program file for the
Tandy Desktop

PMCORE.MOD the program that executes
all Personal DeskMate
functions

You can put these files on each diskette or on only one diskette.
If you put the PMMENU.PDM file on a diskette, you reduce that
diskette's storage capacity by approximately 50,000 bytes. Plac
ing the PMMENU.PDM file on a diskette lessens the number of
times you'll need to swap diskettes as you run Personal
DeskMate.
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On the diskette(s) containing PMMENU.PDM, you can copy
these files from your MS-DOS diskette to make running Per
sonal DeskMate smoother and easier:

FORMAT.COM

DISKCOPY.COM

COMMAND.COM

the program that formats
diskettes

the program that copies
diskettes

the program that lets you
exit Personal DeskMate and

move to the operating sys
tem level without switching
diskettes (already on the
diskette if you used the /s
option)

The application files you can copy onto your diskettes are:

PMTEXT.PDM

PMWORK.PDM

PMFILER.PDM

PMPAINT.PDM

PMCALEND.PDM

PMTELCOM.PDM

Text

Worksheet

Filer

Paint

Calendar

Telecom

The accessories you can copy onto your diskettes are:

PMHELP.ACC

PMPHONE.ACC

Help
Phone List

PMACCESS.ACC

Note Pad

Calendar

Clipboard
Color

Communication

Date and Time

Mouse

PMSERV.ACC

Calculator

Printer

Page setup*

*Run Page setup from each application's File Menu.
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The MENUDATA.TAN file holds custom information you've set
up for Personal DeskMate, such as a custom desktop you've
built, your printer information, modem information, color choices,
and so on. If it doesn't exist on a diskette that contains
PMMENU.PDM, PMMENU.PDM creates it automatically. You
can use a different MENUDATA.TAN file on each diskette con

taining PMMENU.PDM to set up different custom information
for that diskette. If you want to reset Personal DeskMate to the
default state it was in when you first used it, delete MENU
DATA.TAN at the A> prompt with:

del menudata.tan I enter I

When you return to the desktop. Personal DeskMate builds
another MENUDATA.TAN file that defaults to the original
state.

When you are experienced in using Personal DeskMate and no
longer require extra help, you can delete help files you might
have on your diskette. The program file that runs help is
PMHELP.ACC, and all help information is stored in files that
end with .HLP. Use the del command explained above to delete
help files and the help accessory itself.
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SETTING UP TO USE
A POINTING DEVICE

Personal DeskMate can use several different devices to aid you in
selecting information and commands. These devices are called
pointing devices. They enable you to point at locations on the
screen and tell the computer the location of their point. You can
use two different classes of devices: a mouse, such as the Tandy
Digi-Mouse (or another manufacturer's mouse that uses a device
driver compatible with a Microsoft mouse); or a joystick (or any
device that acts essentially as a joystick does, such as the Tandy
Touch Pad). You can use one joystick, or one mouse, but not both
at the same time. Plug the joystick into the right joystick port
on the computer.

Before you use a pointing device, you must install that device, or
tell Personal DeskMate that you're using it. To do this, you must
add a line to a file called config.sys, a special file used by MS-
DOS. If you already installed your mouse using the instructions
provided with it. Personal DeskMate can use the device. If you
haven't installed the mouse, or if you want to use a joystick, fol
low the instructions in this appendix. They require the use of
the Personal DeskMate Text application. Although this appendix
contains complete instructions, you might want to read Chapter
2, "Getting Started," Chapter 3, "The Tandy Desktop," and
Chapter 4, "Text," before installing your pointing device.

1. With the A> prompt on the screen and Diskette #1 in the
current drive, type desk [ enter I to load Personal DeskMate.
The desktop appears on the screen.

2. Press the I tab I key until the marker is on the Text applica
tion's list box.

3. Press I enter I to run the Text application.

4. Insert the diskette that contains the Text application
(Diskette #2) in the drive.

5. You see a blank screen with an (Unt i 11 ed) filename on the
title bar. Press |alt| [f] to display the File Menu.

6. Remove your Personal DeskMate diskette from Drive A,
and replace it with a copy of your MS-DOS diskette.
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7. Press [T) until the marker is on the Open option, and press
1 ENTER I. When the dialog box appears, press (j^, and type
config.sys I enter |. If you already have a config.sys on your
disk. Text loads it. Otherwise, you see a message telling
you that config.sys cannot be found. Press I enter I and then
IESCI to cancel the message box and the Open File dialog
box.

8. The screen is now blank (if no config.sys file exists), or it
shows you the contents of the config.sys file. Find the line
that contains this text: device = mouse.sys. (If the file didn't
exist, or if the line does not occur in the existing file, go
now to Step 9.) If the line exists and you want to use a
mouse, you're finished. Exit the Text application by press
ing I ALT I \T\ to display the File Menu and then typing Q
I ENTER I to mark and execute the Quit option.

If, on the other hand, the line exists, but you want to use a
joystick, you need to change the word, mouse, to joy. Use
the Q] key to move the marker to the beginning of the line,
device = mouse.sys. Use Q to move the marker to the m in
mouse. Press I shift I PH five times to select the word mouse.
Type joy. The line now reads:

device = j oy.sys

You are finished. Exit the Text application by pressing fAim
(T] to display the File Menu and then typing Q | enter I to
mark and execute the Quit option. Press the YES button to
save changes.

9. If the config.sys file does not exist, you must create it. To
use a mouse device, type this line on the blank screen:

device = mouse.sys

To use a joystick, type this line:

device = joy.sys

Leave no blanks at the beginning or between the words on
the line. Convert the file to an ASCII format by pulling
down the File Menu and choosing To ASCII. Create the
file by pressing [altI (T) to display the File Menu. Use (T) to
move the marker to the Save as option, and press | enter j to
choose it.
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At the prompt, type config.sys as the name of the file, and
press I ENTER |. Then, choose the File Menu's Quit option.

The file you created, config.sys, and the associated device file,
mouse.sys or joy.sys, must be on your MS-DOS diskette when
you start up the operating system before using Personal
DeskMate.

The joy.sys file is supplied on your original Personal DeskMate
diskette. The file, mouse.sys, is supplied with your mouse, not
with the Personal DeskMate diskettes. Use the copying proce
dure described in Chapter 12 to copy the file from the diskette
supplied with your mouse to the MS-DOS diskette.

Note: If you have a self-centering joystick or a device
such as a Touch Pad, you might want to use the self-
centering option. This option makes the pointer move
in proportion to the movement of the joystick from its
center position. For example, if you moved the joystick
to the right, the pointer would move to the right. If
you then centered the joystick, the pointer would stop
moving.

If you want the pointer to move in this way, include
this line in your config.sys file:

device = joy.sys /centering
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TELECOM SAMPLE AUTOLOG

This appendix takes you through a sample autolog procedure for
connecting and logging onto CompuServe®. We assume settings
for the Plus 300 internal modem card, but you can substitute the
settings for the type of modem you use. Because the Plus 300
modem card automatically dials for you, instructions for using
non-autodialing modems are not included. However, you can eas
ily adapt the instructions to suit your needs by reading the
instructions in Chapter 9, "Telecom." Note that if you're using a
Plus 300 card, you should use it in "Hayes" mode, following the
switch settings suggested in the modem card manual.

First, you need to use the Communications accessory to define
the type of modem you're using. Next, you must set communica
tions parameters, develop the autolog file, and save it on diskette
using Telecom. You need perform these steps only once. After
that, you can execute the autolog file using Telecom whenever
you like.

Defining the Modem

First, load Personal DeskMate. Once the desktop is on the
screen, follow these instructions to define the type of modem
you're using.

1. Pull down the Accessory Menu, and choose the Communica
tions option.

2. At the Communications port: prompt, push the radio
button for Port 1.

3. At the Connection: prompt, push the radio button for
using a Nod em connection.

4. To fill in the Modem name: prompt, use the Modems list
box. Scroll through the list until you mark PLUS 300-
HAYES. Move out of the list box (by using | tab I or by point
ing and clicking) to place the response at the Modem name:
prompt.

5. Push the OK button at the bottom of the window to store
the settings and return to the desktop.

CompuServe is a registered trademark of CompuServe, Inc.
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Setting Communications Parameters in
Telecom

Next, load the Telecom application. When you see the command
screen, follow the instructions below to set your communications
parameters.

1. Pull down the Commands Menu, and choose the Set option.

2. In the Baud section of the window, push the radio button
for 30 0.

3. At Word Length, push the radio button for 7 bits.

4. At Parity, push the radio button for Even.

5. At Stop Bits, push the radio button for 1.

6. At Flow control, push the radio button for On.

7. In the next section of the window, leave the Ascii filter.
Self echo, and Add line feed check boxes off.

8. Push the GK button at the bottom of the window to estab

lish the parameters and return to the command screen.
The settings you established now appear on the screen.

Developing the Autolog File

The next step in setting up is to actually create the autolog
sequence necessary for calling and communicating with
CompuServe. Follow these instructions to develop the autolog file.

1. Pull down the Commands Menu, and choose the Cal 1
option. Type the phone number provided to you by Compu
Serve for your area. For example, you could type 555-1212.

2. Push the OK button at the bottom of the window. The com

mand screen returns, and the phone number you typed
appears on the screen.

3. Pull down the Commands Menu, and choose the Wait
option. Push the radio button for Wait for time
period:. Then, type a number of seconds you want to wait
to be sure that both systems (yours and CompuServe's)
have enough time to establish a connection for communicat
ing. For instance, you can type 5 to wait for five seconds.
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4. Push the OK button at the bottom of the window. The com

mand screen returns, showing you the file thus far.

5. Pull down the Commands Menu, and choose the Send
option.

6. In the window, the Send string: radio button is already
pushed. Move to the edit field, and tj^e ''C to specify that
you want to send a "control-C." (Hold down | shif | and press

to type the symbol.) Leave the Add carriage
r e t u r n check box off.

7. Move to the DK push button at the bottom of the window,
and push it. When the command screen returns, you see
that the last line of the Parameters column reads "''C".

Quotation marks automatically appear around characters
you specify to send and receive. You do not have to supply
the quotation marks yourself.

8. Pull down the Commands Menu, and choose the Nait
option.

9. In the Wait window, push the radio button for Wait for
string:. Then, move to the edit field, and type User ID: to
specify that you should receive a prompt from CompuServe
asking for your user identification number. Be sure to type
the string exactly as shown in this step. Skip the 30-sec-
ond default time at the next prompt to leave it as it is.

10. Push the OK button at the bottom of the window to return
to the command screen, which now shows the latest line
you've added.

11. Pull down the Commands Menu, and choose the Send
option.

12. In the window that appears, the radio button for Send
string: is already pushed. Move to the edit field, and type
the identification number assigned to you by CompuServe.
For instance, you might type 73333,221 as a user identifi
cation number. Then, move to the Add carriage return
check box, and toggle it on.

13. Push the OK button at the bottom of the window. The com

mand screen returns. The ''M that appears at the end of the
string you typed shows that you turned on the Add car-
r iage return check box.
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14. Pull down the Commands Menu, and choose the Wait
option.

15. In the Wait window, the radio button for Wait for
string: is already pushed. Move to the edit field, and type
Password: to specify that you should receive a prompt
from CompuServe asking for your password. Be sure to
type the string exactly as shown in this step. Skip the 30-
second default time at the next prompt to leave it as it is.

16. Push the GK button at the bottom of the window to return

to the command screen.

17. Pull down the Commands Menu, and choose the Send
option.

18. In the window that appears, the radio button for Send
string: is already pushed. Move to the edit field, and type
your CompuServe password. For instance, you might type
MY-SECRET as a password. Leave the Add carriage
return check box toggled on.

19. Push the OK button at the bottom of the window. The com

mand screen returns. Again, the "M that appears at the
end of the string you typed shows that a carriage return is
being added at the end of your password.

20. The autolog file is now defined. Pull down the File Menu,
and choose the Save as option.

21. At the Save as: prompt, type a filename you want to give
the autolog file when you store it on diskette. For example,
you can type sample to store the file under the name,
SAMPLE.LOG.

22. Push the SAVE button at the bottom of the window. Telecom

saves your autolog file, and the command screen reappears.

Executing the Autolog File

You can use the autolog file you developed to call CompuServe
and actually log onto the service at any time. First, be sure that
your modem is properly connected to the telephone line. If you
run the autolog file directly after developing it in Telecom, pull
down the Commands Menu and choose the Execute option. If
you run the autolog file any other time, load Telecom. Pull down
the File Menu, and choose the Run option to run the autolog file.
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YDur screen now displays the terminal screen, where you can see
communications taking place. Once the connection is established,
you can see the results of using your autolog file. You're now
communicating with CompuServe.
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Color option (Text Menu) 217
colors in Paint application 78, 80, 224
columns 173-74

labelling 46-48
Column width option (Pad Menu) 173
commands, cancelling 21, 123
Commands Menu 237-43

communications See Communications accessory; Telecom
application

Communications accessory 3, 157-58
communications parameters 99, 100-101, 233, 238-40

ASCII and non-ASCII format 169

communications port 158
config.sys 255, 256
COPY command 251

copying
applications to diskettes 251-53
to clipboard 130
files to directories 136-37

diskettes 142

See also backing up
Copy layouts option (File Menu) 193-94
Copy option (Edit Menu) 132, 195, 216
Copy option (File Menu) 136-37
CPU clock speed 136, 144
Create option (Build Menu) 143-44
Create option (Directory Menu) 139
Cut option (Edit Menu) 132, 194, 216

Daily option (Display Menu) 230
database See Filer application
data types

Filer application fields 59, 202
Worksheet application cells 176, 186

Date and Time accessory 3, 159
default reply, 121
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Define layout option (Records Menu) 196
Define option (Index Menu) 209-211
Define option (Report Menu) 206
Delete column option (Pad Menu) 174
Delete function (Phone List) 152
Delete option (Build Menu) 144-45
Delete option (Commands Menu) 242
Delete option (Directory Menu) 139-40
Delete option (File Menu) 138
Delete option (Records Menu) 197-98
Delete row option (Pad Menu) 175
deleting files 109, 138
DeskMate See Personal DeskMate

dialog boxes 19-24, 121-24
components 19-22, 121-23
sample 22-23, 123-24
"shadowed" 23, 124

dir command 10, 112
directories 139-41

applications See list boxes
copying files to 136-37
outlines 140

subdirectories 139, 193
Directory Menu, Tandy Desktop 139-41
directory pathnames 125, 137, 138, 139
Disconnect option (Options Menu) 247
diskcopy.com program 143
Diskcopy option (Disk Menu) 142-43
diskettes 141-42

copying applications to 251-53
Disk Menu, Tandy Desktop 141-42
Display Menu (Calendar) 230-31
Display option (Buffer Menu) 244
Display option (Build Menu) 145-46
Display option (Index Menu) 211
Display option (Records Menu) 196
Display option (Report Menu) 206
double click 3, 11, 113, 159
drag 11, 113

edit fields 19-20, 121
Edit function (Phone List) 151-52
editing text 35-40
Edit Menu 131-33

Calendar application 228
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Filer application 194-96
Paint application 215-17
Text application 166
Worksheet application 173

Edit pattern option (Options Menu) 218-19
End text option (Cells Menu) 184
equipment needs for Personal DeskMate 3-4
Erase option (Edit Menu) 216
Erase option (Paint tool) 221
Execute option (Commands Menu) 243-43
exiting

files and applications 24-25, 43, 55, 74, 88, 97, 108
Personal DeskMate 10, 112

Field Menu 202-205

fields 57, 202-205
adding format characters 60-61, 188
format and labels 58-61, 188, 204
positioning for reports 70-71

File Menu 116, 125-31, 228
Filer application 192-94
Paint application 215
Tandy Desktop 135-39
Telecom application 236-37
Text application 165-66
Worksheet application 172-73

filename extensions 116, 125, 144
Filer application 1, 57-75, 187-211

adding records 61-63, 189
creating files 58, 187
creating record formats 58-61, 187-89
displaying records 65
exiting 74-75
limiting records 66-67
Menu Bar 192-211

naming files 74-75, 192
printing reports 74
print setup 72-74
report setup 68-72, 190-92
saving files 74-75
screen 187

sorting records 63-65
Title Bar 192

files See also autolog files
closing See exiting
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copying to directories 136-37
creating 33-34, 45, 58, 164
deleting 109
editing 35-40
exiting 24-25, 43, 55, 130-31, 134
naming 55, 74, 116, 125, 127, 192
opening 11-13, 34, 91, 113-16
printing See printing; print setup
renaming 139
saving 25, 43, 55, 127, 130-31
selecting information in 16-18, 118-19, 136

Fill option (Paint tool) 221
Find cell option (Search Menu) 185
Find date option (Search Menu) 229
Find lahel option (Search Menu) 184-85
Find next option (Search Menu) 167, 186
Find number option (Search Menu) 185
Find option (Records Menu) 198-200
Find option (Search Menu) 167, 228-29
Find next option (Search Menu) 229
Flip horizontal option (Edit Menu) 216
Flip vertical option (Edit Menu) 217
"floating box" 145
format.com program 142
Format option (Cells Menu) 175-76
Format option (Disk Menu) 141
Format option (Field Menu) 204-205
format characters 60-61, 188
Formula option (Cells Menu) 117-83
formulas 50-52, 177-83
From ASCII option (File Menu) 166

Get Info option (Disk Menu) 141
Get Info option (File Menu) 135
Graphic mode 129
graphics See Paint application

hard disk 141-42

hardware needs for Personal DeskMate 3-4
help information 9, 111
Help Windows 133-34

Index Menu 209-211

information, selecting 16-18
information services 99, 102
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connecting to 106
Input option (Cells Menu) 176-77
input screens See dialog boxes
Insert column option (Pad Menu) 174
Insert mode 16, 117, 163, 169
Insert option (Commands Menu) 242
Insert row option (Pad Menu) 174
install command 9, 111
installing Personal DeskMate 9-10, 111-12
Introduction to MS-DOS 5, 9, 111, 112, 142, 143, 251

joystick 3, 4, 113, 256 See also pointing devices

keyboard
exiting files/applications with 25
moving around screens with 14, 15, 117
opening files/running applications with 12-13, 115
in Paint application 77, 214
selecting information with 16-17, 118
using dialog boxes with 23-24, 122
using menus with 18-19, 119-20

labels

field 59, 188
worksheet columns and rows 46-48

line feed filter 32, 161
line number 168

Line option (Options Menu) 217-18
Line option (Paint tool) 221
list boxes 12, 20, 114, 121-22, 126

deleting definitions of 144-45
displaying 145

Load option (Buffer Menu) 243-44
loading Personal DeskMate 10, 112
log off 107
log on 106

manual for Personal DeskMate 4-5

Menu Bar 15, 18, 117
Calendar application 227-31
Filer application 192-211
Paint application 215-19
Tandy Desktop 27-28, 135-46
Telecom application 236-47
Text application 165-68
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Worksheet application 172-86
menus

accelerators 120

pulling down/selecting options on 18-19, 119-20
"shadowed" options in 120
size 145-46

Merge option (File Menu) 165, 173
modems 100, 106, 158, 233
Monthly option (Display Menu) 230
mouse 3, 113, 256 See pointing devices
Mouse accessory 3, 159-60 See also pointing devices
MS-DOS operating system 3, 139, 141, 143, 252

naming files 55, 74, 116, 125, 127, 192
extensions 116, 125, 144, 244
renaming 139
See also Labelling

New function (Phone List) 151
New option (File Menu) 125-26, 236
Note Pad accessory 2, 153-55

functions 154

installing on Tandy Desktop 155
numbers

adding to worksheets 48-50
opening files 11-13, 113-16, 126
Open option (File Menu) 126, 236
Options Menu

Paint application 217-19
Telecom application 245-47

order of operations 177
Overtype mode 16, 118, 163, 169

Pad Menu 173-75

page layout
Calendar application 96
Filer application 72-74
Text application 40-42
See also Page Setup; printing

page number 168
Page # option (Report Menu) 208
Page Setup option 40, 72, 96

File Menu 127-29, 168
Paint application 1, 77-89, 213-224

colors and patterns 78-79, 224
exiting 88-89
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Menu Bar 215-19

placing text on-screen 79-80, 220
running 77-78, 213-14
saving in 88-89
screen 213

setting line width and color in 80-81
Title Bar 214-15

tools 81-87, 219-23
palette See colors
Paste option (Edit Menu) 132, 195, 216
patterns in Paint application 224
Pencil option (Paint tool) 221
Personal DeskMate

accessories 2-3

applications 1-2
backing up 5-6
equipment needed for 3-4
exiting 10, 112
getting started in 9-25
Help windows 133-34
installing 9-10, 111-12
introduction to 1-6, 9-25, 111-34
loading 10, 112
manual 4-5

software needed for 3-4, 251
picture editor See Paint application
Phone Directory See Phone List
Phone List accessory 2, 149-53

displaying numbers on 150
functions 151-52

installing on Tandy Desktop 153
point 11, 113
pointer 11, 113
pointing devices 3, 11, 113

exiting files/applications with 25
moving around screens with 15-16, 117-18
opening files/running applications with 13, 115
in Paint application 77, 214
selecting information with 17-18, 119
setting up to use 255-57
using dialog boxes with 24, 122
using menus with 19, 120
See also Color mouse; joysticks; mouse; Tandy Digi-Mouse;

Touch Pad

Polyline option (Paint tool) 222-23
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press 11, 113
Printer accessory 3, 160-62
printers 4, 31, 32 See also print setup
Print function (Note Pad) 154
Print function (Phone List) 152
printing 129-30

boldface/underlining 166, 205
Calendar application 96-97
Filer application 74
Text application 40-43
See also print setup

Print option (Buffer Menu) 244-45
Print option (File Menu) 129-30, 194, 215, 237
print setup

Calendar application 96
Filer application 72-74
Tandy Desktop 31-32
See also printers; printing

pulling down menus 18-19, 119-20
push buttons 21-22, 123

Quit function (Note Pad) 154
Quit function (Phone List) 152
Quit option (File Menu) 130-31, 237
quitting See Exiting

radio buttons 21, 122
records 57

adding 61-63, 189, 197
changing 197
creating formats for 58-61, 187-88, 196
deleting 197-98
displaying 65, 196
limiting 66-67
searching 66-67, 198-200
sorting 63-65, 200-202

Records Menu 196-202

Redefine option (Build Menu) 145
Remove option (Build Menu) 146
Rename option (File Menu) 139
Replace option (Search Menu) 167-68
Report Menu 205-209
reports 68-74, 190-92, 205-209
Resize section (Report Menu) 209
rows 174-75
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labelling 46-48
running applications 11-13, llS-l'B, 136

non-Personal DeskMate 136

Run option (File Menu) 136, 236

Sample Session 9-109
ending 109
getting started 9-25

Save as option (File Menu) 127, 237
Save function (Note Pad) 154
Save option (Buffer Menu) 244
Save option (File Menu) 127, 237
saving 123

buffer contents 108, 244
files 25, 43, 55, 74, 88, 97, 105, 127, 130, 134

scheduler See Calendar application
screens

Calendar 225

Filer 187

moving around on 14-16, 116-18
Paint 213

Telecom 233, 235
terminal 106, 235, 247
Text 163

Worksheet 171

scrolling See scrolling arrow icons
scrolling arrow icons 15, 20, 117-18, 122
search criteria for records 66, 190-92
Search Menu

Calendar application 228-29
Text application 166-68
Worksheet application 184-86

Select all option (Edit Menu) 133
selecting information in files 16-18, 118-19
selecting options on a menu 18-19, 119-20
Select option (Paint tool) 219
Send option (Commands Menu) 241-42
Set option (Commands Menu) 238-40
single-drive computer 57, 137, 193
Size option (Field Menu) 204
software needed for Personal DeskMate 3-4, 251
Solid Circle option (Paint tool) 223
Solid Square option (Paint tool) 223
Sort option (Records Menu) 200-202
Spray Can tool 87-88, 221
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spreadsheet See Worksheet application
Square option (Paint tool) 222
Start text option (Cells Menu) 184
storing See saving
Substitute option (Search Menu) 167-68
Summary option (Report Menu) 206-208
Swap option (Disk Menu) 143

Tandy Desktop application 1, 27-32, 135-46
changing 28-30
installing accessories on 149, 153, 155, 156
menu bar 27, 135-46
print setup 31-32
title bar 135

tour of 27-28

Tandy Digi-Mouse 4, 255
Tandy Icon 18, 135, 147
Tandy 1000 series computers 3
Telecom application 2, 99-108, 233-47

buffers 106-107, 108, 235, 243-45
connecting with 106, 234
disconnecting with 107, 234
developing autolog files 102-105, 234-35, 236-37
equipment 3, 102, 106, 149, 234
exiting 108, 237
Menu Bar 236-47

running 99-101, 233-35
screens 106, 233, 235
Title Bar 236

telecommunications See Communications accessory; Telecom
application

Terminal options (Options Menu) 247
terminal screen, 106, 235, 247
Text application 1, 33-43, 163-69

bottom line information 168-69

creating files with 33-34, 164
exiting 43
Menu Bar 165-68

opening files with 34-35
printing with 40-43
revising text with 37-40
saving files with 43
screen 163

substituting text with 35-36
Title Bar 164
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text editor See Notepad accessory; Text application
Text Menu 166, 205, 217
Text Mode 129

text on graphics 79-80, 220
Text option (Paint tool) 220
time See Date and Time accessory
Title Bar

Calendar application 227
Filer application 192
Paint application 214-15
Tandy Desktop 135
Telecom application 236
Text application 164
Worksheet application 172

To ASCII option (File Menu) 165
Today's date option (Report Menu) 208
toggles See check boxes
Touch Pad 3, 4, 113, 257 See also pointing devices
Transfer file option (Options Menu) 245-47

Underline option (Text Menu) 217
underlining print 166, 205, 217
Undo option (Edit Menu) 215

Wait option (Commands Menu) 241
Weekly option (Display Menu) 230
wildcards 137, 138
wordprocessing See Text application
Worksheet application 1, 45-55, 174-86

bottom line information 186

calculating with 52-53, 175
creating files in 45, 172
exiting 55
labelling columns and rows in 46-48
Menu Bar 172-86

naming files 55
recalculating 54-55
repositioning with 53-54
saving in 55
screen 171

Title Bar 172

typing figures in 48-50
writing formulas in 50-52, 177-83

Xon/Xoff 240
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Yearly option (Display Menu) 231

Zoom option (Paint tool) 220
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